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CHAPTER 1 - Basic Concepts

Welcome to Pyware™ 3D - the complete drill designing tool. We at Pygraphics wish to express our
gratitude to you who have supported our products and company by allowing us to serve your software
needs for more than two decades. Our hope is that this program will become an invaluable tool in
your drill designing efforts.

Adjusting to the many innovative concepts of 3D will take a minimum of time, however, we do urge that
you work through Chapter 2 - Tutorial in order to better understand the concepts behind 3D.

Pyware™ 3D was inspired by video animators and a "wish list" of input from "end users”. You will
begin to create, evaluate, and instruct drill never thought possible. In short...you'll soon be wondering
how you got along without it.

WHERE TO
START

* In this chapter you will learn the main windows of Pyware 3D and many of the terms that are to be
used throughout the application and manual.

e Chapter 2 - The Tutorial. This is probably the most important chapter for learning the fundamentals
of 3D. It guides you through the design of a short drill. During the “off-season” develop your skill
with Pyware 3D. After you have created the Tutorial drill, take an old drill and practice inputting a
few pages. Learning a computer and its applications is similar to learning how to play a musical
instrument. “You must learn the fundamentals and practice before performing in the recital.”

The remaining portion of the manual is to be used as a reference material.
» Chapter 3 - The Menu Bar. Describes the functions of the application menu bar.

» Chapter 4 - Drawing Tools. Describes how to enter shapes using the drawing tools as well as
details of special options common to most drawing tools such as “clone” and shape adjustment han-
dles.

* Chapter 5 - Selection and Performer Regrouping Tools. Before using the editing tools in 3D, a
group of performers must first be selected. This chapter shows how to select an individual or group
of performers.

e Chapter 6 - Editing /Maneuvering Tools. This chapter describes how to edit and maneuver per-
formers in a drill.

» Chapter 7 - Special Tools. This chapter covers special items important to the presentation and
instruction of drill such as performer labeling, text boxes and arrow indicators.

» Chapter 8 - Printing. This chapter describes how to print charts, coordinates and other reports.
» Chapter 9 - Utilities. This chapter covers the Utilities menu.

« Drill Rewriter utility for editing number of performers in a drill.

e Count Editor utility for inserting or removing counts from a drill.

» Grid Designer utility for creating custom field grid layouts such as soccer fields, winter
guard, parades etc.

« Page Tab Editor utility for adding and removing page tabs and entering page tab titles.
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» Chapter 10 - Special Designing Techniques
e Writing drill backwards
e Synchronizing drill to music

e Chapter 11 - Interactive Utilities - This chapter covers the procedure of sharing your drill with your
students, other designers, and/or drill design customers.

e Chapter 12 - Traditional Tools Plug-in (purchased separately) - This chapter presents procedures
of creating drill comprised of traditional maneuvers performed by both military and show bands.

» Chapter 13 - Floor Covers Plug-in (purchased separately) - This chapter offers ways of creating
floor (or field) layouts for Winter Guard, Indoor Drum Line, and Stage presentations.

INSTALLATION Pyware™ 3D requires that it be installed on the computer’s hard drive. You will find detailed instruc-
tions for installing and de-installing your program on the Installation Card included with your package.

STARTING 3D 3D is always started by choosing the 3D application on your computer from your group of programs.

3D will not start by selecting a 3D drill file directly. You must launch 3D first, then choose New or
Open from 3D’s File menu.

In Windows, you will find 3D in the Programs group of the Start button. In Macintosh, you will find the
application icon initially on your desktop or dock.

» While Pyware 3D is loading the 3D cover screen will display.

* A new file will display using the default field grid with a maximum of 300 counts of drill for you to start
immediately. This file has a maximum of 300 counts of drill. If you need to increase the maximum
number of counts later, you will use the Count Editor of the Utilities menu. Should you want to
start a drill file with more counts, or a different field display layout see the next step.

* You can create another new file with a different maximum number of counts or a different Field
Display grid by selecting New from the File menu. When determining the number of counts in a
drill we recommend that you do not make a drill file with more than one song per file.

* You can also choose to open an existing file by selecting Open from the File menu.

It's important that you save often. You can always revert to an early “backup” of the file if, after writ-
ing, you realize an earlier version of the file is better. Also, power surges and file corruptions are a
fact of life. Having backups of the file are extremely important. In addition, backing up files on CD is
beneficial. See Backup Drill at the end of this chapter for more details on backup techniques.
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3D’s MAIN
WINDOWS

Once you have opened a file, several windows, menus, palettes and control panels will appear on the
screen. All of which will be explained in this chapter. Items addressed in this chapter:

» The Field Display Window
e The Count Track and Animation Controls

* The Console

The Tool Palette

» The Perspective Window

TI Pyware 30 Java Interactive Professional | Licensed to: Dustin Serial 30JPRO-00013-WHEAL =nF=E
File Edit Tools Display Utilities Interactive Perforrmer's Tools Reference
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FIELD DispLAY
WiNDOW

This is the main area where the drill design is created. The upper left corner of the field display win-

switch Field Zoom Tool
Text Switeh 7
o LT oG

Label Switeh Field Move Tool
Measitre Tool

dow contains display tools which control the way drill is displayed on the field.

The Props Switch - turns the display of props on or off. No props will be shown until they are
entered.

The Label Switch - turns the display of labels (numbers) that appear beside each performer on or
off. No labels will be displayed until the labels are entered.
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The Text Switch - turns the display of the text and arrows on the field display on or off.

The Measure Tool is used to measure the distance between two points. Click on the tool and then
click on two points on the field to measure. The measurement is displayed in the Console. A quick
way to turn off the measure tool is double-click anywhere on the field while the tool is active.

The Field Move Tool is used to move the actual field grid within the field display. Click on the tool to
activate it and then move the cursor to the field display. Drag the field to move it. Click the tool again
to turn it off. <Alt> click (<Option>-click for Mac) directly on the tool to revert to the default field loca-
tion.

The Field Zoom Tool is used to zoom the actual field grid within the field display. Click on the tool
and click on the field grid to zoom in. <Alt> click on the field grid to zoom out. (<Option>-click for
Mac). <Alt>-click directly on the tool to revert back to the default field view.

CouNT TRACK

The Count Track is typically located along the bottom of the screen. Its main component looks like a
ruler with a tick drawn for every count in the drill. A Red and Yellow Anchor can be dragged along the
ruler which determine the count of the drill that will be displayed and edited on the screen. The Count

R

- ||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||||
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Track is very important and is fundamental for the proper operation of Pyware 3D.

During typical use, sliding left-right above the counts of
the Count Track is a Red and Yellow Anchor.

_ . . 0 = = H
Directly to the left of the ruler in the Count Track is an 15 IIIIIIII"""%"'"'I"""'I"""'IIIII
area that displays the Red and Yellow Anchor values. 16 B 24 32 40
When writing forward the top number represents the S ! z 3

count of drill where the Yellow Anchor is located. The
next number represents the count of drill where the Red
Anchor is located and the last number represents the
number of counts between the Red Anchor and the Yellow Anchor.

The space between the two anchors determines the count range of a transition. The Red Anchor is
the ending count of a transition. It is the count where a shape can be edited. At this count, the posi-
tions in the formations are displayed on the field in symbols. For example X's, T's, flag symbols . The
Yellow Anchor is the beginning count of a transition and is used as a reference or background chart.
The positions at this count are displayed in black dots (the default setting). In the “old days” when
designing on paper or using a light board, the Red Anchor could be compared to the actual sheet you
would be drawing on. The Yellow Anchor is the underly-

ing sheet of paper with a formation from the previous set

to be used as a reference. 0

Yellow and Red Anchors

1 III|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|II
When you start a drill, you will typically first create an g 16 =24 32 40 48
opening formation at count 0. You will set both Red and B 2 3

Yellow Anchors to count O.

Yellow Anchaor

After you have created the opening formation you will cre- P
ate your transitions to the next set by “morphing” or 0 =| -/ N

. . . . . IIIIII|II Il IIIII|IIIIIII|IIIIIII|IIIIIII|II
reshaping your opening formation. To indicate the count of 4

. o 16 2 24 32 40 48

the next set and the number of counts in the transition i 2 .
from the last set, you will spread the anchors over those
counts. For example, setting the Yellow Anchor at count Red Anchor

0 and the Red Anchor at count 16 will start the next set
at count 16 and create a 16 count transition between counts 0 and 16.
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TRACK
RESOLUTION
BuTtTON

Often when moving your anchors forward the locations of the performers on the field do not appear to
change even though we are now looking at count 16. That is because no editing has been done at
count 16, therefore the performers at count 16 are marking time from count 0.

To design the formations of the next set, you will select shapes and use the edit tools to reshape them.
In the example, our Red Anchor is at count 16 and therefore the formations (or shapes) we are editing
are at count 16. Since the Yellow Anchor is at count 0, the transitions between count 0 and 16 are
automatically created for you.

Again, for example, if you wish the next transition
to be between counts 16 and 40, you would move
your anchors where the Yellow Anchor is at

count 16 and the Red Anchor is at count 40. YE”JE'W Anchar — /i

NOW’ you are IOOkIng atcount40 Onthefleld & |IIIIIII|II Ilﬁ IIII |||||:|’|||||| I I II|IIIIIII|IIIIIII
Since count 40 is currently marking time from T ] 1 & g
count 16, the secondary (background) chart at K '\ 2 NE

count 16 that is normally displayed is directly x_,z Fed Anchar

under the primary chart (count 40). You will now
reshape the formations at count 40 and the transi-
tion counts between 16 and 40 will be automati-
cally created for you.

The great thing about the Count Track is that transitions can begin and end on ANY count. You are
also not restricted to beginning and ending EVERY transition at the same counts in the drill. Some
transitions may span over several printed charts. In our example we created a set of transitions that
span from 0-16 and from 16-40, so typically we would print a chart at 0, 16 and 40. But what if you
also wanted a group of performers (let's say the guard) to travel from 0 to 40 in a single transition?
That is easy! Set the Yellow Anchor to 0 and your Red Anchor to 40. Reshape the formations that
make up the guard and you're done. The placement of the guard at count 16 (as with the other transi-
tion counts) are automatically created for you.

Another great thing about the Count Track is that with this approach you do not re-create a chart from
scratch at each set. With 3D, you are usually re-shaping the formations of a count (at the Red
Anchor) based on a formation’s shape at a previous count (at the Yellow Anchor). Since transitions
are evolutionary, it is almost always easier to build a chart from its predecessor than to create it from
scratch. The Tutorial that follows will help you better understand how this concept works.

NOTE: Dragging the Yellow Anchor through the count of the Red Anchor will leap frog the anchors.
This time saving feature allows you to continue on to the next set by moving just one anchor instead of
two.

TIP: <Ctrl> click to move your anchors to a bounding set skipping over any sub-tabs. <Alt> (<option>
for Mac) click to move your anchors to a single count.

This multi-function button zooms the Count Track when the button appears in green.
Single clicking the button zooms IN. <Shift> click the button zooms OUT.

<Ctrl> (<option> for Mac) click the button zooms to its default size. Default size can be set in the
Display section of Application Options, listed in the File Menu.

0 > Zoomed Count Track Yiew
- IIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIII
D ‘ 8 15 24 32 4[' 48 I:l- } Frrrrruri | | I T Y A I | | | I T Y A I | | 11
{_)) _ T 4 8 16 24
— Track Eesolution Buttan B
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PAGE TABS

User determined page tabs are markers placed on the Count Track ruler for making it easier to jump
to counts in the drill. Clicking on a page tab jumps the Red Anchor to that count and the Yellow
Anchor to the previous page tab. In printouts, page tabs are considered Sets in the drill. Page Tabs
can be entered two ways. One is visually using the Page Tab Editor button located on the Count
Track and the other is using the Page Tab Editor in the Utilities menu. The Page Tab Editor on the
Utilities menu is covered in Chapter 9 - Utilities. The procedure of implementing the Page Tab Editor
button on the count track is outlined below.

SET | Page Tab Bin S !

ITAB r|||| I|||||||I|||||||I|||||||I|||||||IIIIIIIHIIIIIIIIIIIIIIII |||||||||||||||||||||||||||||||||| |

48 g 8 16 24 32 40 56 5 184 192 z00 z08 P
|_||

2 {\3{ 4 A=
Fage Tab Fage Tab Editor Buttan

Clicking on the Page Tab Editor button enables the entering and editing of page tabs directly on the
Count Track.

When the Page Tab Editor button is enabled, the Page Tab Bin will turn yellow indicating that the
page tab editor has been activated.

Page tabs can be added to the Count Track simply by clicking on the count track at the location you
want the tab to be entered.

Page Tabs are removed from the Count Track by dragging a page tab from the ruler back to the
Page Tab Bin or by holding the <alt> (<option> for mac users) key and clicking on the page tab to be
removed.

While the Page Tab Editor button is on, any page tabs on the Count Track can be dragged to any
location on the ruler.

Turning off the Page Tab Editor button will set the mode of the Count Track back to normal use. The
Page Tab Editor button must be OFF in order to access any tools.

Page Tabs can also be used to indicate sub-sets. Often a page tab is useful to create a complex tran-
sition, however, you only want to print a chart at the beginning and end of the transition. In previous
versions of 3D you had to add page tabs to make it convenient to create the transition and then
remove the page tab before printing. Now you can create a sub-tab. This will prevent the set num-
bers from incrementing thru the sub-tabs because the sub tabs are label A,B,C. For example, with two
sub-tabs between set 2 and 3 the numbering sequence would be 1, 2, 2A, 2B, 3, 4, etc. You also can
choose to print the sub-tabs or not from the Print Charts function.

To enter a sub-tab:
» Enter a page tab on the Count Track as usual.

« After the tab appears on the Count Track, double-click on it and a Page Tab Options dialog will
appear. Choose whether the tab is a Standard Page Tab or Sub-Page Tab and click Okay.

TIP - You don't have to set page tabs before you start designing. Tabs can be set as you progress
through the drill. Tabs also can be inserted in the middle of a transition which will force subsequent
page tabs already entered to be renumbered.
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ANIMATION
CONTROLS

Animation Controls are found on the left side of the Count Track.

Jog Tools

Ik m=Shop

Continuous Loop f Cﬂéﬁ\ Fazt Andiation
Al Countz Step Aninmtion

The Play button starts drill animation from the beginning of the drill or from the Yellow Anchor
depending on the setting of the All Counts switch found along the bottom of the animation controls.

The Pause button pauses the animation.
The Stop button stops the animation.

The Jog Tool is used to jog the animation forward and backward for a quick review. Releasing the jog
returns the display to its previous condition.

The Continuous Loop option causes animation to loop continuously between the Yellow Anchor and
Red Anchor.

The All Counts options starts animation at beginning of the drill file and continues to the end of the
drill, regardless of the placement of both Red and Yellow Anchors. If All Counts is turned off, then the
animation will start at the Yellow Anchor and end at the Red Anchor.

When the Sound option is selected, you can choose and play a MIDI, MP3, or WAV file to play along
with your drill.

When Step Animation is selected, after clicking Play, animation will advance one step per <space-
bar> or <right arrow> keypress. The <left arrow> keypress will reverse the drill one step.

The Fast Animation option will play animation at a fast tempo for quicker review of transitions.

TIP - A combination of both Loop and Fast Animation is a great way to preview the interaction of
maneuvers of shapes to other shapes.
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CONSOLE

TooL PALETTE

The Console is the location for finding detailed information about a function you are currently using.

Location Indecator
-\-\-""--.
30 wd= 1.00 =stp | 29.00 stp i LR

0 af O postions selects >
Edfitingy court: 0 \\ ixteeth
' Eighth

Whaola
Cluater

Half

The top line of the Console is called the Location Indicator. It provides information regarding “cursor
placement” relating to steps from vertical (division) lines and horizontal reference points from either
back side line, front side line, or middle of field.

Information in the Console changes depending on the function currently being used. Typically the con-
sole shows information such as: number of positions selected, average interval of selected or new
shape, average length, maximum stride of transition, etc.

The five buttons in the top right corner of the Console control the step resolution of the location indica-
tor and the cursor on the field. The choices are whole (1) step, half (1/2) step, quarter (1/4) step,
eighth (1/8), and sixteenth (1/16) step. For more control of placement of points on a field select six-
teenth step resolution. This is valuable when implementing tools such as the Free Form Tool where
many points are required to create a smooth shape. When your points are basically endpoints then
you would usually choose whole step resolution so your endpoints will fall on whole steps.

Diramsing

Regrouping Editing /Lansuimring
The Tool Palette contains the tools for entering shapes, selecting and editing shapes, selecting and
maneuvering shapes, changing information about performers, and items such as text and arrows.
The Selection tools are used to select a shape or groups of shapes.

The Regrouping tools are used to combine performers into different groups for editing and maneuver-
ing. Also in this group is an Adjust To tool for quickly adjusting individual placements and a Pace tool
for controlling the pace (such as double-time) during a transition.

The Drawing tools are used to draw new shapes.
The Editing/Maneuvering tools are used to create transitions as well as edit shapes.

The Extras tools are used to add and modify information about performers such as their label (or num-
ber). Also these tools are used to draw special items such as instructions or arrows.
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PERSPECTIVE
WiNDOW

The Perspective Window is manipulated by using the tools in the upper right corner of the window.
The Perspective Window defaults to the minimized (hidden) status when the program is opened. The
Perspective view will appear by clicking on the Minimize button. After the perspective view has been
restored you will NOT see positions entered until you click on the main area of the Perspective View
window.

Minirizs, 51“{"
= g |
Recizl Tt

Zooin

The Minimize button reduces the window to show only the title bar. When the window is minimized,
the perspective view calculations are disabled allowing for a faster refresh rate of the field window.

The Resize button changes the size of the window between two sizes. There is a smaller, faster size
and a larger size that fills most of the screen.

The Tilt button tilts the view in the window. After clicking on the button, move the mouse into the per-
spective view window, click and drag in the direction that you want the display to tilt.

The Shift button moves the view up or down. After clicking on the button, move the mouse into the
perspective view window. Click and drag up or down to shift the display. <Alt> click on the Shift but-
ton returns the window to its default view

The Zoom button zooms the view in or out. After clicking on the button, move the mouse into the per-
spective view and click again to zoom IN. Hold down the <Control> key and click to zoom OUT. <Alt>
click on the Zoom button returns the window to its default view.

BAckup DRILL

With a computer, bad disks, damaged files, computer lock-ups and hard disk crashes are a fact of life.
Although these occurrences are few and far between, they inevitably seem to happen to everyone at
least once. Take the precautions mentioned below and your drill designing days will be virtually trouble
free.

» To prevent losing large amounts of work, it is advisable to create a separate file for each drill seg-
ment (opener, production, closer). Smaller files will also speed up animation and at times, solve cer-
tain printing problems.

* Your time and effort is very valuable. We suggest saving every fifteen minutes when working on a
file. Nothing is more frustrating than losing drill all because you did not save your work. It is easy
and takes very little time. Just select Save from the File menu.

» Work from the drill files that you have stored on your hard drive, however, also put your drill files on
disk (or CD) and store them. Keep copies on both hard disk and floppy disk (or CD). Hard drive
crashes can completely wipe out your entire drill, design library as well as other important files
stored on the computer. Floppy disks and CDs can get damaged too. Never keep your files at only
one location.

» Make quick hard drive backups by choosing Save As from the File menu and changing the name of
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the file. One common method of making backups is by ending a file name with a number such as 01
and then incrementing the number for each backup. For example: Name your opener “Opener01”.
Then after an hour of work, choose Save As and change the name to “Opener02” and so on. The
name with the largest number is the most current and all others are older at one hour increments.
This makes it easy to go back to earlier versions. After you have collected several copies, start delet-
ing the oldest ones, and occasionally move copies to floppy or CD.

Use the Backups section of the Application Options found in the File menu. Check “Always
backup after using Save.” See the Backup section of Chapter 3 - Menu Bar for detalils.



Chapter 2 - The Tutorial

Perhaps the best way to learn Pyware™ 3D is to progress through the development of a simple drill.
Please read the previous chapter before beginning this tutorial to understand some of the terminology.
We strongly urge you to complete this tutorial. It will introduce you to the basic functions and options of
the program.

NEw DRILL

« Start the 3D program.

 After a few moments, the 3D cover page will appear. A new file will be created and displayed using
the default field grid layout. A Count Track will appear at the bottom of the screen. The Count
Track determines which count of the drill will be displayed.

¢ To name our file, choose Save As under the File menu.

 Click in the Save As box, type Tutor and click Save.

PAGE TABS

11

 First, we will set four page tabs on the Count Track to designate specific counts as “Hit” points for
our drill. Page tabs will allow you to to jump to various parts of your drill quickly and easily.

 Click on the Page Tab Editor button to the right of the
Count Track.

136 144 152 160 168 176
Fage Tab Editor il

 Click on count 0 of the Count Track. The page tab will
appear as a small white box on the track at count 0. Make
sure that you have added the page tab on count 0 and not
count 1. If the page tab was added on count 1, simply click
and drag the page tab over to count 0. You may drag page
tabs to any count on the count track.

 Click on count 16 of the Count Track. The page tab will
appear as a small white box with the number 2 on the track
at count 16.

 Click on count 48 on the Count Track. The page tab will
appear as a small white box with the number 3 on the track
at count 48.

 Click on count 72 on the Count track. The page tab will
appear as a small white box with the number 4 will on the
track at count 72.

« Finally, to complete adding page tabs, click on the Page
Tab Editor button at the right of the count track. This will
close the Page Tab Bin and lock the new page tabs in
place.

SET

T'&'B |||||||||||||||||||||||||||||||||||||II|IIIIII
n4ta1524324n=
11)

Fage Tab at Count 0

SET
LE

|
T IIIIIII|IIIIII IIIIII|IIIIIII|IIIIIII|IIIIIII
16 ﬂ 8 ‘H 24 32 40 ¢

il ()

FT:;IQE Tah at Count 16

IIIIIII'"""I'"""I"""'I"""ﬁ"""I"""'IIIIII

16 24 32 40 56 A4

2 GD

Fage Tab at Count 48

""'I"""'I”""'I'”""I"“"H"”"I”"”'I”'””

40 48 56 B4 a0 83 ¢

3 )

Fage Tah at Count 72
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Select Save from the File menu to save the drill file with its new page tabs.

DRAWING LINES

12

The first shapes to be entered in our drill will be two mirrored horizontal lines.

Click on the white Page Tab at count 0 on the Count

. 0 o=

TraCk The pagetab appears asasma” Whlte bOX - IIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIII
beneath count O of the Count Track. The Yellow and Red F— 8 1B 24 37 4D
Anchors will return to the beginning of the Count Track. (\.11) 2

Locate the Tool Palette typically located in the upper left NEEZE A R

corner of the screen and click on the Line tool button. A .
Line Tool Control Panel will appear. @ & & O O & 5 =

In the Line Tool Control Panel, click on the padlock

. : . o Poziti o Omit averl
assigned to the Restrict Horz/Vert option. This will r:t'e':;f Dl g ] Bl Hegﬂct
lock the lines to be drawn as only horizontal, vertical Homrvert

and 45 degree diagonals. Clone|0_|times

Symbols | X Color (W)

We can choose to first determine positions and interval prior to drawing a new shape. Type 24 in
the Positions text box. Leave a 0 in the Interval text box.

To place the 1st endpoint of the line, move the
cursor to the left of the 50 yard line where the
Location Indicator located in the Console
reads 45 yds 6 stp | 42 stp and click the

mouse. E!!!!!!!!!!?!!m!!!!l!!@

To place the 2nd endpoint, move the cursor to
the left until the Location Indicator reads 20
yds 4.00 stp | 42 stp and click the mouse.

In the Control Panel, 22 positions will appear along with a “computer determined” interval based on
the length of the line you have entered.

Editing Handles will appear at the endpoints of the line, and a red Reposition Handle will appear
in the middle of the line. These handles can be used to reshape and edit the line.

Before committing this shape to the file, this would be

a good time to experiment with various editing A _
options found in the Line Control Panel. Click and Fositions 22| ®D Hmit overlaps Hegﬁct
unlock the padlock to the left of the Positions box. Interval 2] & N

Whenever the padlock is unlocked you are setting the Glone| 0 |times

option for the value to be “computer determined”. Symbals | X Coler (M
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» Enter 2 (steps) in the Interval text box. The padlock
Eo th? left gf the mte_rval text box WI.|| automatllcally ositions| 22 & [ ] Omit overlaps 3
lock”. This lock indicates that the interval will not intereal | B Frestrict
change when you manipulate the shape. Since we : Homvert
have locked the interval, the number of positions
change as you manipulate the length of the line while Symbols | % Color (M

the interval stays the same.

Clone O times

» While leaving the value 2 in the Interval text box, enter 28 in the Positions text box. The padlock is
now locked on both the interval and positions. Since we have locked the interval and the number of
positions, the shape automatically scales to keep the defined interval and number of positions.

» Unlock the padlock to the left of the Positions text box.

» Drag the red edit handle assigned to
the LEFT endpoint of the line until
the Location Indicator reads 15
yds 4 stp | 42 stp and release the ........'... PR PR P AP
mouse button. As you drag the edit ?
handle, positions are added or

removed to accommodate the
locked interval.

* Unlock the pad-
lock assigned to
the Restrict
Horz/Vert option.
When restrict is
unchecked, line Symbals | X Coler (M|
endpoints can be
placed at any
point on the field.

Pasitions 27 g |:| Omit owerlaps &

Intenral 2. i Restrict

Clone 0O times HorzVert

» Drag the red edit
handle assigned
to the LEFT end-
point of the line ?
until the Location an®
Indicator reads PR
15 yds 4 stps | RONE
28 stps.

- = o —— W - 1 - IS LT w4

» (Re)Lock the padlock assigned to Restrict Horz/Vert option. The shape will return to its horizontal
placement.

* In the Control Panel, enter Positions = 20 and Interval = 2 in text boxes.

13
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Also, in the Control Panel, enter 1 in the Clone text Line Tool Cortral Panel

box. The Clone option is used to duplicate a shape Fositions | 20 & [ ] omit overlaps &
across an axis. The next few steps will experiment Interval | 2. & Restrict
with the Clone option. Clone 1 times At

Symbols | X Color (W)

n_
Line Tool Control Panel
Fositions 20 i ] |:| Omit overlaps &
Interval 2. i ] Restrict

Clane A times Horzert

Symbols | X Color (W)

O nintnin.i EEEREEEREREITHER NN ENENENRERNEWEREYENN)

*1

» Change value in the Clone text box to 2. When more than one clone is entered the shapes multiply
around a point indicated by the clone handle.

I
Contral Panel
~ Positions | 20 i ] |:| Omit averlaps & L
. *
Intenral 2. i ] Restrict *
Clane 2 times HomzMVert ="
-
[sccept | symbos x Color (M) *
L 3
-
*
! *
i
-
-
-

LJ

-
-
= uinlnluii@niulnlnluﬂfﬁ'\
S *

-

L

-
3
-
-
-
-
»
E 3
-
.—Il
-
-
-
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* Now, change
value in Clone Fositions 20 @& [ | Omit overlaps (| e e
text box to 3. Interval | Z. & =t e e e A
Clane 3  times RIS EYEn: ....”f ....... f.”

Symbals | X il [ )| RREAREa RS e aR A na nan s s ann 2 nn  naaa na
Click and drag the “.;.1"”:”.m.5 A A A M M W WA M W M WA S AN MmN eam AN GEEE AuE EaNAmENNNERE SR ASEENEAE AR
clone handle until | | - - { | | . ;
all four lines form
into a box.

AR A ; o nw el | | E : '

W
*

nl*!nl*!nl*tntitntf

n@nin@n#ngn#nf&q&qt#

SERBBIA LR,

R:po*‘ition Handle
» The next few steps will experiment with changing the placement

of the shape. This can be done with the Reposition Handle /\l ™
located in the middle of the top line. T the shape t S ,[/ o
ocated in the middle of the top line. To move the shape to a D s Whiale , Mbves Point
different location on the field, drag the center of the Reposition Shape . of Rotation
Handle.

* You can also use the Reposition Handle to reposition the (

shape by rotating it. The center of the Relocation Handle is
the Point of Rotation. You can change the Point of Rotation

by dragging the outer ring of the Reposition Handle. Fotater Ao

» Rotate the place- Fasitions 20 ﬂD Omit overlaps i |
ment of the shape - Interwal 2. & Restrict
. | ; HomMert
by dragg|ng the Clane 3 times
Rotator Arm of Symbols X Coler (M)
the Reposition AT
E ]
Handle. e e e e e et 1;‘ PRRaEEaranARinEyTIEREET T iRERITTS
xt *
3 L
* L
E
* ™
» [ 3
*
p ¥ o
. -
- e
* -
-
- oy
* ] -
L3
* . ra
»
frEE e e P ok e el el H el b et
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* It's time to stop experimenting and to actually enter a shape. Let's cancel the shape we have been
working with and start again. Clicking on any tool in the Tool Palette will exit from any tool you are
currently using. If the tool you click on is the same tool you are currently using, it is like starting over
with the tool. So, click on Line tool in the Tool Palette to deselect it and therefore cancel the cre-
ation of the new shape.

LINE TooL
(TAKE 2)  Click on the Line tool to select if it is not already selected. A Line Tool Control Panel will appear.

* Click on the padlock assigned to Restrict Horz/Vert option in order to restrict line to either horizon-
tal, vertical, or 45 degree alignment.

« If not already done, enter these values into the Control Panel: Positions = 20 and Interval = 2.

» On the field, place the 1st endpoint of the line to the LEFT of the 50 yard line where the Location
Indicator reads 45 yds 6 stp | 42 stp and click the mouse button.

* Place the 2nd endpoint of the line to the LEFT of the 50 yard line where the Location Indicator
reads 20 yds 4 stp | 42 stp and click the mouse button. Twenty positions will appear in a line at a 2
step interval.

» Change the value in the Clone text box to 1. There are now two horizontal lines on either side of the

50 yard line.
@ |L|T|o#Q
[};’_’_’_3 B2 2N EC S E FE L 15 volz 4.00 stp | 39.00 stp ) IR
J@ 2 & /l7oZ9 o7 £8 TS 0 of 40 posttions selected
- Editing count: 0
= [ 2]}y Length: 16.4 sty (26 2yd)
Positions | 20 &[] omit overlaps
Interval 2 & Restriot
Homvert

Clone 4] | times

Symbols | X Calar @

o = Q.tllﬂ.‘é?'tnﬂ“ e X R

» Before accepting the shapes designed you can assign the positions of the shapes a Symbol and
Color. The default symbol and color is currently show in the Control Panel. The symbol should be
an “X" and the color should be blue. If not, enter them now.

 Click Accept in the Control Panel. You should see 40 positions divided into two lines on count 0.
The Console is showing the number of Performers as 40.

16



Chapter 2 - The Tutorial

DRAWING ARCS
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 To assign the arcs

The next shape we are to design will be a simple arc of 30 positions. Both endpoints of the arc will
connect to the outside endpoints of the two lines.

¢ Click on the Arc tool in the Tool Palette. An Arc Tool
. i . S I
Control Panel will appear. SSESRPAR @<
PP e L& A0 &=

* |In the Control Panel, enter 32 in the Positions text

box.
Fositions 32 & [ ] omit overlaps [rata Pt=.

Interval O |5 50

Clane 0O  times

Symbols | X Calor (W)

» To place the 1st
arc endpoint,
move the cursor
to the RIGHT of
the 50 yard line

where Location

Indicator reads: AN AN A NN | MM A E }(}((IED
25yds Ostp | 42
stp and click the
mouse button.
THIS IS THE LN 1 M I M 1M WP || M N oo TN MR L M AE i MMM I TN 1
CORRECT
LOCATION! WE ARE LOCATING IT DIRECTLY ON TOP OF THE LAST POSITION OF THE LINE.

 To place the 2nd
arc endpoint,
move the cursor
to the LEFT of the
50 yard line until
the Location Cm}m B ORI R N | N R W e e e
Indicator reads
25yds Ostp |42
stp and click the
mouse button. M LN I T I M 1M WP || NN o TN | MW i M W 1| ¢ TN T 103

peak, move the
mouse until the
Location
Indicator reads

50 yds O stp | 20 o
stp and click the Lt *
mouse button. * *
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» Before committing this shape to the file, this would be
a good time to experiment with various editing
options in the Arc Control Panel. Change the value interval 2948 f§
in the Data Point text box to 3. Three data points —— @

. Clone 0 times
create a 2 sided V shape.

Symbals | X Calor @

Fositions 32| & [ ] omit owerlaps [rata Pts.

* Now, change the value in the Data Point text box to
4. Four data points create a 3 sided shape.

 Finally, change the value in the Data Point text box to 20 to return to the original arc shape.

 Click on the Omit Overlaps option in the Control
Panel. When we created the arc, the two endpoints

of the arc were entered on top of existing positions. Positions 32 A()Omitoverlaps  Data Pts.
The endpoints were entered as “pic” points and not Interval 2072 § (#)atendpoints &f
intended to be filled with a performer because we Clone O times () amawhere

have already placed performers at those points. Omit Symbals | % Color (W)

overlaps removed the overlapping endpoints thus
preventing two performers from being on top of each

other.
GZIK L A A S A S S KKF@:)(KK L A A S A S S KED
» *
» *
# "
E 3 E
Qilta 1 1 i3t TN 2] A AT TR F il AR Ty .. M Nl =
£ 3
- . . *
» -
* ™ - -
s alln & *

 Click the Accept button in the Control Panel. The Console has updated performers to 70.

LT oQ
il 2N [ hl=Ee e FiE LA 10 yds 6.00 =tp | 70.00 stp 1% W [
s

Rl JAo0Ze s T 28 [T/e 0 0f 70 positions selected
Edfting count; 0

- 581 =aq

(It s St S EE St EREESEESEEEEEE G S E TS §
LS x

S
el
s

Xlx | %

» Select Save from the File menu.

18
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CIRCLES
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The third shape to be entered in our drill will be a circle.

Interval = 2.
. P ositi 24 Omit cverl Data Pts.
« If not already checked, check the Lock to Circle r:t'E':u: = g [] omit overlaps =
; 100
option. Clone | 0 times
Lock ta circle |:| Offset spacing
|:| st place attop of circle.
Symbols | X Calor @
* Toplacethecen- - - -
te_r point of the BRI 2« [ (R e A Emmn Aan
circle, use Interal 2 A 100 MR A AR
Location Clone | 0 [times  Jamawhers ) HEEEH A A P AR
Indicator in the  [uosko e | [ otetpasr [ R B IRU AR R IRHRRE
COﬂSOle to move 1zt place at top of circle. : | I |
the cursor to 50 Symbor s coior | A
yds O stp | 56 i T PR P
stp and click the i
mouse button. T
""""""" KOO OGO OOOCOCOCC0 | 000000000 00
HHHHHHH e T P R PP TP PR H e PR TP T e
....... HERAHH I H
| M | | | ]
1 I i I L B L i
e I I E E E LS
e e o e o e T e S
o | | | | x
..................... 1 o O L,
e e ERaN e
{ ()(K }(}(31
* To place the cir- | I |
cumference point | .n‘l' . |
of the circle, . .t
move the cursor | * @9
on the field until 4
the Location " *
Indicator reads * ey @
45 yds 4 stp | 48
stp and click the
mouse button. AHAX AN A N A A AN A | WA A W W R H
! "
S .
M X
E i
H . " H
TRIC Cu it - R s F i NN v i1t Cu il o
H A
be b
IR 3 | % B
I A

Click on the Circle tool in the Tool Palette. A Circle Tool

Control Panel will appear.

In the Control Panel, enter Positions = 24 and

Chapter 2 - The Tutorial
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» Before committing
this shape to the
file, this is a good
time to experi-
ment with various
editing options in
the Circle
Control Panel.
Select the Offset
Spacing option.
This will attempt
to equally distrib-
ute the positions
of the circle
across the point
entered as the cir-
cumference.

* Unlock the
Interval padlock
and remove the
check in the Lock
to Circle option.
This creates an
oval shape. The
two red square
editing handles
can be used to
shape the oval.
You could also
use the
Reposition
Handles to shift
and rotate the
oval.

Recheck the
Lock to Circle
option. The circle
will snap back
into place.

Change the value
in the Data
Points text box to
3. Notice this
procedure creates
an “outlined” tri-
angle. Similarly
you could create
an enclosed
shape with any
number of sides.
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Fozitions 24 & [ ] omit overlaps [rata Pts.
Interval 18100 100
Clone 0O times

|:| Lock to circle Offzet spacing
|:| 1=t place at top of circle.

— — ——r —r— — —t —r—
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Fositions 24 & [ ] omit owerlaps [rata Pts.
Interval 1.810| § 100
Clone 0 times
D Lock to circle Offzet spacing
D 1=t place at top of circle.
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Faositions | 24 &% [ ] omit overlaps Data Pt
Interval 1942 & 3
Clone 0 |times
|:| Lack to circle Oftset spacing
|:| 1st place attop of circle.

|
|
1
.nl *
" ..
i TR
|

ERE S SR S SN AR 06 S S A 08 658

-
E =N
*

|

LA S0 SRS S




Chapter 2 - The Tutorial

Click on the Circle Tool in the Tool Palette to de-select the Circle Tool and cancel the creation of
the circle.

CIrRCLE TooL
(TAKE 2)

21

Now let’s re-enter the circle.

Click on the Circle tool in the Tool Palette. A Circle Tool Control Panel will appear.
If not already entered, in the Control Panel, enter Positions = 24 and Interval = 2.
If not already checked, check the Lock to Circle option.

If not already checked, check the Offset Spacing option.

To place the center point of the circle, use Location Indicator in the Console to move the cursor to
50 yds 0 stp | 56 stp and click the mouse button.

To place the circumference point of the circle, move the cursor on the field until the Location
Indicator reads 45 yds 4 stp | 48 stp and click the mouse button.

In the Control Panel, change the Symbol to G for Guard and the Color to a shade of red.

Select Symbol Color

stohes | 135 | ReE

O RO RO
| |

Previesw

a - B Serple Texd Sample Test .
Sarmgle Text Sanple Text

. u . Satnple Text Sampls Text

Click Accept button to enter the circle.

Select Save from the File menu.
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MovING LINES
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We have now created the opening formation at count 0 which is Set #1. Now we will create the next
set by “morphing” or reshaping your formations at Set #2. Initially 3D has established a mark time
between Set #1 and Set #2. As we reshape the formations at Set #2, 3D will automatically create the
transitions to Set #2 from Set #1.

To indicate the count of the next set and the number of counts in the transition from the last set, we will
spread the anchors in the Count Track over those counts. Setting the Yellow Anchor at count 0 and
the Red Anchor at count 16 will setup the field for editing of the formations at count 16 and create a
16 count transition between counts 0 and 16.

 Click on Page Tab #2. The Red Anchor will snap to count
16, leaving the Yellow Anchor at count 0. When advanc- g = = H
ing the Red Anchor, the performers field locations will not -ﬂ'”""é"'"'&"""I"""'I"""'I"""'
16
B

appear to change even though we are now be looking at 24 32 40 ¢4
count 16. This is because since editing has not been done, z :
performers at count 16 are simply marking time from count

0. In fact, 3D has established a mark time to the end of the

drill.

 To create the formation at Set #2, you will be selecting shapes and then using edit tools to reshape
them. In this example, our Red Anchor is at count 16 and therefore the shapes we are editing are at
count 16. Since the Yellow Anchor is at count 0, the transitions will be created between count 0 and
16. From count O to count 16, we are going to have the two lines Push (or move) forward towards
the home sideline.

* In order to Push the lines, we first need to select the lines
: [ 1 » | ) T L]
on the field. In this example, we will choose a Box Select ii ;:' P f;: 2 &

tool for that purpose. Select the Box Select tool from the
Tool Palette.

 Click above and to the left of the first position of the left line and drag down and to the right until both
lines are encompassed within the rectangle you will be creating.

[ Click Hers

MR XK N XK X | X XX X MK

The performers of both lines will be outlined in bold red indicating that the two lines are selected.
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* Now that we have selected the two lines, we
. ’ IR » g ® L |~
need to choose a tool to manipulate them. 5, & = f; ;" A HO @ s =

Click on the Push tool in the Tool Palette. A
Push Tool Control Panel will appear.

» Before committing this transition to the file, this would be a good time to experiment with various
editing options of the Push Control Panel. Press the <down arrow> key of the computer keyboard
16 times. This procedure is used to push a shape implementing the down or up arrow keys.

* You can drag any editing handle located on each performer in the selected lines to a new location.
All selected places will similarly move as well.

L T aaa/y@},aa L T R T
= "
E@EE@E@EE@@@EE@E@E@' 0 0 o 0 0 0 0l o o KK
E i
M 5 " M
R s R I Mt et Rt et | N B i Bt s Bt (S o ! R W i i R
H M
L Lt
] X |x | X [
e e
¢ Click on the Revert button. The shape will return back to the original location.
» Enter in the Stride text box the number 8. This will cause each position to move a distance at a
stride of 8 steps to 5 yards in 16 counts.
Stride | & s £ &
Distance  10.0 ! Hﬂﬂctrt
; ; a L}
|:| Show Symbals Clieetch
Mirraring 3T 3= 3
seous move
EEED
Lo
& %%
=
AR AL oM 1 TN 1ol o N 1T S WERE § T Lo Mol el 2
—g GE:
Ge Ge
5 8
R AR R R .;:J-}”.”“”“”,””
. i
A L
A "
X i
3 x
R N N T N T B N R A NN A rANMENF A EEEEF AT RN A N
L L L L L e T A T LU CEE L L
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» Located on the left side of the Count Track are the Animation Controls. Click on

the Play button and the selected lines will move forward. When the pointer of the Y
Count Track reaches count 16, the animation will stop. @ll [
I B

 Click Accept to accept the movement of the selected lines.

» Select Save from the File menu.

SPLITTING
SHAPES There will be times when you will want one portion of a shape to separate and "split off" from the rest
of the shape.

« First, you need to select a shape that you want to split into two parts. In this example, we will select
the arc. Select the Pointer tool of the Tool Palette. You can also activate the Pointer tool by press-
ing the second button of your mouse.

* Click on any posi-
tion of the arc. All

performers in the 699 5 9886

arc will appear in ks -

bold red to indi- = ——"F—FF—+"+—+"—%& | — 'f;" GAre DT e
cate that the i3 5

shape is selected. Be sl

aE A ey SEan
¢ Click on the Knife tool in the Tool Palette. A Knife Tool ;
) . ) i s | [
Control Panel will appear. The Knife tool is used to cut a E; o . 2 Pg 2 &

shape into two or more shapes. :

The Knife Tool Control Panel behaves differently from other tool panels. By default, there is no
active Accept button. Every cut with the knife is
accepted without having to click the Accept but-
ton. This is usually preferred because the Knife

tool is used quite frequently for single cuts.
Requiring the click of the Accept button would (%) Knife [ “pply Pamem > | aBC v
simply add an extra step. However, if you wantto | _ lue Hahres #| [undolast)

make the Knife Tool Control Panel behave like [ Group like the Secandary Court |
typical 3D control panels, you would click OFF the focept each shange and stick anound.
“Accept each change and stick around.....” Flick on another tool when finished.

option. When the option is off, the Accept button
will be available and if not clicked when you are
finished cutting, then no changes will occur.
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 With your cursor,
click on one of Y L S R S T P S S
the two positions \ /r
closest to the 50
yard line. Ared

bubble will appear
on the position.

» Click on the other
position that is

closest to the 50 ] B
yard line. A gap _\ f
will appear

between both

positions. The

two arcs created LS G 6 O AR NN | XA N A H R KR
will now act as

two separate *“"-ﬂ-—m@i—""

shapes.

MIRRORING
MoTION

25

In one step, we are going to Push the two arcs in two different directions. On the Count Track, make
sure the Yellow Anchor is set to count 0 and the Red Anchor is set to count 16.

* First, we will need to select the two arcs. Select the o e i
Pointer tool in Tool Palette, or press the second button of AL 12N £ E 4 :
your mouse to activate the Pointer selection tool. 24" 2 & SA02 Sl

* Click on any posi-
tion in one of the PR R

&
two arcs. All of & Qs
the performers in e E
the arc will g'f

. L G
appear in bold red %6 o laab

to indicate the arc
is selected.
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* Press and hold

the <Shift> key A achar
LT 5
while clicking on o o
any position inthe "t ale bl boge b VB b b gl b bl b Ll
other arc. It will €, b
[ i 5
also display in 8 s

bold red. Holding
the <Shift> key
while selecting a
shape will add
that shape to any
previously select-
ed shapes or i { MMMy AN SRR R

" A L ar
positions.

» The two arcs are selected. We will choose NEEE R REE EE j i L~
the Push tool to move these selected arcs to ¥ AE S0P -7 Tl&

a new location. Select the Push tool in the
Tools Palette.

¢ Click on the Left/Right Mirroring option in the Push Tool

Control Panel. T -
Distance 0.0 ] HRT:ﬂ:fctrt
L .

|:| Show Symbaols Drirection

Mirraring |ﬁ -l 14

fooept | pmous mave

¢ Click on the inside position of the RIGHT arc. Click and drag position until the Location Indicator
reads 40 yds 0.00 stp | 8.00 stp. Both arcs will move in motion mirroring left/right to each other.
Light gray lines indicating each selected performer’s path will appear as you move the cursor.

+ 4 + s w -+ R + + » - o + . R A I
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« If adjustment needs to be done, simply click and drag the shapes to desired location. The maneuver
will not be committed to the drill until you click the Accept button.

¢ On the left side of the Count Track are the

Animation Controls. Click on the Play M
button to preview the moving arc with the @II [
moving lines. A

 Click on the Accept button to commit the new move to the drill.

» Select Save from the File menu to save the changes to file.

EXPANDING
CIRCLE From Counts 0 through 16, we will expand the (color guard) circle.

* On the Count Track, make sure the Yellow Anchor is set to count O and the Red Anchor is set to
count 16. Clicking on the page tab on count 16 will set both anchors at one time.

» First, we need to use a selection tool to select the circle. Click on the Pointer tool in the Tool
Palette, or press the second button of your mouse.

 Click on any position in the circle and all of the performers in the circle will be highlighted in red indi-
cating that they are selected.

iz

* Click on the Resize Tool in the Tool Palette. i 4 .

. . 3 & N Fall e i /"*@Lr"
A Resize Tool Control Panel will appear. fo 2E /S 00 DE: T &

 In the Control Panel, if not already clicked,
click on the Scale option. (%] Scale Scaleto 100.0 | %

(") Stretch Show Bridges
() elant [ ] Showiiebbing
™Y Distart |:| Show Symbaols

ATOWE Mowe

[ Accent ] [ Rewart ]

 Let's experiment with options in the
Control Panel. Click and drag the lower
left (red) handle until the Location t CYEEL AR SRR, e
Indicator reads 40 yds. 0.00 stp | 40 * .
stp. The circle will expand away from * *
the center. The outside edge should » R R
touch both 40 yard lines. d
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¢ Click directly in the center
of the Reposition yuii .
Handle and drag until the ; .
Location Indicator reads ron (EEERDY, SRR, SRR RERE, o JEN ARG RN EREEC R R RREE | RRERY 20,
50 yds 0.00 stp | 36 stp. e e B .i £l
Now, the circle will not o S e -
only expand, but it will ]
also move towards the T S SR S0 H S P | P O P o P STER AP Sr SPar Apap s
home sideline. =

SR KK R T K W K K KK

.

.

-

o

g LA Lol - f

* On the left side of the Count Track are the Animation Controls. Click on the
Play button to preview the expanding circle with the movement of the other shapes

in the formation. nme.
LI I

g

* Click the Revert button in the Control Panel so the circle will return back to its original shape.

 Click and drag the lower left t = *
(red) editing handle until the b i
Location Indicator reads .
35 yds. 4.00 stp | 36 stp. *
The circle will expand away e "
from the center. e

i

FRFRFENSFEFRFRN SEay St ./... FRVSFEFR TRV SIS SFRY SFRY SFaY VRN Srer arar

B e R e T S e e

* Click on the Accept button to commit the change to the drill.

e Select Save from the File menu.

28
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Chapter 2 - The Tutorial

You have completed the first 16 counts of drill. To continue to the next set, you must move the Red
and Yellow Anchors on the Count Track. From counts 16 through 48, we will reshape the two arcs
using a Follow the Leader maneuver.

* Click on Page Tab #3. The Yellow Anchor = . -
Willjumptocount16andtheRedAnchorwi” ||||||||||||||| A
jump to count 48. J 24 31 40 56 64

2 2

* First we need to select the two arcs. In this o
example we will choose the Lasso Selection Rl 8 2% | 2] =]
Tool. Select the Lasso Selection Tool from AR AP P

the Tool Palette.

~ G 4 ]
8 T

v L -~
& g Rt T &

 Using the cursor drag a lasso around both arcs. Once selected, both arcs will be shown in bold red
to indicate they are selected. Since the Lasso Tool select only places that are inside the lasso, it is
possible to miss some positions. So make sure all of the performers in the arcs are selected.

56 ﬂj ...... e -

& '__k';é:"mxxx OO ooOOE oo oec oo [ |

BRI R R s
SR Mrﬂ// i

¢ Click on the Follow the Leader Tool in the

Tool Palette. B[] 2% (2% [ = ]| [ [ Rugl ) | L]~
’T@ 2 & | A-012 T &
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* Red “Leader” dots highlighting the end performers on each arc indicate the performer that will be the
leader for the follow the leader movement. Depending on your application, the correct leaders may
already be chosen, and this step is not necessary.

We need both of the leaders to be the outer most performers of the arcs. If both red “Leader” dots
are not on the proper position of one or both of the arcs, you will move the “Leader” dots to the
proper endpoint by clicking on the incorrect “Leader” dot. The red “Leader” dot will automatically
move from one end of the arc to the other.

R '\\:_ B Y B S A e e eV v _:)’__

i L

S, e sl

B e i
H?| FEEEPS

The picture above is a sample of leaders where the leader in the left arc is on the incorrect endpoint.

' ‘Q}‘ I R I D L S T L T d ‘[@‘ '

b, P SRR B ol

The picture above is a sample of leaders who are correct.

 In the Follow the Leader Control Panel, click on the
[ ] cunved shape Handles

Left/Right Mirror option. - [ Delete Hait |
hdirraring b 14
Clicking on leader (red

dot’) changes leader.
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* Click the mouse on the RIGHT side of the field at the location where the Location Indicator reads
35 yds 0.00 stp | 44.00 stp to start a path. A straight path for both shapes will appear. A red editing
handle (square) will appear at the point where you clicked.

=
L5
"
L= L _
. T
RN
i " " ™
'_,.»" E o 6 “t__\‘
.I/' ‘\‘k
[ bt
{ EAE LA S AR AR AR SN A SR AR R B AR AL SR S AN A L S A >
\.\_\ £ ¥
B e
\"\_ /-'“
H‘Hhﬁ_"‘_ ___,__«—F-""’-J/

* Press and hold the <Shift> key while clicking the mouse approximately halfway up one of the path-
ways of one of the arcs. A new editing handle (red square) will appear on the RIGHT path.

i -
5
L]
i
=
* & £ m*m -~
¥ 5 - N\
el Y
. "1@1
T R L S R S L a S
\,\“n\ /“)./‘/
[ ]
‘-\ /"
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* Click and drag the new editing handle until the Location Indicator reads 15 yds 5.00 stp | 41 stp.

L.
=

L.
=

5

S

PR,

2l
x\ LSE L SE S8 S, 68, %, 8,58 S 6% S, SE.SF SL AR RE.O S5 65 SEAE S8 SE. G0 8L 65 SH S R0 S5 65 0 6

e

< Py

 Using the Play button in the Animation Controls of the Count Track preview the animation.
» Click Accept to commit the change.

e Save your work.

GLUING LINES

32

There will be times when you will want to connect (or reconnect) one shape to another. This function
is most important when maneuvering two (or more) shapes into one large formation.

 For this example, make sure the Count Track’s Yellow Anchor is at count 16 and the Red Anchor
is set to count 48.

.ﬁz:(;?tt(:hEBox Select tool from the Tool 2 N I HES s E LA
' e & L0 2  ODT To

* On the field, select both lines.

Click
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33

» Select the Glue Tool in the Tool Palette. A

) b || 2 B |0 EE G S ke L
Glue Tool Control Panel will appear. ¥ e # i ST T a

» With your cursor, click on one of the two positions closest to the 50 yard line. A red bubble will
appear.

o

* Click on the other position closest to the 50 yard line. A red line connecting both positions will
appear. The two lines will now behave as one line when selecting it.

=

=

(T
T
bk
ok
=+
=
>

il

e Save your work.
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MORPHING LINE | In this exercise we will “reshape” the lines into a new shape.

 For this example, make sure the Count Track’s Yellow Anchor is at count 16 and the Red Anchor
is set to count 48.

« If not already selected, select the line with one of these selection tools: Pointer Tool, Box Tool, or
Lasso Tool.

+ Click on the Morph Tool in the Tool Palette. —— —
A Morph Tool Control Panel and red editing | P R I il s S L “A‘
handles will appear over each performer of J@ 2| & | AA0l2 =T T o
the selected line.

it
o
gl

* In this exercise, let's experiment with some of the options in the Morph Tool and its Control Panel.

» Drag any of the editing handles to any position on the field. When one handle is adjusted, path-
ways for each position of the selected shape will be altered in order that equal spacing is maintained
in the new shape.

E
L5
AR W oW e = oW K raE
€ £ . ;
_m\” 5 SRiREC
-
I E&EE]B[E@EE&DEDE—E&M@* {3 T M (] ) (M R T :
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 Click Revert to return the shape back to its original shape.

 Click on the Fewer (handles) option in the Control Panel. The

fewer number of editing handles you work with, the more fluid Cunsed Shape Handles
shapes will become. [ ] Lock Intervals

ATOWS Mowve
Show Bridges

|:| Show Symbols

e

 Continue to click the Fewer button until only three handles are remaining on the shape. If you click
too many times, click Revert and try again.

&

R C R e e . S aasan O )R

stp.

s
[
oot

I TR T T S T T I L R R T L TR IE S S S N R
. | -
- -
*

» Use the Play button in the Animation Controls to preview these changes and then we will continue
to experiment with more Morph Tool options.
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» Now we are going to put an editing handle back in the shape. Press and Hold <Shift> key while
clicking the mouse to the left of the second editing handle. A new editing handle will appear on the
shape.

=

i

L]

 Click and drag the new editing handle to the location indicated by the Location Indicator
(Left) 40 yds 0.00 stp | 40 stp.

=

~
/

» Use the Play button in the Animation Controls to preview these changes and then we will continue
to experiment with more Morph Tool options.
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* Now let's remove a single editing handle. Press and hold the <Shift> key, and click directly on the
second editing handle to the left of the 50 yard line. The handle will vanish and the shape will
change accordingly.

, LY y A L LT ,
W w7 N RS & AR Iy ¥
& (=
R \-\E\ IR SR
/ -
=

 Click and drag the next to last editing handle until the Location Indicator reads 50 yds 0.00 stp |

0.00 stp.
rab wlw oW H 4 AR patr
4 £ " v
" : &
imn \m\'\‘\ ’/‘uf ass
hwﬂ
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* Click and drag BOTH outside editing handles (the endpoints) until the Location Indicator reads 15
yds 6.00 stp | 24.00 stp. If necessary, re-adjust the endpoints to connect with curvilinear forms on
either side of the circle.

TEETan aarid u aur 5 = EIRE T e
% = ¥

H,
s
i

H,

|
s PP

o
A
2

bt'ed a1l k' L Ll LA roil A LANE R b til Ll ol Sk

L R R S . .o ..o Ioo L R R e . v o o ¢ € 4

Sl i

\kk&m@w”/

-

» Use the Play button in the Animation Controls to preview these changes.
* Click Accept to commit the morphed shape to the drill.

» Save your work.

PAss THROUGH
ExamPLE In the next exercise we will transform the circle into a meshed vertical line. To achieve this, we will use
Knife Tool, Glue Tool, and the Morph Tool.

 For this example, make sure the Count Track’s Yellow Anchor is at count 16 and the Red Anchor
is set to count 48.

« If not already selected, select the circle on the field using either the Pointer Tool, Box Select Tool,
or Lasso Tool.

¢ Click on the Glue Tool in the Tool
Palette. A Knife/Glue Control Panel

Regroup Al

will appear. ™ Kni
\ Knite ABC e
« Click the Regroup All button in the N Halves v
Control Panel. Observe that the circle (&) Glue [ e

Group like the Secondary Court ]

shape will segment into individual posi- o o —
H HIRG ] H GEFﬂZ edch change an stizk around.

t!ons.. NeXt’ we will reqrder the posi- I:|I2Ii|:k on another tool when finished.
tions in a pattern to achieve our “X/O”
grouping.

38



#m v.4

39

» With the cursor, click on the position at
the top of the circle and to the left of
the 50 yard line. A red dot will appear
on that position.

» Move the cursor across the 50 yard
line and click on the position at the top
of the circle and to the right of the 50
yard line.

* Move the cursor to the left and select
the next position left of the 50 yard line.

Chapter 2 - The Tutorial
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« Continue selecting each position of the | |
circle in the same “zig/zag” pattern until
all positions of the circle have been =

selected. If you mess up, simply click -t
Undo Last or Regroup All and start
again.

e
=
e
e

+ Once all positions in the circle have icé—:;b
been regrouped, use a selection tool G———
such as the Pointer Tool to select the B——
circle. Notice that the blue lines in the R EERE Bt ey
selected circle have now been
rearranged to indicate the new group-
ing order.

? V{F 2
J
l
|
J
|
|

|
|
.

* Now that we have regrouped the circle into a [e £
zig-zag pattern, if we morph the circle into a J @
line, it will make the circle positions mesh.
Click on the Morph Tool in the Tools Palette.

» Click on the Delete Curved Shape
Half button to
remove editing _ .
handles in the Show Bridges -
Morph Tool [] Show Symbals
Control Panel until

fiY Rewert
all but the handles _accent ] [ ] T e ]
at the end points of
the shape remain. I

|:| Lock Intervals
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* Click and drag the upper editing han- i =
dle until the Location Indicator reads 3
50 yds 0.00 stp | 72 stps.

 Click and drag the lower editing han- -
dle until the Location Indicator reads
50 yds 0.00 stp | 12 stps. The red i
line drawn from one of the positions
designates the performer who is travel-
ing the furthest distance during the L
transition. The Step Length and
Distance Traveled by this performeris = | [
displayed (in red) in the Console.

LR D RE B T T T R T I I e - ® + 2 2 o+ @

Rrlale ] 1
oy

}{V}r|}rv‘>{

» Use the Play button in the Animation Controls to preview these changes.
* Click Accept to commit the changes to the drill.

» Save your work.
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CREATING
SET #4

42

You have completed the first 48 counts of drill. Let's move on to the next set. In the final set of the drill
we will:

1 Segment the large arc into two smaller arcs.

2 Draw two new mirrored shapes on count 72 with performers coming from two pre-existing arcs
located on count 48.

3 Match the positions of the pre-existing arcs on count 48 to positions of the two new mirrored
shapes on count 72.

e Click on Page Tab #4. The Yellow

AnChor Wllljumpto Count48 and the B-JllllllllllllllII|IIIIIII|IIIIIII|IIlllllllllllll;h;Illlllllllmlllllllll.IIIIII|I
Red Anchor will jump to count 72. rﬂ 2 16 24 32 40 4|E 56 B4 a 20
[ F 2 4

» Select the large arc using Pointer Tool, Box Select Tool, or Lasso Tool.

| rlHE Q[ kgE L]
¥z A-0lz2 [o=T Te

A Knife/Glue Control Panel will appear. HIEES

* Click on the Knife Tool in the Tool Palette.
S @

Fegroup Al
() Knife fpply Fattem » | ABC bt
O one DI JHaves v [Undoiza]

Group like the Secondary Courit ]
Dﬁccept each change and stick around.
Click on another tool when finizhed.

» We will cut the arc into two smaller arcs. With your cursor, click on one of the two positions closest
to the left of the 50 yard line. A red bubble will appear.

4
|
o
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* Now click on the other position closest to the 50 yard line. A gap will appear between the two posi-
tions indicating the large arc is now two smaller arcs.

2

» Select both arcs again using either Pointer Tool, Box Select Tool, or Lasso Tool.

 Click on the Curve Tool in the Tool Palette. N FERPEE R - S R P L R R S
A Curve Tool Control Panel will appear. ¥ AR /@3 & ST T &
¢ In the Curve Tool Control Panel,
enter 20 in the Positions text box. Positions| B8l | @ [ ] Omit sverlaps Wendles  (detehing Lines
Intarval 0 5 [ Dzl Halt ][ Rewert ][ Clear ]
Clone | O | times | Del Last || Flip || Back |
[] Predict Mext

 Click OFF the Omit Overlaps option.
Fasitions 20 & [ ] omit everlaps Handles M atching Lines

 Click ON the Predict Next option.

Intersal 0 & [ Del Half ][ Rewvert ][ Clear ]
Clone 0 times | Dettast || Fiip || Back |
Predict Nesxt
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» On the field click on the following points to create the shape of the curved form.
LEFT 45 yds 6.00 stp | 16.00 stp
LEFT 35 yds 4.00 stp | 4.00 stp
LEFT 25 yds 0.00 stp | 20.00 stp
LEFT 10 yds 0.00 Stp | 12 stp

X P ®
: E A
| o A
» i : EOL- = 9 A,
- ' i s il
* TR ® me
» ] £ =
W ‘:)a ok E
_\_\_—_‘—‘——.. AT s s A
] ,a-l_.“_ : ! 5 )
E““\L,B == el
. i A
Al . T,
BEe e
| il "0 o |

While entering these points, the red editing handles will appear at each point. These editing han-
dles can be dragged to adjust the shape. We are creating this curve with only four points because
the fewer the number of editing handles the smoother the curves of the shape.

» Enter in the Clone text box 1. Two mirrored shapes of 20 positions will appear.

PR - f e

e j |

-
=

AR

7 *

e

44



Chapter 2 - The Tutorial

MATCHING
PosiITioNs

45

Currently displayed are gray matching lines “criss-crossing” connecting some of the performers of the
pre-existing arcs to the places in the newly designed curves. The matching lines indicate which per-
formers in the pre-existing arcs will move into the places in the new curved shapes. These gray
matching lines display the current “matching order.” Obviously, the crisscrossing lines are indicating a
matching order that is not the matching order we want. We will enter a new matching order by re-
arranging the matching lines to connect “or move” the performers from their current positions in the
arcs to their new places in the curves.

 Since the matching lines are indicating the incorrect matching order, click on the Clear button in the
Curve Tool Control Panel and all of the gray matching lines will vanish and a red bubble will
appear on the endpoint of one of the new curves. The red bubble indicates the new place that we
will be matching first.
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» 3D has a matching prediction function that will attempt to complete the matching order based on
your first few matches. In the Control Panel, click the Predict Next option ON in order to enable
this feature.

» To get the matching prediction function started, you will e
need to make the first match. The new position inside
the red bubble needs to be matched with one of the - S Sy 5o
performers of the arc. To do that, click on the performer
at the endpoint of the LEFT pre-existing arc. This is the
performer that we want to be moved into the new place
highlighted by the red bubble.

As shown here, the red bubble advanced to the next
place in the new curve after the first match was made.
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* Click on the next performer of the pre-existing arc. Again, this will move the performer currently
located in the arc to the new place in the curve highlighted by the red bubble. After this match, the
Predict Next function will take over and attempt to correctly match the remaining positions of the
first shape according to your initial matches as shown here.
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» Animate the drill if you want to preview your matches. Should you think you made mistakes and
want to start over, click the Clear button and try this section again.

* Click Accept to commit the curves to the drill.

e Save your work.
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REVIEWING
SETS Let's see what we have so far.
e On the Count Track, drag the Yellow Anchor back to count O..
* Make sure the Red Anchor is on count 72.
1] = - B
I IIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIII [LRA I|IIIIIII|IIIIIII|IIII
72 | g 16 24 32 40 48 456 A4 30 33 96
s B—
¢ In the Animation Controls, click on the Play button.
PRINTING Since Page Tabs have already been inserted, it will be very simple to print desired pages.

47

* From File menu, choose Print Charts. A dialog box will appear allowing you to configure the way in

which your charts are to be printed.

30 Print Charts

Prirt Selection Preferences

() Currently Displayed Count [¥] Piint all performes black. [] Thicker giid lines.

Creerlay Set

(%) Use Previous

rom Page Tabs Printeach performers label. DPerformer\fiewpmnt[le\relse\fiew]_ ) Use Next
Thumbnails( | 8 RS Frint text. D Mark center of performer locations. Statting Set# 1
[] magnify symbols []Zoom chart for largest printaut

Set SubSet Count Print Overlay Faths Title

1 F] 0 [#]  |Mone

z L] 15 [¥]  |Mone

< 1] 4a [w] None

a 1] 72 Hone

Prirt Problem? | Shortcuts: |Frint | Dwverlay w Paths b Save as Default “ Print f Preview |[ Cloze

* In the Print Selection options, click From Page Tabs.

* In the Overlay Set options, click Use Previous.
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 Click the Print/Preview button. A dialog box will appear allowing you to preview the printout and

configure Page Setup options. The Page Setup dialog box differ, depending on the printer you are
using.

30 Print Charts ||
Print Selection Preferences Owetlay Set
O Currently bisplaved Count Frint all performers blask. [] Thicker grid lines. USE Freiie
roTP e T Frint each performers label [ Performer viewp oint (revetse view). S
| Print text. Maik center of performer locations. e
() Thumbnails¢ | & per page) Ll b Starting Set# 1
[] Magnify symbols []Zoom chart for largest printaut.
Set  SubSet  Count Frint Ovelay  Paths Title
1 D o E None
2 L] 16 [w] Hane
3 ] 42 [¥]  |Mone
4 ] 7z [¥]  [Hone
Frint Problem? | Shorteuts [Print v|overzy v |Paths v [ saveaspetaut | pritsPreview J|  Close |

 Click Print and your printer’s print dialog will appear. Clicking OK (or Print) will start your print job.

FINISH
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You have completed your first drill.

We've tried to show you as many 3D features as possible in a short tutorial in order to create your first
drill. There’s still much more! Pyware 3D is the most used drill design software in the world. It is used

for a variety of design styles. We encourage you to review the manual to get the most out of your
design efforts.
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This chapter references each menu item of the 3D menu bar.

NEw DRILL
(FILE MENU)
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New Drill is
used to create
a new drill file
or continue
and exhisting
drill from
another file.
Selecting New
Drill from the
File menu will
display the
New Drill File
dialog.

9

Dorill Title:
Figldr=tage Grid Layout: |detault.grd W Browse

Mainum Counts: 300 2 | Ondy one musical pamber per deill Is recarmended.

Thiz drill file i=:

%) & newy drill. | iz not continued from a previous file,

« Drill Title is the title as it appears in in printouts and productions.

Cancel

=1

e Field/Stage Grid Layout is the type of grid that is used for the design and performance surface.
Clicking Browse will display the list of available fields. You can create your own grid layouts from
from the Grid Designer found in the Utilities menu. See Chapter 9 - Utilities for details.

* Maximum number of counts is the number of counts in the new drill file. Only enter one song per
drill. Try not to go over 400 counts. The higher you go the more work you make for 3D in calculating
transitions. On slower machines, you may notice an extra delay.

TIP - We recommend that you create separate files of major segments of the show or each musical
selection. This will make writing and teaching the drill much more manageable. 3D will allow you to
copy the last set of one drill in a file and paste it to a new file as the first set.
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OPEN DRILL
(FILE MENU)

50

Open is used to open a file locat- R IEHE]E
ed on a storage device such as .
your hard drive. Selecting open Crrill files in: | Drillz) | Browse...
from the File menu will display T T—— T
the Open a Drill File dialog. [ weDera 30 Get & Drill Online ]
Click this button to download drill files
from an online account.
Go To Backups Directory
File name:
File type: | Cancel

“Drill files in” shows the directory
on the storage device that is displaying in the file list. Browse will change the directory shown in the
list.

The drill file list contains drill files, drill packages and folders. Clicking on any of them and clicking
Open will open the selection in the list.

The Get a Drill Online button will open the Online File Manager where you can select a file to down-
load from a 3D online account. The Online File Manager is covered in detail in the Interactive menu.
See Chapter 11 - Interactive for detalils.

The Go To Drills Directory will show the list of drill files in the default drill files directory.

The Go To Backups Directory will show the list of drill files in the default backup drill files directory.
The location of the backup drill files directory can be changed from the Application Options
(Backups Tab) of the File menu.

The Go Up One Directory will move up one directory from any sub-folders found in the default drill
files directory.
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PRODUCTION
FILES Version 4 now has three types of 3D data files:
1) 3D Drill file (original data file in Pyware 3D)
2) 3D Drill Package file which is a combination of a 3D Drill file and its external files. External files
consist of the drill's audio file, images for props, and the floor cover image.
3) 3D Production files which are a collection of 3D Drill Packages that when combined make a
complete production (or show).
Using 3D Production files has many advantages over a 3D Drill file or a 3D Drill Package file.
1) An entire production with all of its drills can be downloaded into a viewer or a 3D Performer’s
Practice Tools program at one time.
1) Printing reports such as drill books and coordinates of a 3D Production file will combine all of the
drills in the production into a single printed list.
2) 3D Production files are used by the 3D Performance Simulator of the 3D Performer’s Practice
Tools.
NEw
PRODUCTION Since a production is essentially a collection of drills that when combined make a whole show, you

must have at least one saved drill available to put into your new production before you can create the
production. When a drill is added to a production it is moved from the “Drills” folder into the production
file. You will no longer find your drill in the “Drills” folder. You will, however, find your drill when you
open the production. That is very important to remember, so you don’t panic and think you have lost
your drill. A production will appear in the Open Drills dialog just like a drill (or a drill package). When
you open the production you will see the list of drills in the production in the Open Drill dialog. The
production is just like a sub-folder in the “Drills” folder.

e Select New
Production %I] : e =
from the File k ' : '
menu and the
following dialog

will display.
Click Next to
continue to the The 3D Production Builder is used to combine muttiple drills into a single file called a
next ste Production. Productions are comprised of drills created with 3D Java Interactive, music
p' (audio) files, as well as any other external files such as floor covers, and various production
options.

Productions have enhanced capabatilities over typical 3D Drill files. With a Production you
can print a drill hook consisting of an entire show. Coordinate sheets can be printed where
all drills in the production are printed in a single coordinate list. Productions can be
automatically downloaded by performers into :a 3D Java Simulator for in home drill practice
and simulator competitions. After creating a Production, it can be uploaded it to a 3D Online
Account.

Once online, your performers can download the productions directly into their 3D Java
Production Simulator or 3D Java Viewer for performing and printing.

Cancel Mext =
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¢ Enter the title

of the produc-
tion. The pro-
duction title will
be used as the
file name of the
production’s
main title. After
entering the
production title,
click Create
and then click
Next to contin-
ue to the next
step. If there is
a production
with the same
title in your
Drills folder
you will be
asked to
choose anoth-
er.

Enter the
description of
the production
that will appear
on cover sheets.
Click Next to
continue.

(30
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Enter the title of this production. The title will be shown when the production is used in 3D
applications. The title will also be used as the production’s file name.

3D Praduction Title; | Grand Champion Celebration Creste |

| Cancel = Presious

3

Enter a short 4 line description of this production. The description will appear in applications
such as a 3D Java Production Simulator when the production is selected.

3D Java Production Description

Celebration of Americas - America's Charmpion Band 2006
Performed by Pyaraphics High School Band
July dth, 2006

Cancel = Presiols | Mext =
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» The 3D Production file is a very powerful file. 3D Productions can be sent online (using a 3D Online
Account) for performers (students) who can in turn download directly into their 3D Performer’s
Practice Tools program where they can use the Production file to do the following:

1) Productions can be opened in the 3D Performance Simulator where performers can practice
their drills for scores.

2) Production drill books can be printed that include all of the drills in a production in a single book.

3) Production coordinates can be printed that include all of the drills in a production in a single list.

The following options are for productions opened by 3D Java Performer's
Practice Tools {powered by iPAS).
Enable Printing Functions
‘When Prirting Functions are enabled, coordinates, drill books and thurmbnail charts of 5 drill can be printed
&% long a5 the print functions are not disabled within the drill tzelf. The performers reports will print using
the default report options currently set in this 30 Java program.
Enable Leader Board Functions
‘When Leader Board Functions are enahled, performers can upload their scores to a drill's Leader Board
faor all patticipating performers in the drill to access.
Cancel = Previous I l Mext =

Setting Enable Print Functions will control whether or not a production can be printed from within
the Performer’s Practice Tools program. Occasionally, if a designer has uploaded a production for
preview only, they do not want the performers to be able to print. Drills can also be individually
locked from printing and editing. If a drill has been locked it will not be able to print even if the
Enable Print Functions is selected.

Setting Enable Leader Board Functions will control whether or not a production will have Leader
Boards. Some designers (or directors) may choose to disable the Leader Boards functions.



Choose which
drill files you '
want included in
your production.
The drill files
must have been
saved as Drill
Packages and
they must have
any audio files
included. To
move a drill, into
the production
click on the drill,
and then click the
move (right) but-
ton. To move a
drill out of a pro-
duction, click on
it in the produc-
tion list, and then

click move (left). |l _cancel |
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To add an existing drill to your production, click on a 30 Drill Package located in the left column, then click the
[= Move =] button and the 30 Drill Fackage will move from the Drills folder into the Production. The order that
wou vvant the drillz to perform inthe production can be changed by using the [Move Up] and [Mowve Doven]
huttons .

IMPORTANT TO KHOW: When a 3D Drill Package is moved into a Production it is removed from
the "Drills" folder. To find it, open the Production in which it is contained using the Open
Production function of the File Menu.

3D Packages in "Drills"” Folder This Production

 Part] 3dz
Fiddller Part2 Soz
Fiddler Part3 3oz

= Mowe »>>

= Previous

You can also rearrange the order the drills will appear in the production by clicking on a drill in the
production list and clicking move up or down.

Remember, when you move a drill into a production you will no longer find it loose in the drills folder.
You will find it by opening the production then opening a drill within the production. The production is
like a sub-folder in the “Drills” folder.

The summary will S
display showing
the production
setup. Click
Build Production
and you are done.
Now if you want
performers to
download the pro-
duction, you must
first upload it to
your 3D Account.
Use the Online
File Manager
from the
Interactive menu
to do that.

Cancel

Production Summary

Title: My First Production

File Hame: My First Production.prod
Print Enabled: true

Leader Board Enabled: true

Drill Files: Fiddler Part1.3dz Fiddler
Part2.3dz Fiddler Part3.3dz

Click Here to Build the Hew Production

= Previous
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OPEN
PRODUCTION Productions are collections of drills combined into one file to make a production. When you select
Open Production you will see the list of drills within the production to open.
* Select Open Production from the File g
menu |/ Ope:
« You will see in the Open dialog the list of | P filesin: |Erist i |
productions. Click on a production you |58y Firet Procuuction prod ——
want to open and click Open. [ weemo 3di Ctatie okl
Click th_is b\.!non to downloaf:l drill or
* The list of drills found in the production PRl R
will display. Click on the drill within the
production you want to open and click
Open i Go To Backups Directary
When a production is opened you can only
work with drills in that production. To work
with other drills not in the production you
will need to first close the production by
using Close Production from the File
menu.
Show: (<) All 30 Data File Types () Only 3D Productions
File name: _—
e
CLOSE
PRODUCTION When productions are opened, you can only work with drills that are in that production. When you are
ready to work with a drill that is not in the production you will need to close the currently opened pro-
duction first. To close a production, select Close Production from the File menu.
PRODUCTION
OPTIONS Production Options consist of the production description, Performer’s Practice Tools settings, and
the list of drills that are in the production. Production Options will be available only if you have a pro-
duction currently opened. (See Open Production or New Production). The Production Options
are the same as the options that you set when you create a New Production (See New Production
for details).
ADD/REMOVE
DRILLS IN
PRODUCTION When a production is opened you can change which files are in the production with this function. You

55
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can also create a new drill or create a continuation drill of an existing drill in the production. This is
handy when you have finished one drill and want to move on to the next.

vE FILE &
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SAVE As FILE
(FILE MENU)
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Selecting Save from the File menu will save your recent changes to the file. If a file has not been
saved before, a Save As dialog will display for you to name the file on the storage device (typically the
hard disk).

You can also choose Save As for a file that has already been saved. This will allow you to save
another copy of the drill file with a new name. This is a great way to keep copies of earlier versions of
a file should you choose to go back for some reason. To keep your file versions straight we recom-
mend you rename the file by adding a number to the end of the name such as: opener01, opener02
opener03...

This is the dialog that appears for Save As:

il Save a Drill File

Drill files ir: | Drils [ roves... |
Backups
[ weDema 3
Save Options:
-:_'_':Z- 30 Jawva Interactive Package
(%) 30 Jawa Drill File
Mead Help™
File narme:
Cancel
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“Drill files in” shows the directory on the storage device that is displaying in the file list. Browse will
change the directory shown in the list.

The drill file list contains drill files, drill packages and folders. Clicking on any of them and clicking
Save will save the file to the location in the list.

The Go To Drills Directory will show the list of drill files in the default drill files directory.

The Go Up One Directory will move up one directory from any sub-folders found in the default drill
files directory.

The Save Options contain options available for the type of file that is being saved.

3D Interactive Package is a package that contains not only the standard 3D Drill file but also con-
tains any audio and picture files used within the drill file. The files that can be included are option-
al as well. They are:

Include Audio File
Include Drill File
Include Props
Include Floor Cover

3D Drill File is a standard drill file that includes no picture files for props or floor covers. It also
does not include the audio file if an audio file was used within the drill.

Backup
(FILE MENU)
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This function is used to

backup the currently i Backup File

opened drill file. The

backup is saved in the This function rmakes a backup of the currently opened drill.

default backup files direc-

tory. Selecting Backup Backups are named using a sequential suffix. For example, 3 hackups of

from the File menu will | Sample.3dj would be Sample 1 3dj, Sample.2.5dj, Sample.3.3di. The backup with

display: | the suffix of 1 3d) iz the most recent. Up to 5 backups are kept. The oldest
hackups are deleted first. Backups are located in the Backups folder of the Drills
faldet.
Backup Options | Backup | l Cancel

Backup Options opens the Application Options dialog to the Backup tab where you can change the
default backup directory as well as other backup options. See Application Options for details.

With a computer, bad disks, damaged files, computer lock-ups and hard disk crashes are facts of life.
Although these occurrences are few and far between, they inevitably seem to happen to everyone at
least once. Take the precautions mentioned below and your drill designing days will be virtually trouble
free.

» To prevent losing large amounts of work, it is advisable to create a separate file for each drill seg-
ment (opener, production, closer). Smaller files will also speed up animation and at times, solve cer-
tain printing problems.

 Your time and effort is very valuable. We suggest saving every fifteen minutes when working on a
file. Nothing is more frustrating than losing drill because you did not save your work. It is easy and
takes very little time. Just select Save from the File menu.
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» Work from the drill files that you have stored on your hard drive, however, also put your drill files on
disk (or CD) and store them. Keep copies on both hard disk and floppy disk (or CD). Hard drive
crashes can completely wipe out your entire drill design library as well as other important files stored
on the computer. Floppy disks and CDs can get damaged too. Never keep your files in only one
location.

» Make quick hard drive backups by choosing Save As from the File menu and changing the name of
the file. One common method of making backups is by ending a file name with a number such as 01
and then incrementing the number for each backup. For example: Name your opener “Opener01”.
Then after an hour of work, choose Save As and change the name to “Opener02” and so on. The
name with the largest number is the most current and all others are older at one hour increments.
This makes it easy to go back to earlier versions. After you have collected several copies, start delet-
ing the oldest ones, and occasionally move copies to floppy or CD.

» Use the Backups section of the Application Options found in the File menu. Check “Always
backup after using Save”.

REVERT TO

SAVED

(FILE MENV) This function throws out all changes since the last time the file was saved and re-loads the previously
saved file.

PRINTING

(FiLe MeNu) There are four print functions found under the File menu. These function are covered in detail under

Chapter 8 - Printing. The functions are:
Print Charts
Print Coordinates
Print Cast Sheet

Print Cover Sheet

58
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DOCUMENT
OPTIONS
(FILE MENU)

PROPERTIES
TAB

59

This function is used to change the properties and preferences of a particular file. For example,
through this function you can change a file’s symbol font, file locking properties, copyright information,
and file title. To display the Document Options, select Document Options from the File menu.

The Properties tab contains settings that are the file characteristics which define the use of a file
you are creating. There is a section for typing your author information and copyright. You can
set the file up to be an un-editable file for use as a demo. The properties can be changed and then
locked with a Master password. This is useful if you would like to distribute your drill file but make it
operate only as a demo. Its value is most seen on the Internet. You can create a drill file, put a com-
pany name and contact number in the file that displays when the file is opened, restrict its use for
only previewing, and post it on your web site for sale or upload the file to your Pyware account.
Anyone can download your file for preview. Should they want to purchase your drill, you can unlock
their copy of the file for use by giving the customer a key that only works one time.

The professional designer can implement this feature to market his services.

38 2D Drill Document Options l:?ﬂ _

2! Preferences | External Files |

Author Information and Copeyright

Restrictions
|:| File can not be edited.

|:| File zannot be printad.

|:| Frintouts are obscured with "SAMPLE".

|:| Author Information and Copyright is displayed when the file is cpenead.
|:| Only the first 20 counts of the file can be accessed.

|:| Lock the properies with a b aster P asaword.

(8],1 l | Cancel | |




EXTERNAL
FiLEs TAB

PREFERENCES
TAB

60

The External

Files tab lists prop 30 3D Drill Document Options

image files and
audio files being
used by the drill.

Preferences tab
contains settings
that define the
characteristics of
the file you are
working in.

Chapter 3 - The Menu Bar

A
Properties | Preferences | External Files
Location of external files used with this drill file.
Audio File:
Floor Cover:
Prop Image=s:
L Ok | | Cancel ]
30 3D Drill Document Options X

Properties :

Drill Title: | Untitled

Symbol Font **; | SansSerif abcd ABCD | Choose Font |
Label Font **: SansSerif dbca 4BCD | Choose Font |
Default label position*: Contour W

Default interval for new shapes: 20 steps. **

Audio File: Choose File

Clear Synchronization to Crrill

Animation fixed tempo: 120  beats per minute. **

| Sawe ™" az Defaults |

d

| 0,4 | | Cancel
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« Drill Title is the title that is used when printing. If this title is left blank then printouts will use the
name the file was saved as.

« Symbol Font is the font used to represent the performers on the field.
e Label Font is the font used to label (or number) the performers on the field.

« Default label position is the location of a label that appears next to a performer symbol on new
formations.

e Default Interval is the interval first entered into a drawing tool control panel to determine the
spacing between performers in a shape. This is just the initial value and can be changed while
using a drawing tool. Its default is 2 steps. You may want to change it if you find you consistent-
ly use an interval other than 2.

* Audio File is the music file that contains music you wish played during animation of the drill.

TIP - Entering music before writing the drill provides an excellent musical reference during the
“creating process”.

TIP - Add a “count off” to the music implementing either your notation, sequencing, or audio edit-
ing software.

A drill file can be synchronized to one of three types of sound files: (MID=MIDI, WAV=audio
wave file, MP3=audio file. To set up an audio file for use with a drill file, do the following:

1) With a drill file opened, select the Preferences section of Document Options of the File
menu.

2) Click Choose File for the audio file and select an audio file.

3) The next time you click ON the animate with music button, you will be instructed to synchro-
nize the music to the drill.

* Animation Fixed Tempo is used to set the speed of the animation that is played with no music.

61
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APPLICATION
OPTIONS
(FILE MENU)

DispLAY TAB

62

This function is used to change the preferences of the 3D application. Preferences such as: Secondary

and New Symbol display size and color, count track settings, tool palette setup, installation encryption
information.

The Display Tab con- ! S—
tains options pertaining f_3|] Application Options _}3'
to the appearance of

h . Ii Display | Plug-ing | Backups | Systeminfo | Installation
items and windows. [

Count Track
Track count increment: | 8

Default size: 4 % piselz partick.

Secondary Count Position Style
Size: 4 Color: |.| Sample: *

Mevwe Position Style -
Size: 7 Color: |!| Sample: #
Showy Perspective YWiew windouw .
U=ze 30 Figurines (takes a lot of memory)
|:| Check for Pygraphics messages during startup.
[] Drawe Toolbar Yertically

Show bridges (paths) during previesy animation.

| Feset Prompts & Helpars || Reset Window Locations |

H | [0 | | Cancel J

Count Track in the
Display tab - changes the “count increments” of the count track. Typically showing a number every
8 counts is preferred.

Secondary Count Performer Style settings in the Display tab - changes the size and color of the
symbol used for secondary positions. At low screen resolutions the secondary dots will be larger
on the screen, so you may want to draw smaller symbols than the default settings. If you are new
to 3D, this setting can be changed at any time. Its usefulness will become easier to understand
after using the program.

New Performer Style settings in the Display tab - changes the size and color of new performers.
At low screen resolutions you may want to draw smaller symbols than the default settings. Just as
with the Secondary Count Performer Style, its usefulness will become easier to understand after
using the program.

Show Perspective Window in the Display tab - shows or hides the perspective window. This is
useful on slower computers or computers with low RAM. Unchecking Show Perspective View will
make 3D run faster and with less memory usage.

Use 3D Figurines (takes a lot of memory) - shows actual figures with uniforms defined through
the Figurine Editor instead of the standard pyramid

Check for Pygraphics messages in the Display tab - checks online for messages from
Pygraphics concerning critical and optional updates and items of possible interest to 3D users.

Draw Tool Bar Vertically in the Display tab - draws the Tools Palette vertically instead of horizon-
tally.

Show bridges (paths) during preview animation in the Display tab - toggles on or off the match-
ing bridges to help provide a cleaner animation while drawing new forms.
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Reset Prompts & Helpers - Some prompts will appear during the use of the program for the pur-
pose of providing extra guidance. These prompts could pop up in tools, functions, and options
throughout the program. The prompts will only appear once if the user clicks "Don't display this
again." Reset Prompts & Helpers will reset the "Don't display this again” check box on all of
these prompts.

Reset Window Locations in the Display tab - resets the location of windows and tool palettes to
their default location on the screen.

PLuUG-INS TAB The Plug-Ins tab lists all of the
plug-ins that are installed on
your installation of Pyware 3D.

[ —
=
=
=l
=
=
(=)
=
g
<)
2
=
LA
E

3D Plug-in Instant Purchasing
information -Selecting this but-
ton brings up a new window
with pricing and accessibility for
purchasing 3D Upgrades and
Accessories. A valid Credit Card
and internet access is required
to complete the purchase.

Flug-Ins Installed in this install ation of 30
Standard 30 Java Plug-In Tool Set

Reactivate Plug-Ins - Selecting
this button brings up a new win-
dow that allows you to reacti-
vate a 3D Plug-In you have pre-
viously purchased. It will be
necessary to reactivate your
plug-Ins should you need to | 30 Plug-In Instant Purchasing nfarimatian | | Reactivate Plug-Ihs |

reinstall your software.

[ 0,8 l | Cancel |

BACKUPS TAB The Backups tab contains | 31 Application Options Ed |
options for controlling the auto- | —
matic backup feature. The | Dizplay | Plug-ng ;B : 1| Bystem Info | Installstion

Backup Directory is the loca-
tion of your backup file folder.
Number of backups main-
tained per drill option changes
the maximum number of copies
created. Always backup after
using Save option turns on or —
off the automatic backup feature. || = Prill=Backups! Blramses
When on (checked) a new back-
up file is saved every time you
choose Save from the File Alweays backup after using "Save".
menu.

Backup Directory

Murnber of backups maintained per drill. 15 | W

(0].4 ] | Cancel
63 oA
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INSTALLATION

TaB The Installation tab contains the |
encryption information. If you 30 Application Options B3
have not entered your encryption =
information, the 3D program will Dizplay | Plug-Ine | Backups | System Info @
function as a demo. The encryp-
tion information is entered the first| [ Licensed Tu:

time the program is run.

Mame of persan or organization wha licensed this copy of 30 Jawva.
Serial Humber: 30JPRO-00013
Camputer ID; 170E

Edition: Pyweare 30 Java Interactive Profess... |  Instantly Uparade Mol

Installation; Wed Apr 04 1001617 COT 2007
Restrictions (if any):

Ok | | Cancel

SYSTEM INFO
TAB The System Info tab displays
System Information such as the

X

3'] Application Options !

versions of the Java(tm)
machine.

Operating Systemn: Windows XP
Wersion: 9.1

Architecture: x36

Java Vendar: Sun Microsystems Inc.
“ersion: 1.42 08

Uzer Mame: Dustin Merrell

(824 | | Cancel
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UnDo
(EpiT MENU)

This function will undo the last function of any of the undoable functions. Some are not undoable and
some are. Most edit/maneuvering tools are undoable. Drawing tools are undoable except in one case.
Drawing tools are not undoable when a drawing tool creates performers for the first time, such as
when entering at count 0 of a new file. In order to remove a drawing of new performers, you need to
select the shape with a selection tool such as a Pointer tool, then select Delete from the Edit menu.

DELETE
(EpiT MENU)

You can select the transition or performers to ) o
be deleted by highlighting them with one of your | 3[j petete Options E_\J
selection tools, and hitting your <delete> key. A ||

Delete OptiOﬂS will appeat, and you will have Thiz option resets the transition between courts 0

hoi i '3.?:5' Delete Transition and 44 of the selected positions to a "HOLD" (ar
two cholices: Mark Time).

() Delete Performers Thiz option permanently deletes the selected
- positions from the entrire drill.

Delete Transition resets the transition
between counts X and X (whichever page tabs
your red and yellow anchors are on at the || Delete Transtion | cancel |
time) of the selected positions to a "HOLD" (or — = =
Mark Time). After selecting the Delete Transition radio button and clicking the Delete Transition but-
ton, you will NOT be prompted to confirm.

Delete Performers permanently deletes the selected positions from the entire drill. Upon selecting the
Delete Performers radio button, then clicking the Delete Performers button, you will be prompted to
confirm the permanent deletion of the marked positions. For your safety, on this window, you cannot hit
<Enter> to confirm the deletion. You must click the Delete button.

Copy
(EpiT MENU)

This function will copy the selected performers into a clipboard for pasting elsewhere. In order for Copy
to be available, you must first select performers to copy. Use one of the selection tools such as the
Pointer tool to select the performers. Then select Copy from the Edit menu.

PASTE
(EpiT MENU)
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This function pastes performers that have
been stored in the clipboard with the Copy

P aste copied szlection to count 0.

fUnCtlon. If nOthIng IS stored_ n the Cllp_ {:J P aste with zame matching order. D Invert pasted shape verdically.
board the PaSte fUnCt|On WI” be dlm' 'f:il Faste with different matching order. I:‘ Invert pasted shape horizonally.
SeIeCt PaSte from the Edlt menu and the ':E:Z' Faste as new performers. I:‘ Invert pasted shape across mid stage.
following will display: eymboke[ X Color (&)

Paste with the same matching order - Pastes the performers into the current count of drill and main-
tains their same identity (matching order) as the performers they were copied from.

Paste with different matching order - This option will only be available if performers were selected
on the currently displayed count prior to choosing Paste. The selected performers will be the perform-
ers 3D will try to move (match) the pasted performers into. Matching Controls will display in the right
area of the Paste Control Panel. Matching Controls are used to match the positions of the pasted
shape to their respective performers in the drill. On the field display matching lines are drawn between
the positions of the pasted shape and the selected performers. Often the positions in the line are
matched correctly or simply need to be flipped over to be correct using the Flip button. If more match-
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ing control is necessary, clicking the Clear button will clear all of the matching lines for you to replace
manually. See the end of Chapter 6 Manual Matching for details on manual matching.

Paste as new performers - This option will enter the performers as new performers. This is typically
done at count O of the drill. New performers are rarely entered at any other count. The only time you
might want to enter new performers at a count other than count 0 is when you are starting a new drill
by creating your first time performers at set #2 and plan to chart backwards to set #1.

Mirror ing / Less Options - Clicking this button expands the Paste Control Panel to show Mirroring
Options, which allow you to Invert paste shape vertically, horizontally, and across mid stage. This
inverts the copied shape prior to pasting it on the current count of drill.

SELECT RECENT

(EpiT MENU) Choosing Select Recent from the Edit menu re-selects the last made selection of performers. If a new
shape is entered, then the performers of that shape will be selected. Double-clicking on the Pointer
tool does the same as Select Recent.

SELECT ALL

(Epit MENU) Choosing Select All from the Edit menu selects all performers displayed on the current count of drill.

Snap To

(Epit MENU) This function snaps the selected performers to the nearest whole, half or quarter step. Choosing Snap
To from the Edit menu will display the Shape To dialog
where you can choose the snap to resolution. @

il Snap To
Snap selected pedformers to the nearest:
(%) Whole Step
() Half Step
() Quarter Step
| cancel | [ apply || Okay ]I

AbjusT To

(Epit MENU) The Adjuster editing tool is used for quickly moving and/or adjusting performer’s locations and transi-
tions without having to first select the individual performers. See Chapter 7 Adjuster Tool for details.

TooLs MENu The Tools menu contains many of the same tools as in the Tools Palette. The tools in this menu are
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some of the most used tools. They are found in the Tools menu as another handy way to select tools,
especially through the menu tools shortcuts. Your preference of shortcuts used in the Tools menu can
be changed through the Shortcut Editor of the Utilities menu.
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DispLAY MENU

The Display menu contains functions which control the way the counts of drill appear on the field.
Many of which are also shown as buttons on the title bar of the Field Display Window and the Console.
These are some of the most used display related tools. They are found in the Display menu as anoth-
er handy way to change display characteristics, especially through the menu tools shortcuts. Your
preference of shortcuts used in the Display menu can be changed through the Shortcut Editor of the
Utilities menu.

Whole Step option causes the cursor to jump to whole step intervals when entering locations on the
field.

Similarly Half Step, Quarter Step, Eighth Step, Sixteenth Step behave like Whole Step. These options
are also found as buttons in the upper right corner of the Console.

Show/Hide Props switch controls the display of props on the field. This switch is also found on the
right side of the title bar of the Field Display Window.

Show/Hide Labels switch controls the display of labels on the field. This switch is also found on the
right side of the title bar of the Field Display Window.

Show/Hide Text switch controls the display of text on the field. This switch is also found on the right
side of the title bar of the Field Display Window.

Zoom Grid function zooms the display on the field in or out. This function is also found on the right
side of the title bar of the Field Display Window.

Shift Grid function slides the display on the field in any direction. This function is also found on the
right side of the title bar of the Field Display Window.

Center Grid function centers the field back to the middle of the Field Display Window. This function is
also executed by clicking on the Shift Grid function while holding the <Alt> key.

Measure function measures the distance between any two points on the field. After selecting measure,
clicking on two points shows the distance in the Console. This continues until the Measure function is
de-selected or the mouse is double-clicked.

Animate function is the same as clicking Animate from the Animation Controls of the Count Track.
Next Page Tab jumps the Red and Yellow Anchors of the Count Track one page tab to the right.
Previous Page Tab jumps the Red and Yellow Anchors of the Count Track one page tab to the left.
First Count jumps the Red and Yellow Anchors of the Count Track to the first count on the track.
Last Count jumps the Red and Yellow Anchors of the Count Track to the last count on the track.

Hide Selection hides the selected performers throughout the drill. This is useful when performers that
you are not currently editing are in the way of performers that you are editing.

Show All sets any performers that you have currently hidden to be visible again.

DRILL
REWRITER
(UTiLimes Menu
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The Drill Rewriter is found in the Utilities menu. The Drill Rewriter changes the number of perform-
ers in a drill by adjusting the spacing of the shapes within the drill. Performers can be removed or
added to a set and the adjustment is made throughout the drill. See Chapter 9 - Utilities for detalils.
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CounT EDITOR
(UTiLimes Menu

The Count Editor is found in the Utilities menu. The Count Editor adds or removes counts from a
drill. Counts can be inserted or removed at any place within the drill. This function is most useful to
extend the length of a drill when additional counts are needed at the end of the drill. See Chapter 9 -
Utilities for detalils.

CAST LisT
EDITOR
(UTiLimes Menu

The Cast List Editor is found in the Utilities menu. The Cast List Editor is an editor for creating a
customized cast list or importing the cast list from an exhisting drill file. See Chapter 9 - Utilities for
details.

GRID DESIGNER
(UTiLimes Menu

The Grid Designer is found in the Utilities menu. The Grid Designer is an editor for creating cus-
tomized field grids. You can use this editor to design any type of grid such as winter guard floors, soc-
cer fields and parades. See Chapter 9 - Utilities for details.

PAGE TAB
EDITOR
(UTiLimes Menu

The Page Tab Editor is found in the Utilities menu. The Page Tab Editor is useful for entering page
tab titles. Page tabs are considered sets when printing. If titles are entered, then the title is printed on
the chart. Use this when you want to title a set for clarification. For example, Set #1 could be titled
“Opening Formation” and Set #4 could be titled “Concert Formation”. The Page Tab Editor is also
another way to enter page tabs. Typically, page tabs are entered from the Page Tab Editor button on
the Count Track, however, they can be entered from this editor just as easy. See Chapter 11 - Utilities
for details.

Page tabs can also represent sub-sets. Often a page tab is useful to create a complex transition how-
ever you only want to print a chart at the beginning and end of the transition. You can create a sub-
tab. This will prevent the set numbers from incrementing thru the sub-tabs because the sub tabs are
label A,B,C. For example, with two sub-tabs between set 2 and 3 the numbering sequence would be
1, 2, 2A, 2B, 3, 4, etc. You also can choose to print the sub-tabs or not from the Print Charts function.

SHORTCUT
EbiTor
(UTiLimes Menu

The Shortcut Editor is found in the Utilities menu. The Shortcut Editor is used to change the shortcuts
assigned to menu items. You can setup shortcut profiles so each user can establish their own prefer-
ences for shortcuts. See Chapter 9 - Utilities for details.

FIGURINE
Epimor(UTILITIES
MENU)

68

The Figurine Editor is found in the Utilities menu. The Figurine Editor is used to change the uniform
colors and types for the perspective view icons. You can customize the look of the figurines to be the
same as your performers uniforms. See Chapter 9 - Utilities for Details.
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INTERACTIVE

MENU This menu contains all of the interactive functions that use the 3D Online Account service as well as
Pyware messages and web sites. See Chapter 11 - Interactive Utilities

ONLINE FILE

MANAGER This is a utility that uploads and manages files on the online account. See Chapter 12 - Interactive
Utilities.

UNLOCK THIS

DRILL This is a utility that will allow a user to unlock a locked drill using a key that has been given to them by
the creator of the drill. See Chapter 11 - Interactive Utilities

ONLINE USER

FILE ACCESS &

PASSWORDS This is a utility that allows the administrator to create additional users and modify passwords that
access the online account. See Chapter 11 - Interactive Utilities

DRiLL Lock

DECODER This is a utility that allows you to create keys to unlock files that have been locked by the creator so
that the master password does not have to be released. See Chapter 11 - Interactive Utilities

CHECK FOR

MESSAGES... The Pyware Message Board is an automated information system that checks with Pygraphics
Headquarters for any important notices such as updates that are currently available for you to down-
load.
3D will check Pygraphics Headquarters for any new updates or important notices that you me be inter-
ested in and display the list of messages in the Subject box. If you want to read a message, click on
the message listed in the Subject box and it will display.

PywArRe WEB

SITE Launches your default browser to the Pyware web site.

FREQUENTLY

ASKED

QUESTIONS Launches your default browser to the page of Frequently Asked Questions on the Pyware web site.

DEAUTHORIZE

THis COMPUTER
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This function allows the computer 3D is intalled on to be deauthorized so that another machine may be
authorized on the account.
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GET PLUG-INS

& ACCESSORIES | This function allows you to instantly purchase plug-ins and program updates and upgrades online.

INSTANTLY

UPGRADE My

3D Now This function will allow you to instantly purchase and update or upgrade available for you installed ver-
sion.

CONTACT

PYGRAPHICS This will launch the Pyware website in your default web browser.

Asourt 3D...

(REFERENCE

MENU) About Pyware 3D is found in the Reference menu. This shows the program version information and

the copyright information. Click on the Licensing Agreement button to view the Licensing Agreement.
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“FIRST TIME”
OR

“TRANSITION”? | Drawing tools can either create shapes consisting of 'first time” performers typically at count 0 of a drill

file, or they can create a shape that is the destination of a “transition” for existing performers.
“First Time*

When the Red and Yellow Anchors of the Count Track are on the same count of drill, the drawing
tools will be accessible on the Tool Palette, and if no performers are selected on the field, the
places in the new shape created by the drawing tool will be filled with first time performers. That
means that the performers of the shape do not yet exist anywhere in the drill. To create a shape of
first time performers the Red and Yellow Anchors must both be set to the same count, and NO per-
formers should be selected on the field at that count when choosing a drawing tool. Only in rare
cases are first time performers entered at any count other than count 0. One case is when it is more
convenient to design at the second set of a drill first, and then chart backwards to count 0.

“Transition”

Typically, on all counts of a drill other than count 0, drawing tools are used to create shapes that
define the end of a transition of existing performers. For example, let's take a line moving into a cir-
cle. The Circle tool will be used to create the destination of the transition from the line. The Red
Anchor will be set to the count of drill where the circle will be drawn. The Yellow Anchor is set to
the beginning of the transition into the circle which is usually the previous page tab. To indicate
which performers on the field are moving into the circle THEY MUST BE SELECTED. In this exam-
ple, you would select the line using a selection tool, and then choose the Circle drawing tool. After
the circle is created, Matching Lines will connect the new places in the circle with the existing per-
formers of the selected line. These Matching Lines indicate which performers in the line are mov-
ing into which new place in the circle.

LINE TooL For first time performers, set the Red and Yellow Anchor of the Count Track to the count of drill
where the line is to be entered. For transitions of existing performers into a line, move the Red Anchor
to the count of drill where the line should be drawn. Move the Yellow Anchor to the beginning of the
transition into the new line. This is usually the previous set in the drill. Select the existing performers
that will be moving into the line using a selection tool. See “First Time or Transition?” at the beginning
of this chapter for more explanation.

Clicking on the Line tool will display the N ESNE B B RV = el =R
Line Tool Control Panel. Jo |7 J{O oz slmT 2w Ta
Faozitionz | O & |:| Omit overlaps G
Intensal O & Restrict
Clone 0 times AR
Symbols | X Color [i]

The line is drawn by clicking two points on the field display. The first click will enter the first endpoint
and the second click will be the second endpoint.
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While entering the endpoints, the cursor location is dis-
played in the Console. The resolution of the cursor can
be controlled by the whole, half and quarter, eighth,
sixteenth step switches in the upper right corner of the
Console.

45 wids 0.00 stp | 75.00 stp

[1 %% ¥ b

0 of 0 positions selected

Editing count: 0
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Editing Handles
will appear at the
endpoints of the
line. These han-
dles appear as e : e
small red squares : : : :
and car be
dragged to reposi- —————+—+—+
tion the line by .
changing the loca-~ |

tion of the lines MMM EEN NS S AN NN N NS AN AN NENEEANEARESNANSRANEAE
endpoint. 5 5 5 - |Editing Handles | | |

A Reposition Handle also appears at the midpoint of the line. Reposition Handle
This handle is useful for dragging the entire shape to a differ- ~ ey,

ent location on the field. Drag the inner circle of the Inner/Ring
Reposition Handle to move the entire shape. The extended Drags Whole 4
arm from the center of the Reposition Handle is called the Shape "
Rotator and can be dragged to rotate the line to a new loca- 1

Cuter Ring
LY Wowves Point
- of Rotation

tion. The Point of Rotation is the center of the Reposition
Handle. To change the Point of Rotation, drag the outer cir- Q\)

cle of the Reposition Handle to a different place on the field.
Rotator Arm

In the Line Tool Control Panel, entering
the number of positions in the Positions

. .. . Fositions 0O Omit owerlaps
box will lock the positions and the line intercal| O E [ P Regﬂct
will maintain the number entered while Hom et

. L. Clone O  times
you move its editing handles.

Symbols | X Calor (W)

Similarly, entering the interval in the Interval box will lock the interval and the line will maintain the
interval while you move its editing handles.

Mixed Intervals are also entered in the Interval text box. This option will allow you to have different
intervals in one form. Sometimes you need to have positions at different intervals in the same shape.
The Mixed Intervals function allows you to easily create forms with multiple intervals. The Mixed
Interval function is built in to each of the drawing tools. The different intervals are entered in the
Interval text box. The Mixed Interval is entered with the interval value, followed by an ‘x’, followed by
the number of places at that interval. The Mixed Interval setting can be entered before or after you
create your shape, but have to be entered before | | | [ | [ | [
you Accept the form. For example alinewiththe | [ | | [ [ [ | | | | | | [ |
interval of 2 for 6 positions, followed by an interval
of 4 for 4 positions, ending with an interval of 2 for
6 positions will be entered the following way.

Example 2x6,4x4,2x6 Hepees o & {? bk dhdt ik SRR ERE
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This should be entered in the interval text
box as seen below. To enter the Mixed
Interval into a wider text box, hold the <alt>
key while clicking in the Interval box
(<option>-click for Macintosh).

Mixed Interval

:) Enter mixed inkerval information, (ex: 4wz, 4x3,4x2)
-

[ Ok l [ Cancel ]

Positions and Intervals can be locked or unlocked by clicking on the respective padlock. When
locked, the value cannot be recalculated by the computer if the size or shape of the form is modified.

Entering a number in the Clone box will clone the line across an axis for 1 clone, or across a point for
two or more clones. The Cloning Handle will be placed in the center of the field and can be moved or
rotated to reposition the cloned lines.

Omit Overlaps will watch for places where performers of a line are on top of other performers in the
drill. The overlapping places in the line will be omitted. Omit Overlaps can watch for either overlaps
involving only performers at the line’s endpoints or overlaps involving any performer anywhere in the
line.

Restrict Horizontal/Vertical forces the second endpoint to a location on the field that is in line hori-
zontally, vertically or 45 degrees diagonally with the first endpoint.

When entering the line as “first time” performers, Symbol and Color is used to enter the symbol and
colors for the new performers entered. Symbol and Color options are only shown for first time per-
formers. To enter a symbol sequence such as X O X O, type the sequence one time. For example XO
will enter symbols X O X O X O through out the line. Clicking on the Color Palette will display color
options for the first time performers. The performer’s symbol and color can be changed for existing
performers using the Labeling tool.

When entering the line as a “transition”, Matching Lines options are used to match the positions of
the line to their respective performers in the drill. Matching Lines options are only shown when a
shape is entered as the destination of a transition from a previous set. On the field display, matching
lines are drawn between the positions in the line and the selected performers of the drill. Often the
positions in the line are matched correctly, or simply need to be flipped over to be correct using the
Flip button. If more matching control is necessary, clicking the Clear button will clear all of the match-
ing lines for you to replace manually. See the next section of this chapter called Matching Lines for
details on matching.

At any time the Animation Controls can be used to preview the line in the drill. Other useful options
that can be accessed during entry of the line are located in the upper right corner of the Field Display
Window. These functions control the field display appearance such as moving or zooming the field,
showing/hiding the text boxes, and showing/hiding the performer labels. Also accessible is the meas-
uring tape.

The Accept button will commit the line into the drill page. Clicking on any tool without clicking Accept
will cancel the line. The line can also be cancelled by moving an anchor on the Count Track.
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MATCHING
LINES
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When drawing tools are used to create “transitions” of existing performers, you will need to identify (or

match) the new places made by the drawing tool with a selection of existing performers in the drill.
This process is automatically done by 3D and is shown by the matching lines extending from the new
places to the selected performers.

Often the match-
ing order predict-
ed by 3D is cor-
rect or may simply
need to be invert-
ed with the Flip
button.

Fositions 18l & [ ] omit overlaps [rata Pts.  Matching Lines
Clone 0 times
[] Pradict Mesxt
| |
ot o ot e R EHI R AR ORISR
RImRTRE:
$ | |
o
g |
Y
£ |
8
-
NNEEEN MENARE K ANEAE NN RN T AR 1NN ] AR R
e
g
i
Positions | 18] & [ ] omit owerlaps [rata Fts.  Matching Lines
Interval | 3.101 | f§ 50 Rewert

Clone | O

Accep

times

[] Predict Hext

I I
i ——

I_
I_

CRORCRCBIEGOae— | Tl

I
b

— —HRCROBR BORRR0G

I
|
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However, sometimes the matching order is not obvious enough for 3D to predict it correctly. 3D some-
times just needs a little help from you to get it started. Other times you may need to enter each of the
matching lines yourself. When 3D has not found the correct matching order, the first thing to do is to
try to give it some help.
* Click the Clear
button to clear ! ! ! ! ! ! ! ! ! !
.a” OT the match-  psitions 12 & [ ] omit owerlaps Data Pts.  Matching Lines
nglinesanda e 2101 & 50
red bubble will Clane 0 | timas
appear on top of St
the first new I
place. Thered 4| L _!_ L _!_ L _!_ L _!_ ] AR R Y
bubble indicates l $. & |
the new place 4 » i
that you will : -
match to an : »
existing per- : -
former. ] 1+ EI
g |
: Y
e e e
! .
A » ad |
4 .t
1 ® |
I I I
» With Predict
Next checked, | ! ! ! ! ! ! ! ! !
click on the = a ] omi Data Pie.  Matching Li
selected per- Fozitions | 15 Omit overlaps ata Fis. atehing Lines
former thg_t you Interal | :3.101 |5 a0
want moved into Clone| 0 |times
the new place Predict Next
marked with the _I_ I | | | | | | | |
R R e R R o R L e R AR a R A ) e Er 1 ma Ear | rAEE RS R IR REF | e RA 12
red bubble. A @ |
match line will .
connect the per- ) "
former with the : .
4
new place. : »
™
3 +
! C? :
| 4
— —_— — — — — — — = —— me— = R
! cdif
) - * |
1 .
1 ® |
[ [ [
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* The red bubble
will move to the | I I I I I I I I I
next new place.

Adai lick Fozitions 18 " |:| Omit owerlaps [ata Pt=.  Matching Lines
Again, oSk on "y 501 o
€ selecte Clone 0 times

performer that

you want moved [] Predict Next
into this new S R e TR A R RO ) asaeeraraaa e s e
place. * .

Depending on
the location of
the selected
performer, this
may be enough
matches for 3D
to correctly pre-
dictallorsome #1717 10 117
of the matches.
Sometimes it
may take one or
two more manu- |
al matches for

3D to attempt a

prediction depending on the matching order you are entering.

-
»

-
Z{ﬂ:ﬁ{'ﬂ}:ﬁ:ﬂ.{@:— | T

I
|
2

B

. ]
=, B8
|
|

I
o4

L L

» Sometimes 3D’s prediction starts off well but goes astray. When that happens you can use the Back
button to back up one match at a time. Once you get accustomed to 3D’s prediction logic, you may
find that combinations such as matching partly with Predict Next “on”, then partly with Predict Next
“off”, will accomplish matching with the fewest steps.

When the matching order follows no basic pattern that can be predicted by 3D, it is sometimes easier
to just do the matching manually from scratch.

» Turn off the Predict Next option.

* Click the Clear
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o C“Ck on the I Tool Contral Panel
selected per- Positions 18] & [ ] omit overlaps [ata Pts.  Matching Lines
former that iden-  Interval 2101 § &0 Rewert || Clear
tifies the new Clone 0O  times Flip Back
place marked E [] Predict Hext

bubble. A match +——F+—— —_ — = Lo
line will connect
the performer
with the new
place.

e The red bubble : —
will move to the
next place in the
new shape.
Matched posi-
tions turn green
to indicate they
have been
matched. Click
on the selected
performer that
identifies this
new place.
Repeat this step
for each new
place.

 If you make a | | |
mistake, click v
the Back button
to back up one
matched place.
Another way to
correct a mis-
take is to click
on the matching
line drawn over
the incorrect
performer and
drag the line to
the correct per-
former.
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» The <down arrow> key on the keyboard will advance the red bubble to the next new place.
Likewise, the <up arrow> key will advance the red bubble to the previous new place. After pressing
an arrow key, any matches done afterward will advance the red bubble in the same direction as the
last arrow keypress. Should the <up/down arrow> keys stop responding, click once in the
Positions text box.

At any time during the matching process the Animation Controls can be used to preview the transi-
tion in the drill. Other useful functions that can be accessed during matching are located in the upper
right corner of the field display window. They are functions for controlling the field display such as mov-
ing or zooming the field, showing/hiding the text boxes, show/hiding the performer labels. Also accessi-
ble is the measuring tape.

CIRCLE TooL
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For first time performers, set the Red and Yellow Anchor of the Count Track to the count of drill
where the circle is to be entered. For transitions of existing performers into a circle, move the Red
Anchor to the count of drill where the circle should be drawn. Move the Yellow Anchor to the begin-
ning of the transition into the new circle. This is usually the previous set in the drill. Select the existing
performers that will be moving into the line using a selection tool. See “First Time or Transition?” at
the beginning of this chapter for more explanation.

Clicking on the Circle tool will display the P 7 2% (22 byflel 7 L~
Circle Tool Control Panel. ¥ o A B 7T 2% [Tla
The circle is Pozitions 63 &[] omit overlaps [rata Pts.
drawn by click-  |riepal 2. & 100
ing two .pOintS Clone 0O times
on the fleld_ dis- Lock to circle |:| Offset spacing
plla)ll( ThehfII’Sf.t Id |:| 1=t place at top of circle.
\(I:V:ﬁ bgrlf:eecelﬁ- , S\,rmlbnls XI , I:-:-I-:-rI @
ter point of the A N NN N MM A ME NS T ARy LA Rird SA Rl ERwd RN AEwATE T iy e el A e
circIe..The sec- ...n Hun..
ond click will be = *e
the first per- - RS
former along the Py l.
edge of the cir- :' *
cle. The remain- 1
ing performers i 5| *
will be drawn = 4yt oot L 1 P {0 TNEREF - AREEE s AREEF L _I_ e
counter-clock- _E :1
wise from the | L P |
first performer. e » |
k. o
| el S A |

Many of the options in the Circle Tool Control Panel are exactly the same as options in the Line tool.
Refer to the Line tool at the beginning of this chapter for details on the Position, Interval, Clone,
Symbol, Color and Matching Line options, as well as Editing Handles and Reposition Handles.

Entering a number in the Data Points will change the number of points in the circle. This is useful to
create different shapes. For example 3 data points creates a triangle, 4 a rectangle, and 5 a pentagon.

The Offset Spacing option will offset the first performer of the circle by half the interval. For example,
this is useful when you want an equal number of performers on each side of a yard line. Place the cir-
cle edge handle on the yard line and the performers will be spaced equally on each side of the line.
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The Lock to Circle option will create a circle. Turning off this option i HHH i i
will create an oval. When creating an oval there will be two Editing A 1 r,,'..nu._ i)
Handles which are used to define the inner size and outer size of the i »
oval. Should you want to create the oval rotated, then use the | #' |
Rotation Arm of the Reposition Handle located at the center of the | iR
oval. : Fui
B ol
" A
A
hisee
'.'.‘ 1
.8
I i‘tiﬂ SRR EaHaEE! e
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The First Place at Top of Circle will make the matching order begin at the top of the circle. This is
sometimes useful to make matching of the circle easier.

PoinT TooL
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For first time performers, set the Red and Yellow Anchor of the Count Track to the count of drill
where the point (or points) are to be entered. For transitions of existing performers into the point or
points, move the Red Anchor to the count of drill where the points should be drawn. Move the Yellow
Anchor to the beginning of the transition into the new point(s). This is usually the previous set in the
drill. Select the existing performers that will be moving into the point(s) using a selection tool. See
“First Time or Transition?” at the beginning of this chapter for more explanation.

Clicking on the Point tool will display the NEEIEE HElG [ AvE 77 (Lo
Point Tool Control Panel. = =
e 2L A0 |[OHT ED (TS

Many of the options in the Point Tool
Control Panel are exactly the same as

options in the Line tool. Refer to the Line ~ Elene |0 [times  Matching Lines

tool at the beginning of this chapter for
details on the Clone, Symbol, Color and

Matching Lines options, as well as edit- [ ] Predict Nest

ing handles and Reposition Handles. )

The first click on the field will enter the first point.

The second click on the field is another point and so on....
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For first time performers, set the Red and Yellow Anchor of the Count Track to the count of drill
where the arc is to be entered. For transitions of existing performers into a arc, move the Red Anchor
to the count of drill where the arc should be drawn. Move the Yellow Anchor to the beginning of the
transition into the new arc. This is usually the previous set in the drill. Select the existing performers
that will be moving into the arc using a selection tool. See “First Time or Transition?” at the beginning

of this chapter for more explanation.
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Clicking on the Arc tool will display the N EFERE ENRE g |
Arc Tool Control Panel. S o AR STOs E

The arc is drawn by clicking three points on the field display. The first click on the field is the first end-
point of the arc. The second click on the field is the second endpoint of the arc. The third click on the

field is a point along the edge of the arc.

Positions 28| & [ ] omit overlaps [rata Pts.
Interval | 2. |5 50
Clone O fimes
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Entering a number in the Data Points will change the number of points in the arc. This is useful to cre-
ate different shapes. For example 3 data points creates a wedge.
Many of the options in the Arc Tool Control Panel are exactly the same as options in the Line tool.

Refer to the Line tool at the beginning of this chapter for details on the Position, Interval, Clone,
Symbol, Color and Matching Line options, as well as editing handles and Reposition Handles.
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For first time performers, set the Red and Yellow Anchor of the Count Track to the count of drill
where the curve is to be entered. For transitions of existing performers into a curve, move the Red
Anchor to the count of drill where the curve should be drawn. Move the Yellow Anchor to the begin-
ning of the transition into the new curve. This is usually the previous set in the drill. Select the exist-
ing performers that will be moving into the curve using a selection tool. See “First Time or Transition?”
at the beginning of this chapter for more explanation.

Clicking on the Curve tool will display the [} P I P =G S E 7O L
Curve Tool Control Panel. [ VAR /ég o ST 2 (Te
Fositions 0 & [ ] omit overlaps Handles Matching Lines
Interval 0O 5 [Del Half ][ Fewert ][ Clear ]
Clone 0 times [ Deltast || Fip || Back |
[] Predict Mext

The curve is drawn by clicking three or more points on the field display. The first click on the field is the
first endpoint point of the curve. The second click on the field continues the curve. The third click on
the field continues the curve and so on with the fourth and fifth. The less points you have on the curve
the smoother it will be. There will be an editing handle at every point entered. You can use these han-
dles to further modify the shape of the curve.

Fositions | ﬁDDmit overlaps Handles
Interval 2. &
Clone 0 fimes
Symbols | X Color @
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The Del Last button is used to remove the last entered point when creating the curve.

The Del Half button is used to reduce the number of points entered in half by deleting every other
point entered on the field. This is useful if you have too many points to form a smooth curve.

Many of the options in the Curve Tool Control Panel are exactly the same as options in the Line tool.
Refer to the Line tool at the beginning of this chapter for details on the Position, Interval, Clone,
Symbol, Color and Matching Lines options, as well as editing handles and Reposition Handles.
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For first time performers, set the Red and Yellow Anchor of the Count Track to the count of drill
where the Free Form shape is to be entered. For transitions of existing performers into a free form
shape, move the Red Anchor to the count of drill where the free form shape should be drawn. Move
the Yellow Anchor to the beginning of the transition into the new shape. This is usually the previous
set in the drill. Select the existing performers that will be moving into the free form shape using a
selection tool. See “First Time or Transition?” at the beginning of this chapter for more explanation.
Clicking on the Free Form tool will dis- NEEZ IR EE EEIEE e e

|| X

L|*
play the Free Form Control Panel. = 2E S ‘ ST 29 Ta

Pozitions 16 & [ ] omit overlaps Handles  Matching Lines

Intarval 0 |5 [Elel Last][ Rewvert ][ Clear ]
Clone 0 times [Det Half|[  Fip || Back |
Edit Handle spacing 1 | wds [] Predict Nesxt

Accep

The free form is drawn by clicking points on the field display. The first click on the field is the first end-
point of the free form. The second click on the field places an editing handle at the second point of
the free form shape. By continuing to click on the field you add more editing handles that extend the
shape. You can draw continuously by holding the mouse button while moving the mouse across the
field.
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This option allows you to adjust the frequency that new editing handles (red box) are added to a shape
while drawing. For example, if you input "2" in the Edit Handle Spacing box, while using the Free
Form (Pencil) Tool, an editing handle will appear every two yards on the shape you create.

The Del Last button is used to remove the last entered point when creating the free form.

The Del Half button is used to reduce the number of points entered in half by deleting every other
point entered on the field. This us useful if you have too many points to form a smooth shape.

The Smooth Shape button will smooth the form that has been created to a more fluid form.

Many of the options in the Free Form Tool Control Panel are exactly the same as options in the Line
tool. Refer to the Line tool at the beginning of this chapter for details on the Position, Interval, Clone,
Symbol, Color and Matching Lines options, as well as editing handles and Reposition Handles.
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The Block tool creates filled shapes. The shapes can have any number of sides. Typically, the Block
tool is used to fill rectangles and triangles.

For first time performers, set the Red and Yellow Anchor of the Count Track to the count of drill
where the Block shape is to be entered. For transitions of existing performers into a block, move the
Red Anchor to the count of drill where the block should be drawn. Move the Yellow Anchor to the
beginning of the transition into the new shape. This is usually the previous set in the drill. Select the
existing performers that will be moving into the free form shape using a selection tool. See “First Time
or Transition?” at the beginning of this chapter for more explanation.

Clicking on the Block will display the NEEIZNOGE 0, lE 7 3 [T~
Block Tool Control Panel. Ao 2R SO ST s Ta
Fozitions 0 & [ ] omitOverlaps Handles M atching Lines
Horz.Int, 2.0 f [ ] stagger | Del Last || Revert |[ Clear |
Vertlnt, 20 | £ Show Bridges
Clone 0 times |:| Fredict Hest

ACCEp

The block is drawn by clicking three or more points on the field display. The first click on the field is the
first point of the first side of a multi-sided block. The second click on the field finishes the first side and
starts the next side and so on. A block form can have as many sides as you would prefer.

Sk caasEees e icas et

Fositions 49 & [ ]| Omit Owerlaps Handles | | | |

HomzInt., 4 &[] stagger | | | |

Wert.Int. 4 a8 Show Bridges | | | |
u]

Clone times

Symbols | X Caolar @

—i———l———l———l———i—

Entering a value in Positions will lock the positions box to the value entered. If both of the Horizontal
and Vertical boxes are locked, one will be unlocked automatically in order to adjust the intervals to
maintain the value entered for positions. If the shape of the block is such that the positions value can
not be maintained with reasonable intervals a message will appear above the Accept button in the
Control Panel.

Entering a value in both Horizontal and Vertical intervals will unlock (if locked) the positions value.
The value in the positions box will be calculated to maintain the intervals entered.
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The Stagger option will stagger the spacing of each row in the
block.

Show Bridges shows the matching lines when a block is entered as a “transition”. Since blocks are
rows and columns of new places, the bridge lines can clutter the display.

Del Last will remove the last editing handle entered.

Many of the options in the Block Tool Control Panel are exactly the same as options in the Line tool.
Refer to the Line tool at the beginning of this chapter for details on the Position, Interval, Clone,
Symbol, Color and Matching Lines options, as well as editing handles and Reposition Handles.
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BezieErR CuRVE

TooL For first time performers, set the Red and Yellow Anchor of the Count Track to the count of drill
where the bezier curve shape is to be entered. For transitions of existing performers into a block, move
the Red Anchor to the count of drill where the curve should be drawn. Move the Yellow Anchor to
the beginning of the transition into the new shape. This is usually the previous set in the drill. Select
the existing performers that will be moving into the free form shape using a selection tool. See “First
Time or Transition?” at the beginning of this chapter for more explanation.

Clicking on the Bezier Curve tool will dis- | 3 £ & & | = : P 11 I = P e
]

play the Bezier Curve Control Panel +F e 2 & | /-T2 hlzeT E2E (TS

Fositions A6 & [ ] omit everlaps Handles hatching Lines

Interval | 0 ﬁ [Del Last ][ Rewvert ][ Clear ]
Clone O times
[ ] Predict Nest

The curve is drawn by clicking two or more points on the field display. ——
The first click on the field is the first endpoint point of the curve. The |
second click on the field develops the curve initially as a line. The |
ends of the line have editing handles. |

| "

Dragging the red square in the editing handle will move the end-

points. i = \

Dragging the red circle extending from the square handle will _—t
shape the curve.

L P
®\ N ;5/

Many of the Bezier Curve tool options are exactly the same as options in the Line tool. Refer to the
Line tool for details on the Position, Interval, Clone, Symbol, Color and Matching Lines options, as
well as editing handles and Reposition handle.
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The Polygon tool operates like the Circle tool to create outlined polygon shapes.

For first time performers, set the Red and Yellow Anchor of the Count Track to the count of drill
where the polygon shape is to be entered. For transitions of existing performers into a polygon, move
the Red Anchor to the count of drill where the polygon should be drawn. Move the Yellow Anchor to
the beginning of the transition into the new shape. This is usually the previous set in the drill. Select
the existing performers that will be moving into the free form shape using a selection tool. See “First
Time or Transition?” at the beginning of this chapter for more explanation.

Clicking on the Polygon tool will display NE IR EEE @/‘ ki 75 (L]~

the Polygon Tool Control Panel =l 2E S0 sSEiT 29 Ta
Pozitions 16 & [ ] omit overlaps Sides Matching Lines
Clane 0  times

[ ] oifzet spacing [ | 1=t place attop of polygan [ | Pradict Next

ACCED

The Polygon tool operates similar to the Circle tool. Use the Sides text box to enter the number of
sides in the polygon. Many of the options in the Polygon Tool Control Panel are exactly the same as
options in the Line tool. Refer to the Line tool at the beginning of this chapter for details on the
Position, Interval, Clone, Symbol, Color and Matching Lines options, as well as editing handles
and Reposition Handles.
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The Spiral tool creates spirals of any number of loops.

This tool is purchased separately as an optional Plug-in.

For first time performers, set the Red and Yellow Anchor of the Count Track to the count of drill
where the spiral shape is to be entered. For transitions of existing performers into a spiral, move the
Red Anchor to the count of drill where the spiral should be drawn. Move the Yellow Anchor to the
beginning of the transition into the new shape. This is usually the previous set in the drill. Select the
existing performers that will be moving into the free form shape using a selection tool. See “First Time
or Transition?” at the beginning of this chapter for more explanation.

Clicking on the Spiral tool will display the N EERVE R e L EE Syl 7o L~
Spiral Tool Control Panel. ¥ 2 & /7o ST 28 Tla
I I I I I I I
FPositions 69 ﬁDDmit overlaps Dﬂeuerse
Interval 2. G Loops | 2
Clone 0O fimes
Symbolz | X Calar @
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Loops sets the number of times the spiral will loop.

Reverse changes the direction of the spiral.

Many of the options in the Spiral Tool Control Panel are exactly the same as options in the Line tool.
Refer to the Line tool at the beginning of this chapter for details on the Position, Interval, Clone,
Symbol, Color and Matching Lines options, as well as editing handles and Reposition Handles.
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CHAPTER 5 - Selection, Adjustment & Regrouping Tools

Many tools used to design a drill work with existing shapes. For example, a Push tool is used to move
a formation across the field as well as create a transition from the previous location. In order to use
the Push tool, one must select the performers that will be pushed. That process is called “selection”
and is accomplished using Selection tools. Typically you would use the Pointer selection tool to click
on the shape that you want to push and the shape would become highlighted. Then, you would click
on the Push tool to perform the maneuver. This chapter covers using the Selection tools: Pointer
tool, Box Select tool, Lasso tool, Select By Profile tool.

Other tools in this chapter include the Pace tool, Spotlight tool, and Facing tool. With the Pace tool
you can change the pace of performers moving in a transition. For example, you can set the pace of
performers moving across the field to double time. You will also find a Spotlight tool which is used to
select a single performer, who will be highlighted with a spotlight throughout a drill. With the Facing
tool users are able to create a more realistic feel for your students by enabling you to show the direc-
tion that the performer is facing. With this tool it will now be easier to see a more realistic representa-
tion of the show in the perspective view while using the figurines.

Sometimes cutting a shape into smaller pieces or combining two or more shapes into one large shape
is useful. For example, imagine an arc splitting into thirds and each third floating into one of three
lines. To make the editing easier, we would first want to split the arc into three parts. That can be done
using the Knife tool. After cutting the arc, we can select one part of the arc independently of the oth-
ers. We would then select the first part of the arc and morph it into a line, and repeat the process for
the remaining parts. The process of splitting and combining performers is called “regrouping” and is
done using the Regrouping tools. This chapter covers using the Regrouping tools: Knife tool and
Glue tool.

Adjustment tools are used to make quick adjustments in the transition and placement of formations.
You will find in this chapter the following Adjustment tools: Snap To, Adjust To.
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POINTER
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The Pointer Selection tool is the basic tool for selecting shapes. This tool is used to quickly select all
of the performers of a shape. The Pointer Selection tool only selects whole shapes. In other words,
when you use the Pointer Selection tool you will get ALL of the performers in a shape. If you only
want to select a portion of the performers in a shape other selection and regrouping tools will be used.

To select the Pointer Selection tool, click @_—_; # [2n] [« s B i LA
@

on the Pointer tool on the Tool Palette or 22 /7020 a7 25 [Ta
click the right mouse button. :

Clicking on a shape on the field will select all of the performers of the shape. When only one shape is
selected, the Console will display the Average Interval of the selected shape in steps.

To add another shape to the selection, hold the <Shift> key down and click on another shape.
Similarly, to remove a shape from the selection, hold the <Shift> key down and click on a selected
shape.

Following are several valuable time saving shortcuts using the Pointer tool:

1) Double-clicking on the Pointer tool on the Tool Palette is the same as choosing Select Recent
from the Edit menu.

2) Right clicking on the mouse is the same as clicking on the Pointer tool in the tool palette.

3) With the Pointer Selection tool activated, dragging across performers on the field selects all of the
shapes that have performers found within the drag region.
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Click |Here
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Even if you only catch one performer within the
drag region, the entire shape that the performer | |

is a member of is selected. NN RN NN | |
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4) If the Pointer tool is not selected on the Tool Palette, dragging with the right mouse across per-
formers does the same as left click and drag.

5) Holding down the <Shift> key while dragging across performers will add the shapes of the per-
formers falling inside the drag region to the selection.

6) Clicking on the field but not on a performer clears the selection.

Box SELECTION
TooL The Box Selection tool is used to select a group of performers by dragging a selection box around the
performers. Unlike the Pointer Selection tool where whole shapes are selected, the Box Selection
tool is capable of selecting portions of a shape. When using the Box Selection tool all of performers
that are included in the boxed area (drag region) are selected.

To select the Box Selection tool, click on p@ B2 e E D S E T L~
ke

the Box Selection tool on the Tool 2 E -0 2989 T 28 T O
Palette. :

With the Box Selection tool selected, clicking and dragging a boxed region around the performers will
select the performers inside the drag region.
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Holding down the <Shift> key while dragging the the boxed region around unselected performers adds
the performers to the selection. Likewise, holding down the <Shift> key while dragging around select-
ed performers removes them from the selection.

Clicking on the field but not on a performer clears the selection.

LASSO
SELECTION
TooL
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The Lasso Selection tool is used to select a group of performers by drawing a line around the per-
formers. Unlike the Pointer Selection tool, the Lasso Selection tool is capable of selecting portions
of a shape. When using the Lasso Selection tool all of the performers found within the lasso region
are included in a selection.

To select the Lasso Selection tool, click [} g 2N e | S S E FE LA
on the Lasso Selection tool on the Tool 2 /2029 T 28 TE
Palette. :

Clicking and dragging a line around the performers
will select them.

TR [

Holding down the <Shift> key while dragging the line around unselected performers adds the perform-
ers to the selection. Likewise, holding down the <Shift> key while dragging a line around selected
performers removes them from the selection.

Clicking on the field but not on a performer clears the selection.
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The Spotlight Selection tool is used to select and highlight a position to help a performer watch their
movement while animating a drill.

To select the Spotlight tool, click on the i |2 |- WS s E FiE Lo
Spotlight tool on the Tool Palette and the @; 2 ol 2 o -+, =
Spotlight Tool Control panel will display. A& | AA012 © R

k an a perdormer, or type below ta search. ” Mo bridges
{¥) Bridge spotlight
™ Symbal andfar L Bridge 2l
Label (no spaces)
ﬂ.cceé

To spotlight a position, you can either type in the positions Name, Symbol, and/or Label.

There are options that allow you to see the bridges or paths that the positions will take to go to their
next location. The No bridges option will not display bridges or paths. Bridge spotlight will display
the spotlighted position’s bridge or path. Bridge All will show bridges or paths of all positions visible on

the design grid. Clear removes the spotlight from the display and resets the Spotlight Tool Control
Panel.



CHAPTER 5 - Selection, Adjustment & Regrouping Tools

PROFILE
SELECTION
TooL

93

The Select by Profile tool is for selecting performers by Color, Label, Symbol, or Name. This tool is
used to quickly select groups of performers with similar characteristics.

To select the Profile Selection tool, click [ i’:@ﬁ N7 A EES Syl g L
on the Profile Selection tool on the Tool il AL |A0L9 HhT 28 (TG
Palette and the Profile Selection

Control Panel will appear.

@ Label
.i::;. Symbol  Search for Labels starting with:
Ocolor |
bl

Click on a perfarmer, or type information to search.

To use the Profile Selection Control Panel:

* Click on the characteristic you want to use
when searching for performers you want to
select (or deselect). For example, if all of
the performers you want selected are
drawn in purple symbols, then you will click
on the Color characteristic to search by
color. Another example, if all of the Trumpets
are the symbol “T”, then click the Symbol
characteristic to search by symbol.

Inciucde
Fearch for Labels starting with: Exclude
Al
Clear

Click on a perfarmer, or type infoarmation to search.

 After selecting the characteristic, enter a

search value in the Search for... box. The | () Label | Include |
performers matching that characteristic value | () Symbdi | Search for Labels starting with: Exclude
will be highlighted with red boxes. As a ) Color | (1
shortcut, you can also just click on a per- ) Name } Clest |
former on the screen that has that search

value and it will be entered for you. For Accept Click on a perfarmer, artype information to search,

example, if searching for a characteristic of
Color, if you click on a red performer all of the red performers will be highlighted.

« If the highlighted performers (performers in red boxes) are performers that you want to include in the
selection, click Include. The selection will be modified. All performers in the selection will be
marked with a red dot.

* You can repeat the process of picking a characteristic, entering a characteristic value, then clicking

Include (or Exclude).

e The buttons Include, Exclude, All, Clear are used to modify the current selection with the highlight-

ed performers.

Include will include the highlighted performers in the current selection.
Exclude  will remove the highlighted performers from the current selection.
All will add all performers to the current selection.

Clear will remove all performers from the current selection.
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You can use combinations of these buttons to modify your selection.

For example, let's say you want to select all Trumpet players. Let's assume the Trumpet and
Trombone players are both labeled T1, T2, etc. Also, the Upper Brass are colored Red and the
Lower Brass are colored Blue. If we search by labels starting with T we will get the both Trumpets
and the Trombones. Likewise, if we search for Upper Brass we will get all the Upper Brass instru-
ments including the Trumpets. Here is the solution:

1 Search for Labels starting with “T” to highlight both Trumpets and Trombones.

2 Click Include to include both Trumpets and Trombones in the selection.

3 Search for performers with Color of “Blue” to highlight the Trombones as well as the other Lower
Brass instruments.

4 Click Exclude to remove the Lower Brass instruments from the current selection, therefore leav-
ing only the Trumpets selected.

GLUE TooL
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The Glue Regrouping tool is used for combining two or more shapes into single shapes. For example,
imagine three lines floating into a curve. To make the editing easier, we would first want to glue the
three lines into a single shape using the Glue tool. After gluing, we can select all three lines at one
time as a single shape. We would then simply morph the selection into a curve.

To select the Glue tool, click on the Glue cil 2] [l s E T

ki

L -~
tool and the Glue Tool Control Panel will =
+ hy
display. g @’ AA0Z29 2T £ (TS

'Z'_ :Z' Knife [ Regroup All ] [Apph,r Pat‘tern]

%) Glue AB bt

Accept each change and stick around.
Click an another tool when finished.

The Glue Tool Panel behaves differently from other tool panels. By default, there is no active Accept
button. Every glue with the glue tool is accepted without having to click the Accept button. This is usu-
ally preferred because the Glue tool is used quite frequently for single glues. Requiring the click of the
Accept button would simply add an unnecessary step. However, if you want to make the Glue Tool
Control Panel behave like typical 3D Control Panels, click off the “Accept each change and stick
around.....” option. When the option is off, the Accept button will be available and if not clicked when
you are finished gluing, then no changes will occur.

To perform a glue between two highlighted
shapes, click on the performers on each
end of the two shapes.
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The Glue tool can be switched to the Knife tool by clicking on the Knife option and vice-versa.

Regroup All button will break all of the performers in the highlighted shape(s) into individual points.
After the performers are broken up, you can reconnect the performers in a different order. Normally
this is not used when all of the shapes of a | | | | | | | | |
page are highlighted. To highlight a smaller | | | | | | | |
|

|

L]

group of performers, select the group prior |
to clicking on the Glue tool. The Regroup |
All option is commonly used to change the
grouping order of block shapes as shown. |

Apply Pattern is available when only one shape is highlighted. To highlight a single shape, use the
Pointer tool to select the shape prior to clicking on the Glue tool. To use Apply Pattern, select a pat-
tern from the pop up menu, and click Apply Pattern. The “AB” pattern will regroup a shape where
every other performer becomes a member of the first new shape and the remaining performers
become members of a second new shape. It is difficult to see any change on the field display. The first
new shape is almost directly over the second new shape.
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Divide Into allows you to divide the selected shape into Halves, Thirds, Quarters, Pairs, Groups of
4, 6 or 8. Select the appropriate grouping you wish to apply from the drop down menu, then select
Divide Into. If the "Accept each change and stick around" checkbox is not checked, the new group-
ing will not take effect until you select the Accept button.

The Find Next button will find the next person in the direction the form has begun to be glued and
then glue it to the end of the section. This function allows you to continue gluing a continuous line or
form without requiring every position to be clicked on individually.

The Undo Last button will undo the last glue that was performed.

Revert button reverts the grouping order to its initial order.

KNIFE TooL
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The Knife Regrouping tool is used for cutting a shape into smaller pieces. For example, imagine an
arc splitting into thirds and each third floating into one of three separate lines. To make the editing eas-
ier, we would first want to split the arc into three parts using the Knife tool. After cutting, we can select
one part of the arc independently of the others. We would then select the first part of the arc and
morph it into a line, then repeat the process for the remaining parts.

To select the Knife tool, click on the Knife NS G o E &

X ) e L ~
:j(?(S)FI)I:;r;d the Knife Tool Control Panel will = ¥t //0gz9 o7 £ Ta

I Knife | Regroup All | | Apply Pattern |
| Glue AB b

Accept each change and stick around.
Click on another tool when finished.

The Knife Tool Panel behaves differently from other tool panels. By default, there is no active Accept
button. Every cut with the knife is accepted without having to click the Accept button. This is usually
preferred because the Knife tool is used quite frequently for single cuts. Requiring the click of the
Accept button would simply add an unnecessary step. However, if you want to make the Knife Tool
Control Panel behave like typical 3D Control Panels, click off the “Accept each change and stick
around.....” option. When the option is off, the Accept button will be available and if not clicked when
you are finished cutting, then no changes will occur.
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To perform a cut on a highlighted shape, click _ | |
on the performers on each side of the cut loca- ~ | ~ | |
tion.

Regroup All button will break all of the performers in the highlighted shape(s) into individual points.
After the performers are broken up, the tool will switch to a Glue tool for re-connecting the performers
in a different order. Normally this is not used when all of the shapes of a page are highlighted. To high-
light a smaller group of performers, select the group prior to clicking on the Knife tool. The Regroup
All option is commonly used to change the grouping order of block shapes as shown.

s

Apply Pattern is available when only one shape is highlighted. To highlight a single shape, use the
Pointer tool to select the shape prior to clicking on the Knife tool. To use Apply Pattern, select a pattern
from the pop up menu, and click Apply Pattern. The AB pattern will regroup a shape where every
other performer becomes a member of the first new shape and the remaining performers become
members of a second new shape. It is difficult to see any change on the field display. The first new
shape is almost directly over the second new shape.

Divide Into allows you to divide the selected shape into Halves, Thirds, Quarters, Pairs, Groups of
4, 6 or 8. Select the appropriate grouping you wish to apply from the drop down menu, then select
Divide Into. If the "Accept each change and stick around" checkbox is checked, the new grouping
will not take effect until you select the Accept button.

The Undo Last button will undo the last knife that was done.

Revert button reverts the grouping order its initial order.
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Snap To

EbiminG TooL This function snaps the selected performers to the nearest of Snap To J

whole, half or quarter step. Choosing Snap To from the
Edit menu will display the Snap To dialog where you can i
choose the snap to resolution. (3) Whole Step
TIP - This is often used to firm up the positions of a block S
formation where all performers are at some whole step ! Dwaner Sy

interval from each other.

Snap selected pedformers to the nearest:

[ Cancel ][ Apply ][ Okeary ]I

AbJusT To

EbiminG TooL The Adjust To editing tool is used for quickly moving and/or adjusting
performers in shapes and transitions without having to first select the performers.

To use the Adjust To function:

* On the Count Track move the Red Anchor to the count of drill where the change of path adjust-
ment will stop. Move the Yellow Anchor to the beginning of the transition where the path adjustment
will start (usually the previous set).

* If you want to limit the adjustment function to a number of performers, select them first using one of
the selection tools. This is optional, however, if you don’t select a group of performers, and have a
large drill with a slower computer the function can be sluggish.

 Click on the Adjuster editing tool or select NEEE @ o] [
. . i B } E L l,---'P
Adjust To from the Edit menu and the
. =
Adjuster Control Panel will be displayed. o a LA102 O TTa
Stride Lo &
Distance D Show P aths (=zlow)

|:| Show Symbals

[ Deselect ][ Rewvart ]

« If any performers were selected when starting the Adjuster tool, P IRE RET AR RN EET SR ERTHET]
red editing handles will appear over each performer. If you want
to move them all, click and drag on one of the editing handles and
they all will move.

If you want to move only one individual, click Deselect if any per-
formers are selected to remove all of the editing handles, then click
and drag any single performer.

ing <Shift> click on each performer until a red editing handle
appears over each performer you want to move, then drag one of
them. The others will move similarly.

If you want to move a few performers at the same time, while hold- \
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* To edit individual steps of a performer’s existing path, click Edit e e AR A L ML A B ML, 38 ML
Steps. Editing handles will appear at each step of the selected LE]
performers. If you select more than one performer and edit a step i
of one performer, the same step for the others will similarly move. [
Since an editing handle appears at each step, it may be necessary LE]
to Zoom in to the area of the performer to drag the handles easily. i
|'q] 4 O A HHHH

Show Paths shows all of the paths of the selected performers or the performer you are adjusting.
This option is sluggish on some slower processors.

Show Symbols shows the symbols of the selected performers while you are adjusting.
Revert removes all changes made while adjusting and starts the Adjust tool over.

Stride and Distance boxes show the current stride and distance of the performer whose location you
are dragging.

Pace TooL
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The Pace tool is used during animation to show a performer moving in double time, half time, or regu-
lar time (one step per count). When a performer is marking time, the mark time pace is displayed by
flashing the performer twice per beat for double time, once every other count for half time, once per
beat for regular time, or no flashing at all for performers holding their position.

» Move the red editing anchor to the count of drill where the change of pace will stop. Move the yellow
editing anchor to the beginning of the transition where the change in pace will start (usually the pre-
vious set). Select the existing performers whose pace will be changing using a selection tool such as
the Pointer tool.

« Click on the Pace tool and the Pace Control Panel will be displayed. P22 Infermatian (Hald)
& step per beat.

» Enter the pace change information and click Accept. You can pre- o steps per beat (Double Time)
view the change by clicking on the Play (animation) button prior t0 . san per beat (Half Time)

clicking Accept.
HCCEEE
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FAcING TooL The Facing tool enables you to change the performer's facing (or orientation) on
the field. This is helpful to see a more realistic approach to what your drill would

look like in the s =
Perspective view. Rl 8 |2 555 o P L =% O il
Aol [21E T Aozl b7 = T

To change the facing of a performer, select the "Face" radio button and click on
the compass to determine which angle you would like the performer to face.

To change the facing of a group of

. Lo Ch Iy f it 1o 56
performers, select the "Face" radio ANAES SREy Tram sednt TR

button and click on the compass to O el st 6ff mneerment.

determine which angle you would like A Face B ) Click on compass to change
L) Face il

the group of performers to face. facing, or use amow keys.

Accep

The "Follow direction of movement" button automatically adjusts the selected
performers to face the direction they are traveling for the entirety of the move.

To toggle facing on or off while designing, select the "Show/Hide facing" button

above the console.
AR
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The tools in this chapter are called Editing/Maneuvering tools. These tools are used to reshape exist-
ing shapes displayed at the count indicated by the Red Anchor of the Count Track. However, the
power of these tools go much further than just editing a single count. These tools also create the tran-
sition to the count at the Red Anchor from the count at the Yellow Anchor. Typically the count at the
Yellow Anchor is the count of the previous set you have completed.

For example, imagine you are working on Set #2 of your drill. Set #1 of your drill is at count 0 and Set
#2 of your drill is at count 32. The Yellow Anchor is at count 0 and the Red Anchor is at count 32.
Editing/Maneuvering tools will make changes to shapes at count 32 as well as create the transition
between counts 0 to 32.

Editing/Maneuvering tools are always used on existing performers. Therefore, in order to make the
Editing/Maneuvering tools accessible, a group of performers must first be selected on the field.
Performers are selected with Selection tools such as the Pointer tool. See Chapter 5 - Selection &
Regrouping Tools for details.

PusH TooL

100

The Push tool is used to relocate a selected shape in a straight line path from one point of the field to
another without changing the form of the shape.

To establish the counts where the push transition is to begin and end in the drill, set the Red Anchor
on the Count Track to the count where the push transition is to end. This is typically the count of the
set you are currently working on. Set the Yellow Anchor to the count where the push transition is to
begin. This is typically the previous set. (See this chapter’s overview for more details)

After selecting the shape or shapes that

you want to push, clicking on the Push NEEIE IR EEEE @j} T RAr
tool will display the Push Tool Control tel 22 /- 02 BT 22 T
Panel.
Stride 0.0 to 5 |5.
Distance 0.0 } HRT;tl':fctrt
e I
|:| Show Symbaols Direction
Mirraring 38 x b 14
ATows mowve

Editing handles appear on each select-

ed performer. These handles can be o i
dragged and thus dragging all perform- =17 [ — R

sition. While dragging the editing han-

dles the location of the cursor is dis- \

played in the Console as well as the
Largest Stride and Largest Distance.
The resolution of the cursor can be con-
trolled by the whole, half and quarter
step switches in the upper right cornerof 1 1\ | |
the Console. The Push Tool Control
Panel also displays the Stride and
Distance.

|
|
i Ao
ers to the final location of the push tran- IERESRanas {%}* LA Etn B e
|
I
|
I
|
I
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A Reposition Handle will appear in the center of the PERRSLERRTROE

selected performers. Dragging the center of the /\H " ‘-..
Reposition Handle is the same as dragging one of the Inner Ring T b Arc\rmng
performer handles. Dragging the Rotator Arm that Drags Whole 4 '1‘ g Movce Raint
extends from the Reposition Handle will rotate the s Pl
shape. The point of rotation can be changed by drag-
ging the outer ring of the Reposition Handle to a pre-
ferred location. (\\)

Rotator Arm

Use the Arrow Keys to shift and rotate forms easily without having to change tools or use the mouse.
Moving forms with the Arrow Keys (without the <shift> or <ctrl> keys) is disabled in drawing tools,
because this feature is primarily used for matching performers when regrouping. You can, however,
use Arrow Keys to move the form when you have any editing tool open. Simply select the form you
wish to move, select your editing tool, then move the form with your Arrow Keys.

<Shift><Arrow keys> move the center of the Relocation Handle and the selected form one step. This
causes the new positions to shift similarly to the new location.

<Control><Arrow keys> rotate the Relocation Rotation Handle 5 degrees. This causes the new posi-
tions to rotate around the Relocation Handle.

Entering a number in the Stride text box will move the editing handles the correct distance to reflect
the new stride.

Entering a distance in yards (or meters) in the Distance text box will move the editing handles to the
distance entered.

Clicking on one of the red dots on the Direction compass will move the editing handles to reflect the
new direction.

Snap to Horz/Vert padlock will snap the handles to the nearest horizontal, vertical, or 45 degree direc-
tion.

*

be set to opposing horizontally, oppos- o
ing vertically, or opposing both vertically .| o
L

Mirroring options are available if two or | | - |
more shapes are selected. When mir- | | s | |
roring, the direction of the shapes can | #.‘ |

and horizontally. .
|

Show Symbols will display the position symbols instead of a plain dot.
Reset to Hold - resets the transition to a "Hold" from the secondary count.
Revert button resets the handles to their initial position.

At any time during the entry of the push, the Animation controls can be used to preview the push in
the drill. Other useful function that can be accessed during the entry of the push are located in the
upper right corner of the field display window. They are functions for controlling the field display such
as moving or zooming the field, showing/hiding the text boxes, showing/hiding the performer labels.
Also accessible is the measuring tape.

Clicking the Accept button will commit the push transition to the drill. Clicking on any tool without click-
ing Accept will cancel the push. The push can also be cancelled by moving an anchor on the Count
Track.
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RoTaTE TooL The Rotate tool is used to “gate” a selected shape around a point along curved paths.

To establish the counts where the rotate transition is to begin and end in the drill, set the Red Anchor
on the Count Track to the count where the rotation is to end. This is typically the count of the set you
are currently working on. Set the Yellow Anchor to the count where the rotation is to begin. This is
typically the previous set. (See this chapter’s overview for more details)

you want to rotate, clicking on the Rotate
tool will display the Rotate Tool Control J@ 2E 70729 ST E2S T@

Panel.

After selecting the shape or shapes that NEEIENREEEE : @ F3 [L]-

Rotation 0.0 |deg. ATowkeys
rotate § deg.

Mirraring 55 H¢

|:| Shaw Symbals

Editing handles appear on each selected per-
former. These handles can be dragged and
thus rotating all performers to the final location
of the rotation transition. While dragging the
editing handles the location of the cursor is
displayed in the Console as well as the
Largest Stride and Largest Distance. The
Rotation Control Panel also displays the
angle of rotation.

A Point of Rotation handle will appear in the
center of the selected performers. The point of
rotation can be changed by dragging this han-
dle to a preferred location.

Entering an angle in the Rotation text box will =
move the editing handles to reflect the angle
entered.

Mirroring Options are available if two or more shapes are selected. When mirroring, the rotation of
the shapes can be set to rotate on each shape’s individual point of rotation. The rotation can be in the
same or opposite directions.

Show Symbols will display the position symbols instead of a plain dot.
Reset to Hold - resets the transition to a "Hold" from the secondary count.
Revert button resets the handles to their initial position.

At any time during the entry of the rotation, the Animation controls can be used to preview the rotation
in the drill. Other useful functions that can be accessed during the entry of the rotation are located in
the upper right corner of the field display window. They are functions for controlling the field display
such as moving or zooming the field, showing/hiding the text boxes, showing/hiding the performer
labels. Also accessible is the measuring tape.

Accept button commits the rotation to the drill. Clicking on any tool without clicking Accept will cancel
the rotation. The rotation can also be cancelled by moving an anchor on the Count Track.
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MoRrPH TooL
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The Morph tool is used to change the form of a selected shape. The transition creates a straight line
path from the original shape to the morphed shape. This is the most widely used tool because it is so
versatile.

To establish the counts where the morphing transition is to begin and end in the drill, set the Red
Anchor on the Count Track to the count where the morph is to end. This is typically the count of the
set you are currently working on. Set the Yellow Anchor to the count where the morph is to begin.
This is typically the previous set. (See this chapter’s overview for more details)

After selecting the shape or shapes that NEEVRIDEEERE /.@ = =
=¥

L|
you want to morph, clicking on the Morph
tool will display the Morph Tool Control DAl gL 7029 0 £5 Ta

Panel.

Cunced Shape Handlez

|:| Lock Intenvals balaiGabiall
ATOWS Mawe

Show Bridges

|:| Show Symbals

Editing handles appear on each selected per- i i i

|
former. These handles can be dragged creating —————— L
a new shape at the final location. While drag-
ging the editing handles the location of the
cursor is displayed in the Console as well as
the Largest Stride and Largest Distance.
Bridge lines are drawn from the original shape
to the new morphed shape. These lines repre-
sent the paths taken by the performers. The
bridge line drawn in red is the performer taking
the largest stride and the Largest Stride is | |
shown on the Console along with the Largest | I
Distance.

Initially there is one editing handle per performer in the shape. This is often too many handles to work
with. Editing handles can be removed and added several ways.

Remove editing handles by clicking Fewer will remove half of the handles. Each time Fewer is
clicked the number of handles is cut in half.

Another way to remove editing handles is by
using the cursor to drag a box onto the field
around a group of handles you want removed.
For example, move the cursor just above and to
the left of the second handle in a shape and
drag down to the the location just below the third
handle will remove the two handles.
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An editing handle can also be removed by clicking directly on the handle while holding down the
<Shift> key. Likewise, to add editing handles to the shape, click directly between two handles while
holding down the <Shift> key.

Curved Shape option will create curved shape between the handles. When the option is off the shape
consists of straight lines between the handles.

Show Bridges displays the bridge lines between the morphing shape and the initial location. The
bridge lines represent the paths of the performers. Turning this option off is useful when there are so
many performers that the bridge lines begin to clutter the screen.

Show Symbols will display the position symbols instead of a plain dot.
Reset to Hold - resets the transition to a "Hold" from the secondary count.
Revert button resets the handles to their initial position.

At any time during the entry of the morph, the Animation controls can be used to preview the morph-
ing shape in the drill. Other useful functions that can be accessed during the entry of the morph are
located in the upper right corner of the field display window. They are functions for controlling the field
display such as moving or zooming the field, showing/hiding the text boxes, and showing/hiding the
performer labels. Also accessible is the measuring tape.

Accept button accepts the morph into the drill. Clicking on any tool without clicking Accept will cancel
the morph. The morph can also be cancelled by moving an anchor on the Count Track.
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FoLLow THE

LEADER TooL The Follow the Leader (FTL) tool is used to create a new shape resulting from the paths taken by all
positions of the selected shape. The path is determined by the leader of the shape.

To establish the counts where the FTL transition is to begin and end in the drill, set the Red Anchor on
the Count Track to the count where the FTL is to end. This is typically the count of the set you are
currently working on. Set the Yellow Anchor to the count where the FTL is to begin. This is typically
the previous set. (See this chapter’s overview for more details)

After selecting the shape or shapes that NEEE R EE EEE R L~
you want to FTL, clicking on the Follow S o . A olz2le st 2n Ta
the Leader tool will display the FTL Tool 74

Control Panel.

[]curved Shape Handles
Mirroring 3¢ = 3¢C Delate Half

Delete Last
Clizking on leader (red 2ee

daot) changes leader.

Aocet Rewert

A red dot with a green center appears on one end of
the shape who is designated as the the “leader” of
the Follow the Leader movement. If the other end of
the shape is the preferred “leader”, clicking on the
leader indicator (red dot) and it will change.

If an existing path can be established for the =
leader, editing handles will appear along the
path. These handles can be dragged creating

a new path to the final location. While drag-
ging the editing handles the location of the
cursor is displayed in the Console as well as
the Largest Stride and Largest Distance.

If no existing path has been established there +—-—+—~—f+—F— -+ —F — ——
will not be any editing handles visible.
Clicking anywhere on the field will create a =
path to that location. An editing handle will ,,.»"'.
be placed at that location, the path will be
drawn and the performers will fill in place
behind the leader’s new final location.

Each click on the field will extend the path of the leader to the location of each click. A new editing
handle will be added at each location.
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Clicking on an editing handle while holding down the <Shift> key will remove the handle from the
path. Similarly, clicking along the path between two handles while holding the <Shift> key will insert a
handle into the path.

The Delete Last button shortens the path by removing the last editing handle of the path. This is use-
ful when you inadvertently add an editing handle to the end of the path.

The Fewer button cuts the number of handles in the path in half. Each time Fewer is clicked the num-
ber of handles is reduced.

The Curved Shape option will create a curved path between the handles. When the option is off the
path consists of straight lines between the handles.

Show Symbols will display the position symbols instead of a plain dot.
Reset to Hold - resets the transition to a "Hold" from the secondary count.
Revert button resets the handles to their initial position.

Mirroring Options are available if two or more shapes are selected. When mirroring, the path of the
shapes can be set to opposing horizontally, opposing vertically, or opposing both vertically and hori-
zontally.

At any time during the entry of the FTL, the Animation controls can be used to preview the FTL in the
drill. Other useful functions that can be accessed during the entry of the FTL are located in the upper
right corner of the field display window. They are functions for controlling the field display such as mov-
ing or zooming the field, showing/hiding the text boxes, and showing/hiding the performer labels. Also
accessible is the measuring tape.

Accept button accepts the FTL into the drill. Clicking on any tool without clicking Accept will cancel
the FTL. The FTL can also be cancelled by moving an anchor on the Count Track.

REsize TooL
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The Resize tool is a multipurpose tool for changing the size of a selected group of performers. The
selection can be resized any of the following ways:

Scale - changes the size of the selection in equal amounts vertically and horizontally.
Stretch - changes the size of the selection in differing amounts vertically and horizontally
Slant - stretches the shape while also skewing the shape in horizontal or vertical directions.
Distort - changes the size of the selection in differing amounts in all four directions.

To establish the counts where the resizing transition is to begin and end in the drill, set the Red
Anchor on the Count Track to the count where the resizing is to end. This is typically the count of the
set you are currently working on. Set the Yellow Anchor to the count where the resizing is to begin.
This is typically the previous set. (See this chapter’s overview for more details)

After selecting the shape or shapes that e . an I =
you want to resize, clicking on the Resize 5 @ . ‘j = v i: P(; ;;f’} g g -47 i =
tool will display the Resize Control Panel. = 2 & =

|

L
T &

1)

(%) Scale Scaleto 1000 %
() Streteh Show Bridges

(") slant ] Showitebbing
() pistort | [_| Show Symbols

ATOWE Mowe

[ Accent ] [ Reweart ]
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The selected performers are bordered on all -ttt i =
sides by a Resizing Box. The Resizing Box |
has editing handles at all four corners that

can be moved. bt

Dragging the editing handles will manipulate the shape in a behavior based on the resize mode cho-
sen: Scale, Stretch, Slant, Distort. While dragging the editing handles the location of the cursor is
displayed in the Console as well as the Largest Stride and Largest Distance. Bridge lines are drawn
from the original shape to the new resized shape. These lines represent the paths taken by the per-
formers. The bridge line drawn in red is the performer taking the largest stride and the largest stride is
shown on the Console along with the largest distance.

Entering a value in the Scale To text box will uniformly scale the selection by the amount entered.
Show Symbols will display the position symbols instead of a plain dot.
Reset to Hold - resets the transition to a "Hold" from the secondary count.

Show Webhing displays graphically the resizing formula used on the selected group. This is rarely
used, however, can be useful with the Distort mode to understand how the handle movement is dis-
torting the group.

Revert button resets the handles to their initial position.

At any time during the entry of the resizing, the Animation controls can be used to preview the resized
shape in the drill. Other useful functions that can be accessed during the entry of the resize are locat-
ed in the upper right corner of the field display window. They are functions for controlling the field dis-
play such as moving or zooming the field, showing/hiding the text boxes, and showing/hiding the per-
former labels. Also accessible is the measuring tape.

Accept button accepts the resize into the drill. Clicking on any tool without clicking Accept will cancel
the resize. The resize can also be cancelled by moving an anchor on the Count Track.

107



CHAPTER 6 - Editing & Maneuvering Tools

TRACK TooL The Track tool moves a group of performers uniformly along a path. This is not like follow the leader.
The shape of the selection does not change. The entire shape follows the path at the same time as a
group. This is especially useful for pulling a single performer out of a group for solo’s and creating a
path for that performer to take.

To establish the counts where the track transition is to begin and end in the drill, set the Red Anchor
on the Count Track to the count where the track is to end. This is typically the count of the set you are
currently working on. Set the Yellow Anchor to the count where the track is to begin. This is typically
the previous set. (See this chapter’s overview for more details)

]

[E

After selecting the shape or shapes that B £ (2] %) 8 Pl
o B

HIE*: ' allLEr
you want to track, clicking on the Track Pl 2 2] Aol H vé
tool will display the Track Tool Control
Panel.

L~
T

T

el
£

Curved Fath Handles

|:| Show Symbols Ralaieebiall

—

[ Accept ] Rewert ]

A red dot will appear on the one of the per-
formers of the selection to highlight it. Clicking r iy
anywhere on the field will start a path from the
highlighted performer to that location. An edit-
ing handle will be placed at the location of " .
the click. -

SiEdERE CEEiEed
|
|
|
Yo
|
|
|
|
|

|
Continuing to click on the field will extend the |
path of the selected group to the location of |

each click. A new editing handle will be | g <
added at each location clicked. |
|

Clicking on an editing handle while holding down the <Shift> key will remove the handle from the
path. Likewise, clicking along the path between two handles while holding the <Shift> key will insert a
handle into the path.

The Delete Last button shortens the path by removing the last editing handle of the path. This is use-
ful when you inadvertently add an editing handle to the end of the path.

The Fewer button cuts the number of handles in the path in half. Each time Fewer is clicked the num-
ber of handles is reduced.

Show Symbols will display the position symbols instead of a plain dot.
Reset to Hold - resets the transition to a "Hold" from the secondary count.

108 Revert button resets the handles to their initial position.
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At any time during the use of the Track tool, the Animation controls can be used to preview the
tracked shape in the drill. Other useful functions that can be accessed during the entry of the track tool
are located in the upper right corner of the field display window. They are functions for controlling the
field display such as moving or zooming the field, and showing/hiding the text boxes, showing/hiding
the performer labels. Also accessible is the measuring tape.

Accept button accepts the track into the drill. Clicking on any tool without clicking Accept will cancel
the track. The track can also be cancelled by moving an anchor on the Count Track.



CHAPTER 7 - Performer Labeling and Special Markings

This chapter covers Special Tools in the Tool Palette. These tools are:

Performer Labeling for entering the identifying attributes of performers such as their symbol, color,
label (usually a number), and label position.

Text Boxes for placing text directly on a chart (usually for instructions).
Arrow Indicators for clarifying movement in a drill.

Props for placing items (such as stages) on the field.

PERFORMER
LABELING

110

The Performer Labeling tool is used to change a performer’s identifying attributes. A performer’s
attributes consist of the performer label (usually a number), label placement at a count, symbol and
color used at a count, and performer name.

Some performer attributes do not change throughout the drill. Unchanging attributes consist of a per-
former’s label and name.

Other performer attributes can change at any count within a drill. Changing attributes are a per-
former’s label placement, performer’s color and symbol. A performer’s color and symbol are usually
not changed within a drill. However, a possible use for changing the symbol is to indicate a flag
change. Another possible use for changing the color is to indicate a costume change.

The display of a performer’s label can be turned on and off by the Hide/Show Labeling Switch locat-
ed in the upper right corner of the Field Display window. When the Hide/Show Labeling Switch is
on (depressed), the labels on the count displayed will be shown. Until labels for a performer are
entered with the Performer Labeling tool the performer has no label. When the performer has no
label there is nothing to show and turning the Hide/Show Labeling Switch on or off appears to do
nothing. It is not necessary to turn the Hide/Show Labeling Switch on when using the Labeling tool.
Labels (if any) are always shown while the Labeling tool is active.

After selecting a group of performers T . = ™ =
whose labeling attributes you want to b E1L2 205 FIARG | Ak E 7 i =

change, clicking the Performer Labeling 2o A& | AA00219 55T £ =
tool on the Tool Palette will display the
Performer Labeling Control Panel.

Label E] to end

These changes apply to all counts.

Label () Contour & Label
F'.-:ns:ltlcnn {:;. Contour B Distance
.
L Dﬁlternate

-

EZ' These changes apply to count 17,

() These changes apply to range 1-17.

Symbal X Fepeat Symbal
Colar @ Fepeat Color

(%) These changes apply to all counts,

() These changes apply to range 0-17.

¥
L1

Show anly symboals.
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Label E] to end

These changes apply to all counts. —_—
Label () Cantour & Label

P ositi = Dist
.l:lS.I ian @ et & istance
.
L |:| Alternate

-

#) Theza changes apph to count 16.

z
K

7
L1

:Z' These changes apply to range 1-16.

Symbol | X Repeat Symbol
Colar @ Fepeat Color

EZ' These changes apply to all counts.

() These changes apply to range 0-16.

z
L1

Show anly symbols.

A red bubble will appear on top of one of the selected performers. Entering a value in the Label text
box changes the label of the performer marked with the red bubble. If the label value ends in a
numeric value, the [+] [-] Repeat button will be active. Clicking on the [+] button will change all of the
remaining selected performers with an increasing value starting with the number entered in the Label
text box. For example, T1 will generate T2, T3, T4... Likewise, clicking on the [-] button changes all of
the remaining selected performers with a decreasing value.

Entering text in the Name text box changes the name of the performer marked with the red bubble.

Clicking on a red dot in the Position compass will change the position of the labels relative to the loca-

tion of the symbol assigned each performer.

Contour A will move the labels on each performer to
a position perpendicular to the contour of the shape.

Contour B does the same as Contour A except the
positions are on the other side of the shape.

Alternate follows the contour of the shape but alter-
nates each label position to each side of the shape.
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The default performer label position can be set. Select Document Options from the File menu. In
the Preferences tab find the option “Default label position.” Choose one of the positions in the list.
All new transitions will initially set the label position to the default label position.

Clicking the [Further] Space button will increase the distance of the label from the shape. Likewise,
the [Closer] Space button decreases the distance.

Entering a character such as X in the Symbol will change the symbol of the performer marked with the
red bubble to the character entered. The Repeat Symbol button will repeat the symbol entered
throughout the selection. Typing a sequence such as ABC will change the symbols in sequence. The
performer marked with a red bubble will be an A. The next performer a B, then C. The sequence will
repeat through the remaining performers.

Entering a color in the Color button will change the color of the performer marked with the red bubble.
The Repeat Color button will repeat the color throughout the selection.

The symbol and color changes can be applied to all counts of the drill or the changes can be applied
only to the counts set between the Yellow and Red Anchors on the Count Track. The option is set
with, “These changes apply to all counts” and “These changes apply to counts xx thru xx.”

Previous and Next will move the red bubble to the previous and next performer of the selected per-
formers. The <up/down> arrows do the same.

Accept button accepts the labeling changes into the drill. Clicking on any tool without clicking Accept
will cancel the labeling changes. The changes can also be cancelled by moving an anchor on the
Count Track.

TexT TooL
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The Text Tool is used to enter boxes of text directly onto a count of drill. Usually a text box contains
drill instructions for the performers.

Clicking on the Text tool will display the Rl 25 = r=Ee s E FiE L~

Text Tool Control Panel. ¥ 2L /7028 T = E@
Fant Size Frame.j Templates

|:| Transparent sadf e

D Searif [ Use ]

Bccep

All existing text boxes (if any) will appear on the screen
with editing handles in the upper left and lower right cor-
ner of each box.
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Clicking on the field and not on any existing text box will create a NEW text box. The location of the
first click will become the upper left corner of the new text box. Move the mouse to a location for the
lower right corner of the new text box. In order to type text inside the box, click in the middle of the
box to place a cursor in the context area for typing.

Clicking and dragging on an editing handle located in the upper left corner of a text box will move the
text box. Similarly, clicking and dragging on an editing handle located in the lower right corner of a
text box will resize the text box.

Clicking in the middle of an existing text box will select the text box and place a cursor in the boxes
content area for typing. A text box is selected if the frame around the box is red. After a text box is
selected, changes made in the Text Box Control Panel will only affect the selected text box leaving
all other text boxes (if any) untouched. If no text box is selected, changes in the options of the Text
Box Control Panel will have no affect on any existing text box, however, any new text box created will
have to be created with the current control panel options.

Contents of a text box can be copied and pasted using <ctrl> ¢ to copy and <ctrl> v to paste. This is
useful to know when the contents of a text box is repeated throughout a drill. For example, often an
instruction box is placed on each set of a drill. Each instruction box has formatted information that is
repeated on each set such as Section #___ Transition . This text can be copied and pasted
into a text box at each set.

Font Size [Bigger] and [Smaller] buttons will increase or decrease the size of the font used within the
selected text box.

Framed option will draw a frame around the selected text box.

Transparent option will make the text box transparent. When transparent, the field grid along with any
performers will show through the text box.

Serif option will change the font to a Serif styled font as opposed to the default setting of a SanSerif
style.

Delete button will delete the selected text box. If no text box is selected, the Delete button will do
nothing.

Lists of pre-designed text boxes with text can be cre-

ated and used though the Templates combo box Font Size Franmad Templates
located in the Text Tool Control Panel. [ Transparent Sample Template 1 |+
Small

To use a template, select the template from the [ serif =armple Template 1
Templates combo box and click Use. Initially there  ————— Bt List...

. . . . A a OEETE
are no templates in the list, and only the Edit List.... m L
item will be found.
Adding a template to the list is accomplished 30 Text Template List Editor S
by first creating or selecting an existing text Sample Template 1

box with the desired text typed into it. Select
Edit List... from the Templates list to display
the Text Template List Editor.

Within the Text Template List Editor, clicking
Add will add the selected (or just created)
text box to the list. Likewise, clicking
Replace will replace the selected template in
the list with the selected text box on the chart.
Similarly, clicking Delete will delete the select- Adds the text box surtently selected on page X to the list
ed template from the list.

Replaces the curently selected text box on page X with the
selected item in the list.
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Accept button accepts the text changes into the drill. Clicking on any tool without clicking Accept will
cancel the text changes. The changes can also be cancelled by moving an anchor on the Count
Track.

ArrROW ToOOL
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The Arrow tool adds arrow indicators to a chart. Arrows are usually used to indicate direction of
movement within a transition. Arrows can also be used to identify distances between two points.
Typically distances between performers and key places on a field. There is also a center point arrow
which is useful for marking the center point for arcs and circles as well as indicating a distance for the
radius.

Selecting the Arrow Labeling tool in the

Tool Palette and the Arrow Labeling RIEHE (21N = | O R EIS Sy f] F R L@
Control Panel will display. Dk~ 2EA029 ST £5 |T
(%) Straight Armrow Arront Head 1
() Curved Amow ||| Arow Head 2
() center Point | [| Show Length
Any existing arrows will appear on the screen with editing
handles at each end. Curved arrows will have an additional ;
editing handle in the middle. L—M\xﬁ
Clicking on an arrow’s editing handle will select the arrow. A \“xaﬂ
selected arrow is drawn in red. Dragging an editing handle

will reposition the selected arrow.
A

Clicking on a location on the field that is not on an existing arrow’s editing handle will start the cre-
ation of a NEW arrow. The type of the new arrow is defined by the current settings in the Arrow
Labeling Control Panel. There are three types of arrows: Straight, Curved and Center Point.
Straight Arrow is an arrow formed by a straight line. Likewise, Curved Arrow is an arrow formed by
a curved line.

Center Point arrow is an arrow that represents the radius of a B |
circle or arc. For a Straight or Curved arrow, the location of the _'_ et A L e
. . . . e
first click will become one end of the new arrow. A second click 4 b
on the field will become the other end of the arrow. For a / B
Center Point arrow, the first click will be the center point and the 3
second click will be the circumference. After the arrow is
entered, the settings for the new arrow can be changed. | —43-_%9
g
| s
, ] i
~d ns -~
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Arrow Heads can be added to either end of the arrow using the Arrow Head options. The length of
the arrow can be placed on the arrow using the Show Length option.

Delete Arrow button will delete the currently selected arrow. The currently selected arrow is the arrow
drawn in red. To select a different handle, click on one of its editing handles.

Accept button accepts the arrows into the drill. Clicking on any tool without clicking Accept will cancel
the arrow changes. The changes can also be cancelled by moving an anchor on the Count Track.

Prop TooL

115

A prop is an image such as a stage, wall or pit area. Any jpg or gif image can be used as the prop. All
props are entered at count O of the drill. Props can be moved around the field by assigning a performer
to be the carrier of the prop. To control the movement of a prop, you can assign the prop to an existing
performer or create a new performer using the Point tool. To move the prop, use the editing functions
on the performer and the prop will follow the movement of the performer.

Before entering a prop, use to Count Track to move to count 0 of the drill and the Prop tool will be
enabled. Props are always added at count 0, and they exist throughout the drill.

Clicking on the Prop tool will display the Rl 25 [ r=# s »E 7iF L
Prop Tool Control Panel. =l 22 /7028 o7 25 16

[ Choose 3 Prop Image ]

|:| Frop is carmied by a parformer.
(Crag the upper left cormer of the prap
to the peformer chosen as its carier)

Height abowe floor | 0.0 | wd=s {or mirs)

Accen

Clicking on top of an existing prop will select the prop for
editing. A prop is selected when it is outlined in red. 0 MR TN ] SONERF |4 TNNERF | EWEE % 4 TNEEF.] Y

Clicking a location anywhere else on the field will start the =
creation of a NEW prop. The first click will be the location of
the upper-left corner of the prop. Then move the cursor to
the location for the lower-right corner of the prop and click.
A red box will indicate the location entered.

Editing handles will appear on a selected or new prop. =
Dragging the handle in the upper-left corner will move the
location of the prop. Dragging the handle in the lower-right
corner will change the size of the prop.

Clicking on Choose a Prop Image in the Prop Tool Control Panel will display a file dialog for finding
an existing (jpg or gif) image.

Clicking on Prop is carried by a performer in the Prop
Tool Control Panel will cause the prop to move with the
movement of a selected performer. To select the performer
to be the props carrier, drag the upper-left corner of the prop
directly on top of an existing performer. A red bulls eye will
appear on top of the performer to indicate the performer that
will carry the prop throughout the drill. The carrier can be
any performer in the drill, however, usually a new performer
is added to the drill whose only purpose is to carry a prop.
Use the Point tool to add a performer for this purpose. A e e A P e e
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Selecting the performer and editing its movement throughout the drill will cause the prop to move as
well.

The height of the prop can be entered by entering a number in the Height text box. The height is in
yards or meters. If you choose a height above about 2 yards, the performers will move under the prop.
If you choose a height of 0 yards the performers will move on top of the prop. You can create walls by
creating a narrow prop with a height such as 3 yards. Height is measured in meters if the 3D applica-
tion is setup to work in meters.

Should you transfer the drill file to another computer, you will need to also transfer the prop images
used in your drill. You can save a 3D Drill File as a 3D Package that will include all props used with
the drill into one file. When saving, the package option Include Props must be set. To change the
format of an existing drill file to a 3D Package, choose Save As from the File menu and set the Save
Options.

3D Package files are compatible only with 3D version 2 or greater. Should you need the file to open
on 3D Java version 1, it is best to put the external files in the same folder as the drill. You can deter-
mine which images are used in the drill by selecting External Files from Document Options of the
File menu.
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With 3D, any count of a drill can be printed. However, one usually only wants printouts at set points.
Charts can be printed by count number or by Set number. Sets are determined by the location of the
Page Tabs on the Count Track. Prior to printing you may want to add or remove certain Page Tabs
from the Count Track so the Sets will printout according to your preference.

Select Print Charts from the File menu and the following preview screen will display.

; = ||
| 3'] Print Charts x
Print Selection Preferences Overlay Set
:l. Currently Dizplayed Count Frint all perfformers black. |:| Thicker grid lines. \.}. Usze Previous
‘E-‘ Fram Page Tabs Print each peformers label. D Performer viewpoint (reverse wisn), Usa Mesxt
. Frint text. hak center of performer locations.
() Thumbnails( &  per page) ] ] 4 Starting Set# 1
|:| hagnifw symbols |:|Zoom chart for largest printout.
Set SubSet Count Frint Chwerlay Faths Title
1 I:‘ a None
z F 18 None
3 F 3z Nane
A 9z Mone (Subset)
36 i None (Subsety
4 F 63| None
LTS a4 Nane (Subset)
5 F 100/ Mone
] F 132 None
A 156 None (Subset)
7 F 164 Nane
] F 120/ Mone
B4 195 None (Subsety
9 F 204 None
a8 212 Nane (Subset)
10 F 220/ Mone
Prirt Prokblem? Shaortcuts |Print W Owerlay * | Paths W Save as Default H Pritit [ Presiesy ” Clase

Print Selection options are used to determine which counts of a drill are printed.
From Page Tab option will print the selected page tabs showing in the Drill book.

Currently Displayed Count option will print the current count displayed. The displayed count is
determined by the location of the red anchor.

Thumbnails per page will print small grids to fill the page. Ideal settings for dotbooks are 8 thumb-
nails per page in portrait orientation, or 4 thumbnails per page in landscape orientation.

Print Preferences

Print all performers black is useful when it is important to make clear black and white reproduc-
tions of the printout. You may choose to check this option for color printers because the color sym-
bols will not copy as clear when in color. You may also choose to check this option for black and
white printers because colored symbols will be printed as a shade of gray and also will not copy as
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clearly as if they were black. Typically if you plan to reproduce the printouts you will want all of the
symbols to be printed black.

Print each performers label determines whether a label is printed (usually a number) beside each
performers symbol. Normally, if labels were entered with the Performer Labeling tool, this option is
checked. However, sometimes when a chart is very cluttered, it is preferred to remove the labels to
make the chart more clear.

Print text option determines whether the text created with the Text tool will be printed on the chart.
The Print text option also determines whether arrow indicators created with the Arrow Labeling
tool will be printed.

Magnify Symbols option will enlarge the symbols and labels printed on the charts.

Thicker grid lines option will print the field grid with thicker lines. This is sometimes useful on laser
printers low on toner. Also, on some printers the grid lines are too thin to reproduce well.

Performer viewpoint (reverse view) will print the charts from the performers perspective.

Mark center of performer locations will place a dot in the center of the positions where the per-
former will be standing.

Zoom chart for largest printout will print zoomed in charts. The printout will be zoomed in as
much as possible while still keeping the performers in the picture. When selecting this preference,
some options will display for determining which charted items are visible in the printout when
zoomed.

Overlay Set has two options Use Previous and Use Next. When checked, if a chart selection
includes an overlay, Use Previous will print the previous set as a background chart. Likewise, Use
Next will print the next set as a background chart.

Starting Set # will change the starting set number. For example if the first drill ends with page tab 23
the continuation file can begin with page 24.

Shortcuts pull-down menus change the
settings in the drill book options in the
print charts dialog. The Print shortcut
menu will remove or add all of the

checks from the selection boxes in the — o [T e lover =
print column. Similarly, the Overlay rirt Frener: kg e

shortcut menu will remove or add all of Frint

the checks from the selection boxes in All

the Include Overlay column and the All But SubSets
Paths shortcut menu will select all, Hone

none, or mid-point options to print paths.

Sets and SubSets are derived from the Page Tabs of the Count Track. Typically a chart should be
printed at each page tab and therefore each page tab is a Set. Sometimes, however, it is useful to
create a page tab at a location where you don’t necessarily need a printed chart. Such as in a com-
plex transition where you only want to print a chart at the beginning and end of the transition but you
may need a few tabs placed within the transition to make it easier to create. These “mid-transition”
page tabs can be changed to a Sub-Set so the set numbering will be correct. For example, with two
sub-sets between set 2 and 3 the numbering sequence would be 1, 2, 2A, 2B, 3, 4, etc.

The Print column in the table enables/disables the printing of the set.
The Overlay column in the table enabled/disables the printing of a background chart for the set.

The Paths column in the table can be set to None for no paths printed, or All Paths for a dot per step
for every performer, or Path Midpoint for a single dot for each performer marking the midway point to
the next set.
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The Title column in the table can be used to enter a title for the set to be printed along the top of the
printed chart.

Close button will exit the Print Charts window.

Save as Default will save settings of the options from Print Preferences as default values. Print
Selection option will not be saved.

Print/Preview button opens print preview and page setup dialog.

| 30 print Preview Xl

H Srrint... | FF Page Setup page 1 of16 b M [ toom (3 [ | Close
I

Drill: From: Batman Begins "Batmobile Chase" Set#1 Count:0

0 5 10 15 20 25 30 35 40 45 50 45 40 35 30 25 20 15 10 5 0

T T T T T T T T T T T | 1 T|sET#1
B 78 TR Bl R AT TR AT SRR R SIE st i o
B3 .
- 7 H -+ -+ T H- - - - — H - H= - - H mm - -
L% Yo g
LN e
R o1
= HEeE R e e oo oS £ e e o s ae e me
H b3 {8 B WA i T i s f_ X5 | ks il s o LK i T I D R NS an}
;3' X | | | |
RS AR R RN S
SN N | |
%5 | gn |
1%
RS

" rage Licensed to: Dustin
Frow: Batinen Begin: "Batuobile Chase S
- by Milee Etory

. Craig Hars
tom Deill and Clinic Hervices-Call-800-034-3192

wrw creatives onsltation com

Print will send the job to the printer.

Previous Page will move to the previous preview page of the print job.
Next Page will move to the next preview page of the print job.

Page Setup button opens the printers page setup dialog.

Done button closes the print preview and returns to the print charts dialog.
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PRINTING
COORDINATES
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With 3D, coordinates for any count of a drill can be printed. However, one usually only wants coordi-
nates for the set points in the drill. 3D uses the Page Tabs on the Count Track to determine the sets
in the drill. Prior to printing you may want to add or remove certain Page Tabs from the Count Track
so the Sets will printout according to your preference. It is useful to use Sub-Sets on the Count Track
to indicate sets that are used for design purposes but not to print.

Selecting Print Coordinates from the File menu will display the Print Coordinates dialog.

| 30 Print Coordinates
Report Type Sort Performers

a Print Peformers Coordinate Sheet ":_:' Shape and Rank

Combine coordinates of all drillz in this ") Original Entry Order

production into ane list.
() Hame
List size: | quarter page (index cand size] | % -

() symbel and Label
{_J Frint Directors Coordinate Sheet 7

(%) Label and Symbol

List size: | half page B
Preferences Grid Terminology
Left Side  Left
Don't print sub-sets. Right Side  Right
Step Resolution; Teop Visitar
(%) Quarter Steps () Half Steps Bottern| Home
() Eighth Steps () whole Steps
Statting Set# 1|
Frint Ferformer 1D
Print date and time of printaut
| Prirt Probletm? | | Save as Default ” Pririt { Previews |[ Close

There are two coordinate Report Type options:

1) Print Performer Coordinate Sheet is a list of coordinates for a performer. The coordinate list
contains a coordinate for each Page Tab location (set) in the drill.

a)Combine coordinates of all drills in this production
into one list. This option is available when choosing . : A
) ) ) ) . Y Combine coordinates of all drills in this
Print Coordinates while a Production file (or a drill in production inte ane list,
a Production flle) IS CUrrently Opened' Lizt zsize: | quarter page (index card size) | %

f Print Peformer's Coordinate Sheet

b)List Size - This is the size of the printout. This is use- () Print Direstors Coordinate Sheet
ful for performers who want lists to be printed in a con-
venient size for fitting on index cards or small pocket

. List size: | half page ¥
size for a wallet.

2) Print Director Coordinate Sheet is a list of all performers. The list contains a coordinate for
each performer at a Page Tab (set). A Director Coordinate Sheet can be printed for each Page
Tab in the drill by selecting the Include coordinates for all sets option.
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Coordinates can be printed at four different resolutions: Whole Steps, Half Steps, Quarter Steps and
Eighth Steps.

Print only selected positions is useful for reprinting a single performer or a group of performers.
Select the performer(s) with a selection tool before selecting Print Coordinates from the File menu.
Then check the Print only selected positions option.

Sort performer list by: option sorts the coordinates by one of the following ways: Label and Symbol,
Symbol and Label, Name, Original entry order, or Shape and Rank.

Setting up the Grid Terminology to match the terms commonly used by your performing group will
make the coordinates easier to understand by the performers. For example, on a football field grid the
Left Side of the grid (the left endzone) may be referred to as the North Goal by your performers rather
than the default term Left.

Close button exits the Print Coordinates window.

Save as Default button saves the settings of the Grid Terminology and Preferences as default val-
ues.

Print/Preview will open the page setup display then render and display a preview of the coordinate
report according to the settings of the print coordinate report options.

J

3|] Print Preview )\l

‘ Ehprint... | I Page Setup Page 1 |orsz b M [Fh 100w B [ | close

Persormmne

Print will send the job to the printer.

Previous Page will move to the previous preview page of the print job.
Next Page will move to the next preview page of the print job.

Page Setup button opens the printers page setup dialog.

Done button closes the print preview and returns to the print coordinates dialog.
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PRINTING A
CAST SHEET Whether you have a large band or a small band the cast sheet is a very useful tool. The cast sheet will
display and print all symbols, labels, and names of the performers in the drill.
When you select Print Cast Sheet from the File menu the Cast Sheet Manager will display.
30 Cast List Editor x|
Mame Lahel Symbal Motes
(18- Xk 0
[18-C X *
(16-B X ¥k
[18-A X *
| 54 ¥ _)F
(5B ¥ _*_
52 ¥ _)F
5.0 ¥ _*_
| B ¥ _)F
BB ¥ _*_
|8-C ¥ _)F
(B0 ¥ _*_
12D X ¥k
12-C X *
12-B X ¥k
[12-A X *
(1D X ¥k
11-C X *
(1B X ¥k
(11-A X *
| 20-4, X _*_ =
| Sort:
by order enterad | Irpatt Mames & Labels |
() by Hame, Symbal, Label
by Label, Symbal, Name | Print f Previesw |
i) by Symbol, Label, Name | - |
Frint all symbals black.
Show unlabeled cast members, | Done |
124
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Print Sort order will sort the names in the cast sheet according to one of the following options: by
Symbol, Label, Name; by order entered; by Name, Symbol, Label; or by Label, Symbol, Name.

The name is entered using the Label Tool or can be entered directly from this dialog, the Cast Sheet
Manager.

The Notes column is just a space on the printout for taking notes on performers during rehearsals.
This feature was added in version 3. If this drill is opened with a version earlier than version 3, the
notes will not be found.

Print all symbols black will print all symbols in the cast sheet black instead of the color defined in the
label function.

Show unlabeled cast members shows all performers (even the performers with no label) on the Cast
Sheet Manager window and in the printout. Hiding unlabeled performers from a printout is useful if
you entered some performers as markers on the field and not actually performers.

Done button exits the Print Cast Manager window.
Save as Default button saves the settings of the Sort order.

Print/Preview will open the page setup display then render and display a preview of the Cast Sheet
report according to the settings of the print cast sheet manager.

3H print Preview |é] |
Ehprirt... [T Page Setup Page 1 off b M L‘g 100% L}“i\, [ Close

|Dril1 Roci That !/ feptermber Cast Sleet
Fame Lahel Symbol Motes

16-D X J+L

16-C

16-B

1=

5D

G4
. 6B
[ G-I
. G-D
. 120
. 12-C
. 12-B
. 12-A
1o
. 1"-C
. 1-B
(11
. 20-A
. 20-B
. 20-C
. 20-0
. 13D
. 13-C
13-B

13-4

P XX XXX XXX XX XXX XXX XXX (X|X X (XXX |X

e b Bl st e e e e b B e e e e e e B Bl e e e e e o e e ke e
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Print will send the job to the printer.

Previous Page will move to the previous preview page of the print job.
Next Page will move to the next preview page of the print job.

Page Setup button opens the printer’s page setup dialog.

Done button closes the print preview and returns to the cast sheet manager.

IMPORT CAST
LisT INFO Cast list names and labels can be imported from one drill to another. This is very handy when you add
cast list information such as cast member names or labels to a drill after you have finished it. This is
often done if you have purchased a custom or pre-written drill. Before Import you would have to make
the changes to all of the drills in a production (or show). Now you can make changes in the first drill of
a show and then import the changes to the other drills of the production (or show). Typically, you will
want to import into your drill the cast information of the previous drill of the show you are writing.
Usually the formation at the first count of the drill you are editing is the formation at last count of the
drill you are importing from. Import will find the counts with matching formations in both drills, lookup
the name (and/or label) of each performer and then set that name (and/or label) in the drill you are
editing.

» Select Print Cast List from the File menu or Cast List Editor from the Utilities menu and the Cast
List Editor will display.

 Click the Import Names & Labels button located in the lower left corner of the editor and the follow-
ing dialog will display:

a0

17 Import the cast sheet from drill file: Browse

2 Setup the Cast Member cross reference method:
'* Order Entered. The order performers were entered is the same for bath files.

Use thiz method when ane drill file was created using "Mew Drill" as a "continuation" of the
other drill file.

i_':'- Matcing Set. Look for a zet whoze formations are the zame in both drill files.

Use thiz method when drills were created independently of each ather but there is a matching
zatin both drill files.

31 Import wwhat information:
Import Cast Metmber Mame, WARMMNG, This OVERWRITES any existing hames.

|:| Import Cast Member Label. WARNING: Thizs OVERWRITES any existing labels.

Cancel |

 Click Browse and find the drill whose cast list information you want to import into this drill.
» Select the Cast Member cross reference method.

Method 1: Order Entered. Once you have finished a drill file, if you start another drill file using the
“this drill is a continuation of the drill...” then both drills will have performers entered in the
same order. However, should you add new performers later, then the order may no longer be the
same (at least for the newly added performers) and the second cross reference method may give
126 you better results.
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Method 2: Matching Set. This scans both drill files and looks for a set whose formations are
exactly the same in both. Then it copies the cast information from one to the other.

» Choose what information you want to import. The information can be cast list name and label. Itis
important to remember that the name and/or labels of performers that are found in both drills will be
overwritten in the drill you have opened.

 Click Import to begin the search and copy the cast information into your drill.

* When you click Done from the Cast List Editor, you will be asked if you want to save the changes.
If you do not want the changes saved, you can click No here and nothing will be saved of the import.

PRINTING A
COVER SHEET
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The Print Cover Sheet function will [ —
print a cover sheet for the drill book. | 3l Print Cover Sheet Iﬁj
When you choose Print Cover Sheet [
from the File menu the Print Cover I
Sheet dialog will display. |
|
|

Edit Drill Title

Impart 15t Page of Notes | Close |

Import Z2nd Page of Notes

|
Edit Author Info |
|
|

| Prinit £ Presview |

Edit Drill Title will open the Document Options to the Preferences tab so that the title may be
changed.

Edit Author Info will open the Document Options to the Properties tab so that the Author Info may
be changed.

Import 1st page of Notes and Import 2nd page of Notes will allow you to import a text file to have
as notes pages to follow the cover sheet for any additional instructions.

Close will close the Print Cover Manager dialog and return to the design grid.

Print/Preview will open the page setup display, render and display a preview of the Cover Sheet
report according to the settings of the Print Cover Sheet dialog. From the Print/Preview dialog you
can select Print.
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DRILL REWRITER
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The Drill Rewriter is an editor which can add or remove performers from an entire drill file. When a
performer is added or removed, it is often preferred that the intervals of the shapes involved change to
accommodate the added or removed performer. Similarly, when performers are removed it is some-
times preferred that a hole be left in the shape the performer once occupied. This is especially useful
if the shape is a block or filled shape. The Drill Rewrite editor can either adjust intervals or leave
holes. However, the Drill Rewriter goes further than that. The Drill Rewriter can also adjust the tran-
sitions of the shapes.

When the Drill Rewriter adds or removes a performer, it looks at each shape where the performer is
involved throughout the drill. If intervals for those shapes need to be adjusted to accommodate the
removed (or additional) performer, only the shapes where the performer resides will be changed. This
section will cover how to ensure only the necessary shapes are changed when intervals change.

For example, you may find that combining two or more shapes into one larger shape may make more
sense when the Drill Rewriter starts adjusting the shape intervals. For example, imagine at Set #3,
two arcs drawn end to end to make an S shape, and a performer we plan on removing is a part of one
of the arcs. If we choose to adjust the intervals to accommodate the removed performer, the arc
where the performer resides will be adjusted, but the other arc intervals will remain unchanged. We
might have preferred that the intervals would adjust across the entire S shape. To make this happen,
we would need to glue the two arcs into a single S shape before using the Drill Rewriter. Now when
the Drill Rewriter looks to see which shape is involved at Set #3, it will find an S shape instead of two
independent arcs.

Sometimes you may find that cutting a shape into a smaller segment may make more sense when the
Drill Rewriter starts adjusting the shapes intervals. For example, imagine we plan on removing a per-
former who is a part of on outlined box at set #2. If we choose to adjust the intervals of the box, do we
really want the intervals for all four sides to adjust, or do we actually want the intervals for only one of
the sides of the box to adjust? Often, we would prefer only one side to change and the other 3 sides
to stay the same. To make this happen, we would need to cut the box using the Knife tool into 4 lines
before using the Drill Rewriter. Now, when Drill Rewrite looks to see the shape involved at Set #2, it
will find a line instead of a box.

To check out the shapes and see if a shape needs to be com-
bined from another shape or cut out of a shape, do the follow- |_ Ll e el ke
ing: i |

 Click on the first page tab and select Select All from the Edit
menu.

» Evaluate how shapes are grouped. Especially the shapes
that you expect to be involved in interval adjustments during
a drill rewrite. The shape will be involved when one or more
performers within the shape are to be removed or added.
For example if a performer of this square is to be removed, | | T T T | |
then the intervals of the entire box will be adjusted because ! ! ! ! ! !
the performer resides in the box shape.

| | |
« If regrouping appears to be needed, select which shape | | | |
needs regrouping. Select either Knife tool or Glue tool, and ™ | T & e i 7T [ T
make the necessary adjustments to the grouping of the
involved shape(s). In this example, we want the performer to
reside in only one side of the box and not the whole box.

This is done by cutting the box into four lines.

» Repeat these steps at each page tab in the drill.
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Removing a Performer

This Remove Performer option will delete a position from the entire drill and resize shape intervals or
leave a hole within a shape.

» Select Drill Rewriter from the Utilities
menu and the Drill Rewriter Wizard
will appear. The Drill Rewriter will only
edit a drill file that has first been saved.

You may be asked to save before con- _
tinuing. 0 Equalize Intervals

O Leave 3 Hale

Remave Performers | [n=ert Perfarmers
Click on a perfaormer or peformers to remowve and select from the
options, then click Continue.

'EZ' Stop at each page tab to make a choice from the following:

() Equalize intervals throughout the drill.

() Leawve a hole throughout the drill.

Cancel

* Click on the performer (or performers)
that you want to remove from the drill.
The Drill Rewriter Wizard is displayed
in the upper right corner of the field dis-
play window. If it is covering your per- LaL Bk e el B LGSR R
formers, it can be moved by dragging
the control panel’s title bar.

-

The Stop at each page tab... option will display each count that has a page tab (or sub-page tab)
and highlight the performer to be removed. At each page tab, you will decide how this shape is to
handle the removal of the selected performer. For example, if the shape is a part of a filled block of
horizontal and vertical lines, it may be preferred to leave a hole in the shape rather than to adjust its
intervals.

The Equalize Intervals option adjusts the intervals of each shape that the removed performer(s)
occupies.

The Leave a hole throughout the drill option inputs a hole in each shape that the removed per-
former(s) occupies.

 Click Continue and the Rewrite Control Panel will display. The control panel is typically displayed
in the upper left corner of the field. However, if it is covering your view, you can move it by dragging
its title bar.

A red X will appear on top of each performer that is about to be removed. The Rewrite Control
Panel will display the counts that are about to be involved. Depending on the options set one or
more of the following buttons are available:

Equalize equalizes the intervals of the shapes involved during the count range shown in the con-
trol panel.
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Leave a Hole cuts out a hole in the shapes involved during the count range shown in the control
panel.

Undo Last Set backs up to the previous count range rewritten.

Cancel reverts to saved version of the drill.

Adding a Performer
This function will add a performer to an entire drill and resize shape intervals.

e Select Drill Rewrite command under
the Tools menu. A dialog box will
appear. The Drill Rewrite will only edit
a drill file that has first been saved. You

may be asked to save before continu-
ing. Click on two pedformers bebveen which

Remove Performers | Inzert Performers

) i a new performer will be inserted, then click Continue.
* Click the Insert Performers tab in the

Drill Rewriter dialog.

Cancel

* Click on the performer adjacent to the location where you want a performer added. The performer
you selected and the adjacent neighbor will be highlighted. Sometimes the adjacent performer is the
wrong one. Double check to see that the location where you want a performer added is between the
two selected performers. If not, try again by clicking on the other adjacent performer.

 Click Continue and the Rewrite Control Panel will display. The control panel is typically displayed
in the upper right corner of the field. However, if it is covering your view, you can move it by dragging
its title bar.

A blue dot will appear on top of each performer between which the new performer will be added.
Equalize will equalize the shapes within the drill.

Cancel will revert to the last saved version of the drill.
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CouNT EDITOR The Count Editor is an editor which is used .
to insert or remove counts from a drill. When [t TR 10T,
inserting counts into a drill, the transition in

the new counts will be mark time. The Apply

This function is used to add and remowve counts to the drill file.

button will apply the settings in the editor to (%) Insert Courts
the drill. The Page Tabs will be moved as Insert a total of | 1 counts.
well.

() Inzert counts after count | O

) Insert atthe end of the file,

) Remowve Counts

Remowe a total of | 1 counts.

Remowe counts after count | 0

Apply

When extending or shortening an existing transition by adding or removing counts to the drill, it is best
to add or remove the counts in the middle of the transition. For example, let's take a 16 count transi-
tion from count 0 to count 16. You will want to insert (or remove) counts after count 1 (or before count
15). This will preserve your beginning and ending forms. After you have made the changes with the
Count Editor, you will notice a jump in the animation. This is because the continuity of the drill has
been disrupted. It is similar to removing frames from a movie, it will cause a jump in the picture. This
is easily remedied. You will need to re-build the transitions.

To re-build the transitions:

» Place the Yellow Anchor at the beginning of the transition. In this example, it is count O.

» Place the Red Anchor at the end of the transition. In this example, it is count 16.

» Use a selection tool to select all performers except those performing any Follow the Leaders.

* Click the Morph editing tool and click Accept without making any changes. This will rebuild the
transitions of all forms with the exception of the Follow the Leaders.

« If there are any Follow the Leader transitions they will need to be corrected one shape at time by
selecting the shape, clicking Follow the Leader and clicking Accept.
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Casrt LisT
EDITOR
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Whether you have a large band or a small band the cast sheet is a very useful tool. The cast sheet will
display and print all symbols, labels, and names of the performers in the drill.

When you select Print Cast Sheet from the File menu the Cast Sheet Manager will display.

| 3l Cast List Editor X |
Mame Label = Sym.. | Figurine Motes
] 30 M _*.Baritone Figure b
26 M _|+1.Barit0ne Figure
33 M _|+;Barit0ne Figure
28 M _*;Baritone Figure
29 M _*;Baritone Figure
34 M _*.Baritone Figure
3 M _|+1.Barit0ne Figure
35 M _|+;Barit0ne Figure
71 I _»+_Bass Drurn Figure
7z o] _deBass Drurn Figure
73 Is] _r_:P._Bass Drum Figure
74 e _EF‘Bass Drum Figure
70 - _+Snare Drum Figure
it} - _+Snare Drum Figure
&9 - _+.5nare Drum Figure
&7 - _+.5nare Drum Figure
A6 o ..+._Quad Drum Figure
A5 . ,Jr._Quad Drum Figure
54 L _4_Flute Figure
53 L _|+_Flute Figure
&0 L _|+_Flute Figure e
Sart:
(! by order enterad I Import Mames & Labels |

by Name, Symbol, Label

) by Label, Symbol, Name | Print 4 Previews |

(%) by Symbol, Label, Name |

Save as Default |
[w] Frint all sumbols black.

Print Sort order will sort the names in the cast sheet according to one of the following options: by
Symbol, Label, Name; by order entered; by Name, Symbol, Label; or by Label, Symbol, Name.

The name is entered using the Label Tool or can be entered directly from this dialog, the Cast Sheet
Manager.

The Figurine column allows for the assignment of figurines to each performer in the cast list. These
figurines are shown in the Perspective View.

The Notes column is just a space on the printout for taking notes on performers during rehearsals.
This feature was added in version 3. If this drill is opened with a version earlier than version 3, the
notes will not be found.

Print all symbols black will print all symbols in the cast sheet black instead of the color defined in the
label function.

Show unlabeled cast members shows all performers (even the performers with no label) on the Cast
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Sheet Manager window and in the printout. Hiding unlabeled performers from a printout is useful if
you entered some performers as markers on the field and not actually performers.

Import Names & Labels allows you to import cast information from an exhisting drill.

Print/Preview will open the page setup display then render and display a preview of the Cast Sheet
report according to the settings of the print cast sheet manager.

Save as Default button saves the settings of the Sort order.

Done button exits the Print Cast Manager window.

GRID DESIGNER
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The Grid Designer is an editor which is used to create custom grid layouts. Any type of grid can be
designed such as soccer fields, winter guard, stages and streets. Custom grid layouts are stored in the
Layouts folder inside the 3D application folder. When a new drill file is created, a grid layout is chosen.
That layout is embedded into the drill file. Therefore, if a drill file is given to another 3D user, the user
does not have to have a copy of the layout in order for the drill file to be displayed correctly.

To load the Grid Designer, select Grid Designer from the Utilities menu. The current field grid will
display inside the editor.

| 3[' Grid Designer: untitled m
| =
Grid Divisions Grid Options Marker Options (vd line markers) [
Top-Baottom & stepsper 5 | yards b Stvle ines - Size | + || +
Left-Right & stepsper 5 yerds Resolution 1 step v Measure [inward B
” Measure vertically from stage front. Double clicking on & green major line handle turns onfoff marker. @\ |Q e -
—
25 75 125 175 225 275 325 375 425 475 475 425 375 325 275 225 175 125 75 25 <=
&
0 .1I].15_2[I 25.30_35.40 _25_25‘,‘155.40 35.30.25_2D.15.1l]_‘ 0 i
25 HHHHH | P ! | PR A R ! | | i ! | L
5 e
75 =
10 fae
125 e
15 fe
17.5 — ==
20 = ==
225 fe
25 : fez
e [-500 yds Dyds | ef
225 =
20 = =]
17.5 = (==
15 =
e P H I
10 fe
75 i =
5 ; =
o L | | | | | | 7678 i | | | | | | SR B i
o T
Pressts: | Load ” Save ” Save Az | | Color Cptions ” Floor Covet | O, ‘ Cancel

Units - a pop up menu for setting the measurement configuration to Yards or Meters.

Left-Right [ ] steps per [ ] yards - sets up the underlying horizontal step grid. Also establishes the
way the Location Indicator of the Console and Student Coordinates measure locations on the field.

Top-Bottom [ ] steps per [ ] yards - sets up the underlying vertical step grid. Typically, these values
are the same as the Left-Right settings.

Resolution - a pop up menu for setting up the number of step division markings between the yard
lines.

Style - a pop up menu for setting the step division style to either lines or dots.

Measure - a pop up menu for setting up the way the Location Indicator, Field Markers, and
Coordinates Reports use the yard line markers. Typically Winter Guard designers measure from the
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center yard line marker outward. Whereas field designer follows the yardline markers on football field
and measure inward.

Measure vertically from stage front - sets the vertical measurement of the Location Indicator to
measure incrementally from the front side line (0 steps) to the back side line (typically 84 steps). If this
option is not checked and the Measure setting is inward, the Location Indicator measurement from
each side line will start with O (steps) and incrementally increase until the cursor reaches the center of
the field (typically 42 steps).

Marker Size - [~ ] [ v ] buttons will increase or decrease the size of the yard line division numbers.

Zoom buttons - Clicking on the ( +) magnifying glass zooms into the center of the grid area.
Conversely, the ( - ) magnifying glass zooms out from the center of the grid area.

Field Relocation buttons - clicking on (slide up) button moves the grid area higher on the screen.
Conversely, the (slide down) moves the grid area lower on the screen.

Division Markers are the large numbers running from one end of the field grid to the other. The num-
bers are located at each major division line. They designate the number of yards across the grid.
Usually, these Division Markers are used as yard line markers on a football field, where the center
marker is the 50 yard line. The Division Markers are movable. For example, the markers displayed
horizontally can be dragged vertically to any location. Often, with football field grids, the markers are
placed in the exact location as they appear on the field, however, sometimes it is preferable to move
the markers just off of the field grid area so as not to clutter the display or the printout. Division
Markers can be hidden so that only certain yardline markers will be shown. To hide the Division
Marker double click on the large oval that corresponds the the yardline that you want the marker to be
removed. To have the yardline marker reappear double click on the large oval that corresponds the the
yardline that you want the marker to reappear.

Field Grid Border - is the red border surrounding the grid. On a football field the border represents the
side lines and the endzones. The middle of each of the four border lines is a number that represents
the location of the border. The four numbers can be drug to change the top, bottom, left, and right side
of the border.

Division Line, Sub-Division Line, Hash Mark editing handles located along the bottom and right
margins can be dragged to move the lines or hash marks up and down or across the grid area. The
editing handles associated with Division Lines are the longer ovals. Editing handles associated
with Sub-Division Lines are the smaller ovals. Editing handles associated with Hash Marks are rec-
tangular in shape. All the editing handles are yellow until they are moved when their color changes to
green. To add a line or hash, drag a new handle out of the handle bin into the grid area. To remove a
line or hash, drag its editing handle back into the bin area. The small numbers located along the left
and top margins of the editor indicate in yards the location of the line or hash. When creating a grid
representing a football field, it may be interesting to note that you can add as many hash marks as you
would like.

Color Options are used to change the color of the grid elements. Clicking on Color Options will dis-
play Grid Color choices. Within the Grid Color dialog, clicking directly on a color swatch will display
a color palette for changing the color.

Save and Save As buttons will save the field grid layout to the ‘Layout” folder. If you name your file
Default it will be the field grid layout that is use by default in the New (drill) file function of the File
menu.

Load button will load a grid field layout.

Clicking OK will copy the current field grid layout in the Grid Designer into the currently opened drill
file. Clicking Cancel will exit the Grid Designer without changing the grid layout currently embedded in
the opened drill file.



CHAPTER 9 - Utilities

PAGE TAB
EDITOR The Page Tab Editor is an editor for changing the Page Tabs that appear on the Count Track. The
Page Tabs can be entered and moved visually using the Page Tab Editor button on the Count Track.
The visual editor is covered in Chapter 1 in the section discussing the Count Track. Selecting Page
Tab Editor from the Utilities menu and the editor will display.

3'] Page Tab Editor
Ir .

| Starting Set # 1| _
| Set  Subset  Court Title I
1 O o !
2 O ps !
- | IR | !
S8, 48 (Subset) !
36 4 (Subset) !
4 L] s _ !
4.4, B4 (Subset) !
5 ] |1oo !
B | JIE _ !
B, 156 (Subset) !
7 [l |14 !
] [l |1so _ !
B, 196 (Subset) |
] [] |04 _ |
as, 1212 (Subset) !
10 [l |20 !
" Add Page Tab ] Cancel I
11 P
I:l Remaove Page Tah | | Save ||

= ]

Starting Set # will change the starting set number. For Example, if the first drill ends with page 23, the
continuation file can begin with page tab 24.

The Add Page Tab button adds a page tab at a count entered. The Delete Page Tab button removes
the page tab this is currently selected in the list of page tabs.

The Subset column is useful wen you are trying to create a complex transition however you only want
to print a chart at the beginning and end of the transition. In that case, you can establish a set as a
Subset. This will prevent the set numbers from incrementing thru the subsets (or sub-tabs) because
the sub-tabs are labeled A,B,C. For example, with two subsets between set 2 and 3 the numbering
sequence would be 1, 2, 2A, 2B, 3, 4, etc.

Click in the set Title column to enter a title for the page tab. When a title is entered, the title will be
used in printouts. Page Tab titles are useful to clarify reports. For example, imagine Page Tab #4 is a
concert formation. Titling Page Tab #4 Concert Set will print “Concert Set” on any printout where Page
Tab #4 is involved.
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SHORTCUT

EDITOR Many functions of the 3D menu bar can be accessed directly using keyboard shortcuts. To edit your
keyboard shortcuts: You can create more than one set of shortcuts. This is useful if more than one
person is using your installation of 3D. Each individual can setup the shortcuts according to their pref-
erences. Initially there are two sets: Default and a Version 2. The Default set is a set of shortcuts
created at Pygraphics containing preferred shortcuts from the Pyware Tech Staff as well as some of
our users. The Version 2 set contains shortcuts to match the previous version of 3D. The Default set
cannot be changed. If you want to modify the Default set, you must create a copy of the Default set
and modify the copy.

Ed|

3'] Enter a Shortcut

| Enter the keypress combinations to be used as a shorteut for the function: File:Add/Remowe Drill in Production
Madifier Keys
Shift [ cortral [ at [ commmand
Backspace | Tab | Erter | Clear | Pauze Caps Lock | Escape Space
Page Up | Page Dovwn | End | Home | Lett | Up | Right Coven
1 | Miruis |- ! o 11 |2 |3
4 |s |5 |7 8 |8 L o
& B |c D |E F s H
I | K L | 1 il o P
Q R |5 T u W |y X
o |z il I 11 MurmPad-0 | MumPad-1 MumPad-2
MurmPad-3 | MumPad-4 | MurPad-5 | MumPad-6 | MurmPad-7 | MumPad-5 | MurmPad-3 MurmPact *
MumPad + | MumPad | | MurnPad - | MurmPad . | MumPad f | F1 |F2 F3
F4 |F5 |F& |F7 |F& |Fa |F10 F11
F12 | Delete | Mum Lack | Scrall Lack | Ampersand | Asterisk | Double Guote Less
Print Screen | Ingert | Help ) | Greater | Riight Brace | Quiote | At | Colon
Circurmfles | Dollar Exclamation Mark | Left Parenthesis | Mumber Sign | Pluz | Right Parenthesis | Underscore
Conflicts
Shortcut for "File:Add/Remaove Drill in Production” = Shift+ K
| Save | | Cancel |

» To create your own shortcut set, select a set that most closely matches the set you want to create for
yourself. Typically, one chooses Default as the set to copy. Select the set by choosing a set name
from the Shortcut Set combo box appearing at the top of the Shortcut Editor. Click New Set to
make a copy of the currently selected set with a new name. Likewise Delete removes the currently
selected Shortcut Set.

 To edit a shortcut, click on the shortcut description appearing in the list of shortcuts and click the Edit
button. Shortcuts from the Default set can not be edited. Click the key commands you want to rep-
resent its new shortcut.

» To remove a shortcut, click on the shortcut description appearing in the list, and click the Clear but-
ton. The shortcut will be removed.

 To reset a shortcut to its default value, click on the shortcut description appearing in the list, and click
Default.

» To save the changes click Save.

The currently selected Shortcut Set will be the set used in the application when the Shortcut Editor
is exited after saving.
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FIGURINE
EDITOR

The Figurine Editor is an editor for changing the Figure Uniforms that appear in the Perspective
View Window. When you open the figurine editor you can choose to edit the standard set which is

used with any file that does not have a custom figurine set assigned to it.

3'] Figurine Edtior

4|

.

9

Figurines are used in perspective views. Figurines are performer images that have been colorized to your specifications using

the Figurine Editor. Figurines are grouped into types of sets: 1) Sta K Figurine Edtior

Standard Figurine Set The Standard Figurine Setis used by all d
isthe 30 application's default figurine set.
Editt Standard Sat This button edits the Standard Figurine Set us
(I
Custom Figurine Set Custom Figurine Sets are used with a spe

Figurine Set currently setup in the 3D appl
unigue for ane drill. A drill must be saved
a Custam Figurine Setto it.

Add Custom Set This button acds a Custom Figuring set to the
This bitton edits the colors of the Custom Figi

This button delstes the Custorm Figurine Set u:
Custom Figurine Set, export & copy of the sst

The Edit Standard Set button
brings up the figurine editor

window and allows you to H
change the default figure uni-
forms.

The Add Custom Set copies
the standard set and adds it to

the current drill package, then allows you to edit the uniform colors.

Figuine
o Cviom Fipm -

Uss Detint coions

= Coat (Front ony}

= Comt (Top Front only)
Cot [Ettom Front onky]

- Gt (ack orly)

HELPER EDITOR
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The Helper Editor allows you to turn on or off
specific helpers and allows you to view all
helpers at one time.

Show in Context - This button turns the select-
ed helper on to be seen when its tool or function
is activated.

Don’t Show in Context - This button turns the
selected helper off, and will not be shown when
its tool or function is activated.

Show all in Context - This button turns all
helpers on to be seen when its tool or function is
activated.

Don’t Show Any - This button turns off all
helpers, and will not show when its tool or func-
tion is activated.

3'] Helper Editor

||angle of Rotation

|| Data Points

'!Lm:kinu Humber of Positions
|Arrow Key Options

LArrow Key Options

| The Omit Overlap Option
|Symbol Options

Interval Options

| The Track Resolution Button

green

inthe File Menu.

ELm:kinu to VerticalHorizontal Diagonal

P

| Helpers that are sek ba pop g within the program are isted shove in b,

| This multi-function button zooms the Count Track when the bution appears in

Click the hutton zooms IN. <Shift=-click the buttan zooms OUT.
=Cantral=-click the button zooms to its default size

| The default size can be set in the Display section of Application Options listed

Contextual Behavior
Helpers appear in pop up
windowves when your click on
certain functions and options
within the: program.

Selected Helper
Don't Showe in Cortext ‘

| Show Alin Cortest |

Clicking "Show Allin Cortext®
will causs all helpers that have
been setto never show again
to re-appear while using the
program

Don't Show Any

Clicking "Don't Showe Any" will
prevent all helpers from
popping Up during the use of
the pragram

save || Cancel
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WRITING
DRILL
BACKWARDS

138

There will be times when you might wish to write backwards from a set later in the drill. For example,
imagine your second set of a drill is actually the opening formation, and the first set is a transition into
the opening formation. In this case, it is easier to create the opening formation at the later count first,

then chart backwards to the beginning of the drill.

» As with the above example, Set #2 is the opening formation. In this case we need to create perform-
ers for the first time in the drill at Set #2. These performers do not exist anywhere else in the drill file.
Place both editing anchors at Set #2. If you are charting backwards from a set of existing perform-
ers, skip this step. On the Count Track placing both anchors on top of each other is necessary for
creating “first time” performers. Holding <Alt> key (option on Mac) while clicking on a page tab will
force both Yellow and Red Anchors to move together to the tab. With the anchors setup, enter the
new formations into the drill.

el |
IIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII|IIIIIII
{r o 16 24 32 40 48 A/ B4 72 B0 B8 8/ 104 112 120 1.

\ |/ z
L

» Using the above example, Set #2 is the start of the set we have just finished, and now we want to
move “backwards” to Set #1 to design the ending count and transition between the two sets.
Normally we would be thinking about the transition from the previous set (Set #1) to the current set
(Set #2). To setup the anchors for the “backwards” design, set the editing anchors on the Count
Track between Set #2 and the Set #1. Click on the small red right arrow on the Count Track
appearing between the Yellow and Red Anchors. The Red and Yellow Anchor will swap locations.
Editing of shapes and all transitions will now be written backwards.

Forward drill writing as indicated by the small red right arrow in the Count Track.

B 2

98 24 32 40 48 56 B4 ¥R B0 88 96 104 112 120 1

Backward drill writing as indicated by the small LEFT arrow in the Count Track and the red warning
bar in the Count Track’s page tab area.

16 a 16 24 3% 40 483 66 B4 T2 80 83 96 104 112 120 1
B

NOTE: Do not forget to return the small red arrow back to its normal direction when wishing to con-
tinue writing forward.
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A 3D drill file can be synchronized to one of three types of sound files:

MID = MIDI file
WAV = audio wave file

MP3 = audio file

To setup an audio file for use with a drill file do the following:

» With a drill file opened, select the Preferences section of Document Options of the File menu.

* Click Choose File for the
audio file and select an
audio file.

« To indicate sound with animation, click on the Sound button under [P

Open Audio File:

Laak, jn: :@ Dezktop

My Documents

% My Computer
W My Mebwork Places
[_JFaxes

_4Java 3.0.5
(_iScans

£

| £% B2~

__JFalders

File name: |

Files of tupe: | &l Filess 7]

- | Cancel |

the animation controls of the Count Track.

=9 =

s>

« After clicking on the Sound button, if there is no audio file selected, the following message will dis-

play.

Wi

IUnable ko find an audio File For this drill,
Click <¥es= to display Document Qptions For choosing an audio file?

=) [

<1
A
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« If the selected audio file has not been synchronized to the drill file the following message will display.
Audio Synchronization |z_\a.

\'F:) The drill needs ko be synchronized ta the audia file,
L]
To start, click <Yes> and synchronize the drill using the <spacebar=.

e [0 ]

» To synchronize an audio file to a drill file click on the <spacebar>

while the music is playing in tempo with the music. Each click of the Svnchronizing
<spacebar> will advance the drill one count. When completed click ' :
the Done button on the Synchronizing Window. Count E'e

[ Done 1

¢ To re-synchronize the drill, clear the current . p—— :
y | Audio Synchronization (X |

synchronization by holding the <alt> key
(<option> on Macintosh) while clicking on
the Sound button. Another way to clear the \c{) Ckay to clear the drill synchronization to its audio File?
synchronization is by clicking on Clear '
Synchronization To Drill in the @ | Mo |
Preferences section of Document

Options of the File menu.

« After the audio file is synchronized, each time you click on the Play button when the Sound button is
depressed the music will be played.

Should you transfer the drill file
to another computer, you will (310 30 Drill Document Options
also need to transfer the drills -

audio file. The location of the
audio file is found in the
External Files section of
Document Options of the File
menu.

X

|| Propetties | Preferences 5
Location of external files used with this drill file.
Audio File: les'Pyweare 30 Java Interactive'Drills\Batman'02Batman Theme Television.mps
Floor Cover:

Prop Images:

External files can be saved in a

drill file package called 3D

Package. This option is avalil-

able in the Save As dialog. This

package is compatible only with

the 3D version2 or greater.

Should you need the file to open

on 3D Version 1, it is best to put

the external files in the same _

folder as the drill. ok [ cencal
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MANAGER
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The Online File Manager is a utility that manages the transfer of files to and from your Online
Account. Depending on the access privileges you (the account administrator) setup, other users can
sign on to your account and read (download) drills. Users can sign on to your account through other
3D applications or through 3D Viewers anywhere in the world.

e To start the Online File Manager utility, select Online File Manager from the Interactive menu.
The Online File Manager will attempt to go online and find the list of accounts that you can access.

If the Online File Manager successfully connects to the Pyware Online Accounts a list of accounts
will display.

30 Ontine Accounts Ed|
Select an account to access:
Account Mame Account D
Dustin 00013
Dustin

| Add Account |

[ Remove Account ]

(%) Show My Personal Account List

() Show Commercial Accounts | Cancel |

Add Account will add an account to the list of accounts. If an account is selected in the list, Delete
Account will remove it from the list.

Show My Personal Account List shows the list of accounts that you have entered either through Add
Account as well as the account to you were given during the initial setup of the program.

Show Commercial Accounts displays the list of commercial accounts currently accessible on the
Pyware Online Account system.

Clicking on an account in the list and clicking Open will open and display the Sign On to Account dia-
log. Cancel will close the list of Online Accounts dialog where you can choose to Log On again.

Signing on to Account: Dustin E
Sign on as:
) Unregistered User or Group (Anonymous Guest)
(+) Registered User or Group:
Uszer or Grougp Mame: | Dustin

Password: | =

Locatian:

signon | | cancel
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When signing on as a Anonymous Guest, you will be able to see the files on the account that have
been given public access by the account administrator. Anonymous Guests are typically students
of school accounts, or shoppers on commercial accounts. Anonymous Guests require no sign-on
name or password.

When signing on as a Registered User, a user has unique privileges to see files that may (or may
not) be seen by Anonymous Guests. These access privileges are set by you, the account adminis-
trator. Often Registered Users consist of clients of drill designers. These users need private
access to the drill or drills that they have commissioned. No one else should be able to access
those drills. In order to sign-on as a Registered User, you must first be registered in the account by
the account administrator. Once registered, the administrator will give you a Sign-on Name and
Password.

Each account has an Account Administrator. The administrators sign on Name and Password is
given to the application’s registered user when the online account is setup by Pygraphics. To sign
on as an Account Administrator, select Registered User and enter the administrators sign on Name
and Password.

Save Settings is useful if you usually sign on into the same account repetitively because it will save
the values you have typed in to make it faster next time you want to sign on.

Cancel will disconnect from the online account system and return to the Online File Manager. To re-
connect, click Log On to another account.

Sign On will sign on to the account and display the list of accessible files.
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¢ Once a visitor has signed on to the account the Online File Manager will display with the list of
accessible files.

X

| 3 3D Java Online File Manager I <
To get a file from [Dustin], click the check box in the column "GET THIS FILE".
File Mame Online Deseription Online Yer Local Wer CHECK BOX TO FICK THE FILE
| Earth Wyind and Fireprod _Trad'rtional Dreill v | w4 Clocal) | D
Hailf tirme Dkl titne test Sdz _Half tire il tirme test .2 | .2 Clocal) | |:|
| Leader board 304,30 _Leaderboard el file v | v Clocal) | D
| Leaderboard 302 file Jdz _Test Lesderboard 30Z file v | v Clocal) | |:|
Lesderboard Production prod _Test Lesderboard Production | v | v Clocal) | D
| Paul Sitmon Dbl Tim Test. 3dz _Paul simon Dbl Time Test | vz | none i |
| an 3D Java Online File Manager '_>_/_
To access online files in account [Dustin], make a change in the TO DO column.
File Hame Online Description Online Wer Local Ver TO DO

| Earthy wind and Fire prod Traditional Drill w.d .4 (local) |(click here to do something with this file)|
Half tirme Dhl time test.3dz Hailf time dbl time test w2 w.2 (local) .(click here to do something with this file)

| Leader board 30J.3d Leaderboard 3dj file . LA w.1 (local) |(click here to do something with this file)

| Leaderboard 3DZ file. 3dz Test Leaderboard 3DZ file . LAl w1 (local) .(click here to do something with this file)
Leaderboard Production.prod Test Leaderhoard Production v w1 (local) | (click here to do something with this file)

| Paul Sirnon Dbl Tim Test 3dz -Paul simaon Dhl Time Test . w2 . nong [click here to do something with this file)

| Paul Simon Opener prod -Paul Siton Dbl time Half Time test . v | w.4 [local) .(click here to do something with this file)

: Test Dkl time Half Time 3dz -Test Dbl time half time . L] . none [click hereto do Sometﬁiﬁg with this file)
Coordinate Printout Test 3 -LOCAL COPY - Mo online description currently availa... . . .(click here to do zomething with this file)
Fantasy. 3dj LAl COPY - Mo online description currently availa... .(click here to do zomething with this file)

| In The Stone.3d LAl COPY - Mo online description currently availa... . [click here to do samething with this file)

| Fock That .3dj Lozl COPY - Mo online description currently availa... . .(click here to do something with this file)

| =ddf 3o LAl COPY - Mo online description currently availa... [click here to do samething with this file)

Sirnulator File of Batman Begins...- LAl COPY - Mo online description currently availa... . . [click here to do something with this file)

;test.de -LOCAL COPY - Mo online description currently availa... . . .(click here to do something with this file)

: Tutor file 3dj -LOCAL COPY - Ma anline description currerﬁly availa... . . [click heve to do Sometﬁiﬁg with this file)

| WEDemmo 3o -LOCAL COPY - Mo anline description currertly svaila... . . .(click here to do something with this file)

01 El Catvitw Resl.3dz LOCAL COPY - Mo anline description currertly svaila... | .(click here to do something with this file) p—

Online Connection Monitor Files in this account that have not been modified for aver
User Mame:  Dustin Status: Online LRI

User Level:  Administrator

Account Dustin Log Cn to ancther account Cancel

The Online File Manager will display all files the signed on user has privileges to see. All files will
be displayed, both files local to the host computer, as well as the files located in the online account.
The File Name is the actual name of the drill file (.3dj) or drill package (.3dz) as it is saved to your
hard drive. The File Description is a description entered by the account administrator of the files
located in the online account. The file versions are useful when determining which copy of a file
(local or online) is the most current.

Guests and Registered Users signing on to an account will see a GET THIS FILE column, because
the only action they can perform is to read (download) files from the online account. Account
Administrators will see a TO DO column so they can perform a variety of tasks that upload, down-
load and delete files from the online account.
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In the figure on the previous page notice that only five of the eight files listed are actually in the
online account and the rest of the file are located on the local computer only. Notice the online file
versions for the files that are online are shown in the Internet Copy column. If there are local
copies that have been downloaded from the online account the Local Copy will display the local ver-
sion. You can use the versions to determine whether the drill file on your computer, or in the online
account, is the most current.

When logged in as the account administrator, there are four tasks that can be chosen to do to the
files in the list. Beside each of the drill files is a TO DO pull down menu listing the applicable tasks.

* Do Nothing will not make any changes to the file.

e Get the online internet copy of the file will download the online version of the file to the local
computer.

« Send a file copy to the internet account will upload the local version of the file to the online
account. This option is only available to the administrator.

* Remove the file from the internet account will remove the file entirely from the online
account. This option is only available to the administrator.

Other control buttons in the Online File Manager window are:
Save Changes will perform the tasks selected for each file.
Cancel will log off the online account and close the Online Account Manager.
Show File Information will show the file information dialog of the selected file in the list.

Log on to another account will log off the current account and re-display the list of accounts.

The Online Connection Monitor monitors the connection to the online account and displays the
user and account information.

Online Connection Monitor

User Hame: Custin Status: Online
User Lewvel: Administratar

Account: Dostin

User Name is the current user logged in.
User Level is the privilege level of the currently logged in user.
Account is the account in which the user is currently logged on to.

Status is the current status of the file manager.
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UNLOCK THIS
DRILL
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This function is used to unlock drills that have been locked from full access by a drill provider.
To unlock a drill:
» Contact the drill provider for a key.

e The drill provider will want to know the Drill ID and Lock ID displayed in this window.

' 3l orill Unlock Utility X
Locked Drill Information
File: WEBDermo 3dj
Demonstration File provided by:
YWarner Bros Publications
Designer, Craig Harms
This function is used to unlock drills that have been locked from full access.
To unlock this drill:

131 Contact the drill provider for a key.

29 The drill provider will weant to know the Crill I and Lock 1D shown Below,
Impartant; Do not click [Exit] or close this screen after you give the provider the
infarmation, because the Lock 1D will zhange each time vou open this function.
and the key the provider gives ywou will not wakd

31 The drill provider will give you a key.l

41 Enter the key and click [Unlock].

51 Follow the screen prompts.

Drill ID: WEDEMO.3
Lock ID: 44FF

Key:

| Unlock |

| Exi

VERY IMPORTANT: Do not click Exit or close this window after you give the provider the informa-
tion, because the Lock ID will change each time you use this function. Therefore, the key the drill
provider gives you will not work!

 The drill provider will give you a key.
e Enter the key and click Unlock.

 Follow the screen prompts.
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ONLINE USER
FILE ACCESS &
PASSWORDS The Online Users File Access & Passwords utility is to be used by the account’s administrator to
setup the access privileges for visitors to their account. Visitors who have signed on to your account
are called “users”. Users can access your account from their 3D applications and from downloadable
3D Viewers. There are three types of users.

1 Anonymous Guest - This is a user who can access your account without having to sign on with a
User Name and Password. These users can only read (download) files from your online account.
They do not have the authority to write (upload) files to your online account. With this utility you
can setup Anonymous Guests to see only selected files in the account. Allowing Anonymous
Guests to sign on to your account is useful when you want a large group of users to have access
the same list of files, such as all performers in a marching band. Since a User Name and
Password are not required to be an Anonymous Guest, it is also useful for Commercial Online
Accounts for potential customers to be able to sign on.

2 Registered Guest - This is a user who can access your account with a sign on User Name and
Password. These users can read (download) files from your online account, but do not have the
authority to write (upload) files to your online account. With this utility you can setup Registered
Guests to see only selected files in the account. Setting up Registered Guests is useful to give
unique file access to a single user such as a customer picking up commissioned drill from a
designer.

3 Account Administrator - This is a user who can access your account after signing on to the
account as a Registered User using the account administrators User Name and Password. This
user can read and write files from your online account. All files in the account are visible to this
user. The administrator can use this utility to add or edit users and change their access privileges.
You can setup different users to have differing access to files in the account. This utility can only
be run by the account administrator.

* To start the Online Users File Access & Passwords, select Online Users File Access &
Passwords from the Interactive menu. The Online Users File Access & Passwords will attempt
to go online and find your online account.

* Once connected, a Sigh On

dialog will display for you to | Signing on to Account: Dustin v\.H
enter the account administra- %
tor's Name and Password. kgt

() Unregistered User or Group (Anommmous Guest)

() Registered User or Group:

Uzer or Group Mame: | Dustin
Passweord: | =
Location:
Sign On ] | Cancel

Clicking Sign On will display the list of all files in the online account.
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Xi

3“ Online User File Access & Passwords

|E¥
Py

This editor is used to set the access privileges for users logging on to your account.
Click on a user whose access privileges you want to change and click “Edit User”.

Lzer (or Grougp) Lewvel Eatth Win... Half titme ... Leader b... Leaderbo.. Lesderbo.. Paul Simo... Paul Sima... Test Dhiti...
Dustin | Acministrator

Anorrymous Guest |Guest

Test Group (Guest

Dustins Graup Guest.

Thiz account can have one administratar and an unlimited number of guests.

Online Connection Monitor Grant access to Unregistered Users & Groups a3 Anonytnous Guest

User Hame: [Custin Status: Online :
| Mew Registered Uszer or Group |

User Level:  Administrator

Account: | Dustin | Cancel

In the table, the User column displays the Name you have designated for each for the users or user
groups you have established.

The Level column displays the type of level given to each user you have established. The levels
are:

Administrator - has full access to the online account to add, update and remove files.
Guest - has read only access for downloading files from the online account.
No Access - can sign on, but will not see any files in the online account.

The remaining columns in the table designate each file in the online account and the type of access
privilege this user is given to the file. The column title is the name of the file. The privileges are:

Read/Write - the user can upload, download, and update this file from the online account
READ - the user can only download this file from the online account
hide - the user will not see this file in the online account

The Allow anonymous guest for public access is used when you want to allow users access to your
account without a unique User Name and User Password. This option is typically useful for school
band programs who want student performers access to certain files on the account without assigning
user names and passwords to each student. This option is also used for Commercial Accounts that
anyone to see a selection of files visible to anonymous guests on their account.
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e To add a new user or user group to you list of users, click New Registered User will display the Edit
User Privileges dialog.

| 3 Edit User Privileges B3
zer or Group Mame: | Dusting Group

Level \GLUEST b

Pazzword: |

et the accesz privilege vou want this User (or Group) to have for
each file that iz currently online. %ou can alzo use the *_all files"
check box helowy to set the access privilege for all files (including any
files yet to he put anline). If you change the password, you will need
to natity the User (or Group) of the nesw passward or they will no
langer be ahle to sign an.

Online Files Read Only
Earth Wind and Fire prod

Half tirme Dbl time test. 3oz

Leader board 30 .35

Leaderboard 3DE file 3dz

Leaderboard Production prod

Paul Sirman Dil Tien Test Sdz

Paul Sirmon Cpener porod

Test Dhl tirme Half Time Sdz

REREEREEE

Set all files readable.

| Ckay || Cancel

User Name and Password are text boxes where you enter a user name and password that you as
the account administrator will determine.

Level is the level for the users file access. NO ACCESS will prevent all files from being displayed
on the users file list. GUEST allows users to see selected files in their users file list to read (down-
load). The only user that can write (upload) files to the list is the Account Administrator.

Online Files is the list of all files current on the Online Account.

When the Level is GUEST, the Read Only column determines whether this registered user has
access to this file.

Set all files readable is used as a shortcut to set all current and any future files in the online account
to Read Only. Remember, this option will set any future files added to the online account to be Read
Only for this user. Conversely, if you do not use this option in a users privileges, you will need to
edit the users privileges after new files have been uploaded into the account when you want the user
to have access to the new files.
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The Read Only column sets the access to the a file for the user. If it is not checked, the user will
not see the file when they sign on to the account.

Okay will accept the changes to the new user.

The Edit User button will display the same Edit User Privileges dialog as did the New Registered
User button.

The one exceptionis ¢ —a
that when editing the f 3[] Online Administrator Profile [_/EJ
Account r
Administrator’s privi-
leges the log in and
contact information will
display. This contact
information will be dis-
played to users that

As the administrator, you will be ahle to upload files to vour account, as
well as control who has access to those files.

Yaur Mame: Dustin|

appear to be having Pagaword, FFEF
trouble signing on to
your account. The contact info below is displayed to users that need help with their pasamward.

Cartact ebdail; Dusting@pywware.com
Phone: 940-240-55356

Okay for Pygraphics to send ehails to the abowve ehdail address.

Okay H Cancel

The Delete User button will delete the selected user.

Save writes access changes to the online account. Likewise, Cancel exits the utility.

PERFORMER’S
TooLs MENu This menu has access to all of the Performer’s Practice Tools and utilities to manage them.

1 |3D Performer’s Practice Tools - Launches the same program that the performers (students) and
download and run on their home computers.

2 Leader Board Manager - This utility manages the online Leader Boards lists that are generated by
the performers as they use the 3D Performance Simulator. (explained in more detail next)

3 Print Performer’s Setup Instructions. This prints a sheet that the director (drill designer) can pass out
to the performers detailing steps to download and setup the Performer’s Practice Tools.

4 Setup - This wizard sets up 3D program to communicate directly with a installation of Performer’s
Practice Tools on this computer. It also activates all of the “Enhanced” features that can be pur-
chased by the performer, and setups up the paths necessary for 3D to launch the Performer’s
Practice Tools directly.
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LEADER BOARD

MANAGER Leader Boards are generated by performers using the 3D Performance Simulator. As a performer
practices their drills they attempt to reach a perfect score of 1000. As their scores improve, their score
is uploaded to the drill's Leader Board so performers can compete for the top of the leader board. The
Leader Board Manager displays the Leader Board lists of all of the drills you have online.

Clear - erases the list of the currently displayed Leader Board.
Clear All - erases the list of all Leader Boards.
Purge.. older than ? days - will remove performers on all Leader Board lists that have been on a list of
a determined number of days.
DRiLL Lock
DECODER The Drill Lock Decoder utility is used primarily for designers selling drills online. Drills can be locked
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with a password so they can be viewed but not edited or printed. After a customer downloads and pre-
views a drill, the customer can then contact the drill designer to purchase and unlock it. This decoder
creates unique keys for unlocking a drill, so a key used by one customer cannot be used by another.

To create a locked drill file that can't be edited or printed:
» Open the drill, and select Document Options from the File menu.
* In the Author Information box, type your contact and/or sales information.

» Under the Properties tab, pick your restriction options such as "Cannot be printed" and "Cannot
be edited."

* Click Lock the properties with a Master Password, enter a Master password. The Master password
is the password that only you know. When your customer contacts you to unlock the drill, don't give
them your Master Password. Instead, use this decoder to create a unique key that will only work for
this customer and no one else. Remember the Master Password because you will need it to create
the unique key for your customer.

To unlock a locked drill with a

password that will work only il Drill Password Decoder
for one customer: This decoder is used primarily for designers selling drill online. Drills can be locked with a password so they
can be viewead but not edited or printad. After a cust downloads and i a diill, the customer can
then contact the diill designerto purchase and unlock it. This decoder creates unique keys for unlocking a
° Te” the CUStomer to Open drill, 50 a key used by one customer cannot be used by another.
the drl” they Want to unIOCk To create a locked drill file that can't be edited or printed:
us|ng the”' 3D program 1) Open the drill, and select Document Options from the File menu.
2) Underthe Properties tab, pick your restriction options such az"Cannot be printed." and "Cannot be
edited".
o Tell the customer to select 3) In the Author Information box, type your contact and/or sales information and select the
. . "Author information and Copyright is displayed when the file iz opened.”
UnIOCk th 1S Dr' ” frOm the @) Click "Lock the properies with a Master Pazaward" and click [Okay].
H ) Enter a Master Pasamord that only wou will know,
Interactive menu and a
1 ih 1 [T When your customer contacts you to unlock the drill, den't give them your Master Pasamard.
Drl” Un IOCk Utl | Ity WI” dls Instead, uze thiz decoderto create a unique key that will only wod for this customer and no one else.
play. 1) Tell the customer to open the drill they want to unlock using their 20 Java Interactive program.

2) Tell the customer to select"Unlock Drill" from the "Interactive" menu.

3) Agithe customer to read to you the Drill ID, and Lock 1D that is displayed. Forwourinformation,
the Drill 1D is going to be the first 8 characters of the file that the customer has openad. Use the
Crrill ID given wou wou make sure you are about to unlock corect file.

) On thiz decoderyou will enter the Master Pasamord that you originally used to lock the drill. ou will
alzo enterthe Drill I, and the Lock ID that the customer gawve wou. Then click [Caleulate Key].

&) Tell the customer to enter the key thatwou hawve calculated and click [Unlock].

Master Password: | 1111
Drill ID: | TEST L
Lock x| SCOF

Key: A-OHU

Calculate Key —————
Done
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» Ask the customer to read to you the Drill ID, and Lock ID that is displayed. For your information,
the Drill ID is going to be the first 8 characters of the file that the customer has opened. You should
use the Drill ID given to make sure you are about to unlock the correct file.

 Using this decoder Utility, enter the Master Password that you originally used to lock the drill. Also
enter the Drill ID, and the Lock ID that the customer gave you.

 Click Calculate Key.

 Tell the customer to enter the key that you have calculated and click Unlock.

CHECK FOR

UPDATES This functions checks and downloads updates from the the automated update system at Pyware
Headquarters.

CHECK FOR

MESSAGES... This utility opens the Pyware Message Board. The Pyware Message Board is an automated infor-

mation system that checks with Pyware Headquarters for any important notices such as updates that
are currently available for you to download. To check messages:

e Select Check for Messages from Pyware Headquarters from the Interactive menu and the utility
will attempt to connect with Pyware Headquarters.

B 1] Messages from Pygraphics Headquarters - You have 4 messages. B3

Click on a subject to show the message.

Subject

:“Fluur Cover" plug-in for winter guard and stage performances

ETraditionaI Tools ! Military Maneuvers plug-in.

5'8119105 Pyware User Forums Now Available!

(41252007 3D Java Yersion 4.1 is How Available Call 800-222-7536 for purchase information.

[<

v

| WY Y GENE CO || Send a message | | Delete all messages | Cloze

3D will check Pyware Headquarters for any new update information or important notices that you
may be interested in and display the list of messages in the Subject box. If you want to read a mes-

sage, click the message listed in the Subject box and it will display.
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Clicking on www.pyware.com launches a browser to the Pyware web site.

Clicking on Send a Message sends a message from you to the Pyware Headquarters.
Selecting a message and clicking Remind me later will re-display the message in 20 days.
Selecting a message and clicking Delete this message will remove the message from the list.
Clicking Delete all messages will remove all messages from the list.

Close will exit the Pyware Message Board.

Pyware WEB

SITE This utility will open the local computer’s web browser to the Pyware website.

FREQUENTLY

ASKED

QUESTIONS This utility will open the local computer’s web browser to the Frequently Asked Questions webpage
on the Pyware website.

DEAUTHORIZE

THIS COMPUTER

This function was employed for users who need to e

switch 3D installations between more machines than years 30 Program Acation
their license allows, all with the convience of not having it

to contact Pygraphics to do so. Once you select the

deauthorize button, the program on your machine will

convert into a demonstration version that does not

WARNING: This fnction will demzhesize this installation and

save or print and is restricted to viewing only 80 ot 1o & e
counts. You would then be able toinstall and activate S i i el A TS A Dk

bustn bekowm, then click [Deauthorize).

on a different computer.

| unded stand tht | m Desuthorizing this installstion.

Should you choose to install and suthorize on a déferent
EOMBULET, Y Te-BANSITE the INSLERILEN BR THIS EOMBULET, yBU
will need your sevial number: 30.IPA0-$0034.30080

GET PLuG-INs

AND

ACCESSORIES This utility opens the 3D Upgrades and Accessories window for information and pricing regarding avail-
able updates and Plug-Ins. These may be purchased instantly online via Credit Card.

INSTANTLY

UPGRADE

My 3D Now This utility opens a window with prompts:
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How do | instantly upgrade my 3D Edition opens the window similar to Get Plug-Ins and
Accessories. This window has information and pricing regarding available updates and Plug-Ins.

| want to apply an existing upgrade or Plug-In purchase prompts you to revalidate your program. If
you have purchased an update (and have internet access at the time you are attempting to revalidate),
your new purchase will take effect after completing the online validation.
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The Traditional Tools Plug-In includes tools that are used in military corps style marching. These
tools include: the Sequential Push tool which is used to create step offs and drop offs; the Counter
March tool for counter marches; Parade Gate tool for wide sweeping turns, and the Traditional tool
that allows you to create a custom transitions.

Traditional Tools Plug-In is an optional purchase. To see if Traditional Tools Plug-in is installed on
your program, select Application Options from the File menu and click on the Plug-Ins tab.

3l Application Options |‘>_’§j .

Flug-Ins Installed in thiz installation of 30:
Standard 30 Java Plug-In Tool Set
Lentine Spiral Drawing Tool

Traditional Tool Set

Floor Covers

30 Plug-In Instant Purchasing Information | | Reactivate Plug-Ins |

L Ok J | Cancel | .
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INSTALLATION
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The Traditional Tools Plug-In will not operate on any version of 3D that is less than version 1.1.1. 3D

can be updated from our site at www.pyware.com.

To activate your Traditional Tools Plug-In, go to your File Menu and choose Application Options.
From Application Options, select your Plug-ins tab. Click "Reactivate Plug-ins."”

You should then see blanks to enter information for each plug-in currently available. Reference your
Traditional Tool Plug-in Activation Code that came with your program, and type in the missing fragment

of the activation code in the appropriate field.

Select "Reactivate," and if keyed in correctly, your plug-in will be unlocked. Restart 3D and you will

see the Traditional Tools on your Tool Palette.

| 30 Upgrade & Plug-In Catalog >’?.
This window is used to reactivate plug-ins that have been purchased.
It may be necessary to reactivate your plug-ins should you need to reinstall your software.
. 3D Plug-ins Activation Codes (if purchased)
Floor Cover 00013 - ||
Traditional Tools ooo1is -
Spiral Tool oools -
Personalized Crill Books ooo1s -
Okher
| Exit

RE-ACTIVATE |J
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SEQUENTIAL
PusH TooL The Sequential Push tool allows you to create step offs and drop offs.

To access the tool, set the Count Track up for a “transition” with the Red Anchor at the end count of
the transition and the Yellow Anchor at the beginning. The performers you want doing this transition
must also be selected.

 Click on the Sequential Push tool but- = . o 5
ton you will then see the Sequential RS(EE SP7 a5 4 0 '_i EQ L~
Push Control Panel. il & A9 &2 T T &

Stride 0.0 tos o7 5
Distance 0.0 % ) Restrict

Step Off 2 steps Direction HORVert
Crrop Off 0O steps

Editing handles appear on each performer. . | | | | | | | |

Dragging the editing handle of a position to |
a final location will cause all other perform-

|
ers to follow behind in a sequential move- NLEAEEELEREL I
ment. The position that is dragged will mm
always be the performer that will travel the = |
furthest in the maneuver. E@ |

If there are not enough counts in the transi- |

tion for all performers to have timetostep | | | I | | L i IR NN | AR 1)
| |
|

off, then those performers will mark time. | | | |
1 1 1 1 1 1 1

Entering a value in the Stride text box moves the positions into the new location that reflect stride
length entered. Likewise, entering a number into the Distance text box moves the positions into the
new location that reflects distance entered. Clicking on the directional compass will move the
positions to reflect the new direction.

Snap to Horz/Vert padlock will snap the positions to nearest horizontal, vertical, or 45 degree direc-
tion.

Multi-Segment allows you to select more |
than one shape (segment) and have the .l .l
step off be uniform in all of the selected INRNRARNANA]
shapes as shown here.

The value in Step Off designates the counts between each step off. For example if you entered 2,
then the positions will step off every 2 counts until the end of the shape is reached or the number of
counts in the maneuver is reached.
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The value in Drop Off designates the counts between each drop off. Typically you will enter a value
for either the Step Off or the Drop Off and leave the other at 0. For example if you enter a 0 as the
step off and 2 as the drop off, all positions stepped off together then the positions will drop off at the
rate of 2 every count until the end of the maneuver. If there are not enough counts in the maneuver

then some positions may just mark time.

The Animation Controls are always accessible while using this tool for previewing the maneuver.
Reset to Hold - resets the transition to a "Hold" from the secondary count.
Revert button resets the handles to their initial position.

Accept button accepts the shape into the drill.

COUNTER
MARCH TooL
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To access the tool, set the Count Track up for a “transition” with the Red Anchor at the end count
of the transition and the Yellow Anchor at the beginning. The performers you want doing this transi-
tion must also be selected.

Click on the Counter March tool button _
you will then see the Counter March B |23 (@2 %) | = || 20 0] [ g B | | Ll
Control Panel. O @ 22 A28 [SIT @L T &

Stide & tos
13 Flank [ ) right (%) left ] atthe blue line,
2)Take 2  steps and flank. (O=don't flank again)

F1Pause 0 counts and go. (O=don't pause)

A e Amows mowe action

the counter march to the location on the field where

the counter march is to begin. A blue line will desig-
nate the location where the counter march maneuver
will begin.

Editing handles appear on each of the selected per- e |
formers. Drag any editing handle in the direction of B |
o ]

In the Counter March Control Panel, the value in the Stride text box determines the stride length
the performers will be using during this maneuver.

The Flank button designates which way the performers will first turn in the counter march. You have
two options flanking to the left or to the right.

The value in Take [ ] steps and flank designates the number of steps after the first flank that the
performers travel before flanking again.

The value in Pause [ ] counts and go designates the number of counts the performers will hold (or
mark time) before the second flank.

The Animation Controls are always accessible while using this tool for previewing the maneuver.
Revert button resets the handles to their initial position.

Accept button accepts the shape into the drill.
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PARADE GATE
TooL
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The Parade Gate tool allows you to create wide gate turn easily. This is an essential tool for parades
when rounding corners. To access the tool, set the Count Track up for a “transition” with the Red
Anchor at the end count of the transition and the Yellow Anchor at the beginning. The performers
you want doing this transition must also be selected.

» To access the Parade Gate tool you must select a range of counts as seen below and a group of
performers must be selected.

* Click on the Parade Gate tool button e o i @
and the Parade Gate Control Panel will Rl 58] |2 = ]| E B |7 {. L~
appear. el [Z212 AAcl= ST [EE [T &

Stride & to S (except during gate)
Gate [ () left () right ] atthe blue line.
Steps during gate 16

« Editing handles will appear on each of the selected performers. Drag any performer to determine
the initial marching direction and the point at which the rotation of the gate maneuver should begin.

The center point of the rotation will occur at the final location of the editing handle you drag. You
can change the center point of rotation by dragging the center point indicator.

m
mm)
L
I E
*
. 4

pebesesesateest’
R
+n+n+n+n+u+n+n -
+¢+¢+n!u+¢+n+¢ .
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In the Control Panel, the value in the Stride text box designates the stride length the performers will
be using during this maneuver, except during the actual gate. During the gate all performers will be
taking different strides.
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Gate [left] [right] at the blue line designates which way the positions will turn when performing the
gate. The gate will not begin until the performers cross the blue line.

The value in Steps during gate designates the number of steps taken in the gate. The default is 16.
This means the performers take a total of 16 steps during the execution of the gate maneuver.

Revert button resets the handles to their initial position.

Accept button accepts the shape into the drill.
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TRADITIONAL
TooL
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The Traditional tool allows you to create custom transitions. They are created by entering a Route
consisting of any combination flanking and sequential setup moves. To access the tool, set the Count
Track up for a “transition” with the Red Anchor at the end count of the transition and the Yellow
Anchor at the beginning. The performers you want doing this transition must also be selected.

» Click on the Traditional tool button and

the Traditional Control Panel will 31 B 7 N I i a5 P L = e S
appear. J @ 2 & A A 0l29 [&=T T
Stide 8 tos Action Line Slope Mo Slope i
Fath Hame ‘Slant L [ New ] [ Copy ][ Delete]
Route =2 mt

Description | Step 2 Step Off
hdark Time to the end.

» Editing handles will appear on each of the selected perform- | |
ers. Drag any performer to determine the initial marching | |
direction for all of the performers.

As you drag an editing handle an action line will appear on
the field that designates starting line for the Route to begin. As
each performer crosses this line, the performer will begin fol- i el
lowing the Route. Mt

In this example. The performers are initially moving in the | |
same direction as the leader (Left). As they cross the action xR N MR o ey v W
line, they begin performing the route. In this case the route is |
simple LF (Left Flank). |

=ttt et e

et =R =

FEFRIEREFERTE
\B: FRERFEERE

S

LB B o g
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» The Traditional tool allows you to create custom transitions. They are created by entering a Route
consisting of any combination moves. You have 8 different moves available:

Code Movement

LF Left Flank

RF Right Flank

MT Mark Time

FM Forward March

TR To the Rear

ST Step Off (such as Step 2)

SD Drop off (such as Drop 2)

H Half Stride allows to take a half distance step

The route is entered in the Route box by typing the code for the move followed by a number of
steps. Each move is separated with a comma.

For example: LE2,LF

The above example is a Left Flank (LF) then take 2 steps and make another left flank (LF), then con-
tinue marching to the end of the length of the transition. This is a standard left counter march. Type
in the route in the Route text box and as you type, the description will appear in the Description
area. This will help you confirm that you are entering a correct route.

Action Line Slope changes the slope of the starting line of the route. Typically the slope will be 0.
However you can set the line to a 45 degree slope which allows you to create column left and right
formations. You have 7 different settings: no slope, 22.5, 45, 67.5, -67.5, -45 and -22.5 degrees,
depending on what direction you want the column to turn.

New button creates a new traditional maneuver.

Save button will save your Route as a traditional maneuver to be used again later.
Copy button will open and display a saved Route (traditional maneuver).

Delete button will delete a saved Route.

Revert button resets the handles to their initial position.

Accept button accepts the shape into the drill.
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In Pyware 3D, a performing surface is most always made up of a grid created by the Grid Designer of
the Utilities menu. Grids are the lines on the field display such as yard lines on a football field. Most

performing surfaces can be defined using simply these horizontal and vertical grid lines. However, in

some cases there are other characteristics of a performing surface that would be handy to show on the
screen. For example, the markings on a standard basketball court would be nice for Winter Guard per-
formances. These special markings or background can be displayed using Floor Covers. When creat-
ing a grid using the Grid Designer, you can add a Floor Cover that is placed under the grid. The floor
cover usually represents the markings of a basketball court, soccer field or other standard field, howev-
er, it could also be the logo that is painted in the center of a football field, or the design on a canvas

that lays over the performing surface in an indoor performance. There are many uses for Floor Covers.

Floor Covers Plug-In is an optional purchase. To see if Floor Covers Plug-In is installed on your
program, select Application Options from the File menu and click on the Plug-Ins tab.

[ 3'] Application Options EE!' :
Backups | System Ihfo | Installation |

||| Digplay (P

F'Iug-lnls In.stalled in this installation of 30
Standard 30 Java Plug-In Tool Set
Lertine Spiral Dravwing Toal

Traditional Tool Set

Floar Covers

3D Plug-In Instant Purchasing Information | | Reactivate Plug-Ins |

L Ik J | Cancel | |
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INSTALLATION
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Installing the Floor Cover Plug-In: The Floor Cover Plug will not operate on any version of 3D that is
less than version 1.1.1. 3D can be updated from our site at www.pyware.com.

To activate your Floor Covers Plug-In, go to your File Menu and choose Application Options. From
Application Options, select your Plug-ins tab. Click "Reactivate Plug-ins."

You should then see blanks to enter information for each plug-in currently available. Reference your
Floor Covers Plug-in Activation Code that came with your program, and type in the missing fragment of
the activation code in the appropriate field.

Select "Reactivate," and if keyed in correctly, your plug-in will be unlocked. Restart 3D and you will
see the Floor Covers option in your Grid Designer under the Utlities Menu.

30 Upgrade & Plug-In Catalog /\a
This window is used to reactivate plug-ins that have been purchased.
It may be necessary to reactivate your plug-ins should you need to reinstall your software.
. 3D Plug-ins Activation Codes (if purchased)

Floor Cover 00013 - ||

Traditional Tools ooo1is -

Spiral Tool oools -

Personalized Drill Books oools -

Okher

I | Exit RE-ACTIVATE
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DESIGNING A
FLOOR COVER
IN A GRID
LAvouTt A floor cover is actually a “.jpg” or “.gif” picture file that is created with the width and the height of the
picture in the same proportion as the performing surface. For example on a football field, the height is
52.5% of the length. Included with the floor covers is a Football field template that is already created to
these proportions. Within this picture file is a drawing representing the surface design of the perform-
ance. All floor cover files are located in the Floor Covers folder of the 3D application folder.

To create a grid that includes a floor cover you will use the Grid Designer found in the Utilities menu
of 3D.

» Select Grid Designer from the Utilities menu.

« If the grid that you want placed over the floor cover is already created but not currently displayed,
click Load and select the grid you want to be placed over the floor cover.

* Click Floor Cover and
SEEeRiGINRUCHISRel§ilele /g Select a Floor Cover to include with field grid:
covers (located in the Floor
Covers folder). If you want Lok in: |
to create a different floor
cover, you will need to use
a paint program to design = Footbal_Template.jpg
the floor cover with the = IHSEEal.jpa
width and height of the pic- | [E/LG5occer.jpa
ture in the same proportion | [E/MBAEEAl.jpg
as the performing surface. = SMSoccer. jpg
Save it in the Floor Covers
folder as a “.jpg” or “.gif"

file. _

Files of type: | Al Files " i Cancel

_ ‘Floor Covers ._.v | rji -

= CollegeH3EEall. jpg

« After the floor cover and grid layout are setup as you would like, save the layout using the Save or
Save As button so you can use the new grid design on new drill files.

* Click Ok if you want change the grid of the currently opened drill file to the new grid.
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ADDING A

ScHooL Logo

Toa

GRID LAYouT Included in the Floor Covers folder is a Football_Template.jpg file. This file is created with the correct
proportions (height and width) of a standard football field. The file also has a tick mark at each yard
line location.

» To add a logo to the file, open the file “Football_Template.jpg” with a drawing (paint) program. The
paint program can be something like “Microsoft Photo Editor.” The file is located in the Floor Covers
folder found in the 3D application folder.

 Paste your logo into the template. Scale and locate the logo so that it fits correctly in the template
using the yard line tick marks as a guide.

» Delete the outer border and tick marks leaving only the logo in the file.

» Save As the file under a new name. Make sure the location of the file is in the Floor Covers folder.

* Use the steps in the section above for adding a floor cover to an existing grid.

TRANSFERRING

FLoor CovVERS
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Should you transfer the drill file to another computer, you will need to also transfer the floor cover
image used in your drill. You can save a 3D Drill File as a 3D Package that will include the floor cover
picture used with the drill into one file. When saving, the package option Include Floor Cover must
be set. To change the format of an existing drill file to a 3D Package, choose Save As from the File
menu and set the Save Options.

3D Package files are compatible only with 3D version 2 or greater. Should you need the file to open
on 3D Java version 1, it is best to put the external files in the same folder as the drill. You can deter-
mine which images are used in the drill by selecting External Files from Document Options of the
File menu.
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In Pyware 3D, the Personal Drill Book Printer is a plug-in that harnesses one of the most powerful
features of the Performer's Practice Tools and puts it in your hands as a Director/Designer. This plug-in

allows you to print customized drill books for each performer with set by set pathways and coordinate
sheets.

The Personal Drill Book Printer plug-in is an optional purchase. To see if the Personal Drill Book

Printer plug-in is installed on your program, select Application Options from the File menu and click
on the Plug-Ins tab.

S|

| 30 Application Options !

o
il
=)

_EEiackups Swyatem Info | Installstion

FPlug-Inz Installed in this installation of 30
Standard 30 Plug-In Tool Set

30 Floor Cover Plug-In

Lentine Spiral Drawing Tool

| Traditional Tool Set

Personalized Crill Books

Click on a plug-in to display it's options (if any).

3D Plug-In Instant Purchasing Information | | Reactivate Plug-lns |

[ 8.4 l | Cancel
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INSTALLATION
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Installing the Personal Drill Book Printer Plug-In: This Plug-in will not operate on any version of 3D that
is less than version 4.2.6. 3D can be updated from our site at www.pyware.com.

» Open the 3D software.

* Go to the File Menu

e Open Application Options.

* Click on the Plug-ins Tab:

 Click the Re-activate Plug-ins button

» Enter the Plug-In Key Code in the text box at the bottom of the screen. The Plug-In Key Code is
sent to you by email from Pygraphics. You can also call Pygraphics 800-222-7536 for the key code.
Please have your 3D program Serial Number ready when you call.

30 upgrade & Plug-In Catalog X

| o]

This window is used to reactivate plug-ins that have been purchasesd.

It may be necessary to reactivate your plug-ins should you need to reinstall yvour software,

30 Plug-Ins Activation Codes {if purchased)

Floor Cover goooo -
Traditianal Toals goooo -
Spiral Tool gooog -
Perzonalized Drill Books goooo -
Cther

| Exit | RE-ACTIVATE |
L]

Click the Re-activate button to activate the plug-in. Restart 3D and you will see the Personal Drill
Book Printer option under the File Menu.
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PRINTING A
DRILL Book
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Before printing Drill Books it is suggested that you Print Charts Chl+P
label and name all performer’s for this tool to be most
effective. To print a Personalized Drill Book select
Print Personalized Drill Books from the file menu.

Print Coordinates Chrl+I
Print Cast Sheets
Print Cowver Sheet

Print Personalized Drill Books

This will open the Print options for the Personalized Drill Books.

| 30 Personalized Drill Book Plug-in B3

Sl |

Practes and print their persaonal drill book on their hotne computer. Similarly, with this plug-in, the zame Perzonalized Drill Books

Ly }3_["“{ Barformee’s  THIS plug-in is & module from 3D Performer's Practice Tools. With the Performer's Practice Tools, performers can dovwnloacd
;f/\ A2 & Tonls

are printed except all performers (or a selection) can be printed at one time.

Preferences Sort Performers

' Original Entry Order

w| Include Drill Book Cower. ) Hame

&

Include all drills of this production. () Gymbal and Label
Prirt all performers black. () Label and Symbol

Prirt each performers label.

Print text.

Prirt facing.

Overay set: Previous a Next

Coordinate step resolution and grid terminelagy
preferances are found inthe Print Coordinates window.

| Print Problem? | Save as Default ” Prirtt f Presvies: ” Cloze

Preferences are options used to customize the drill book printouts.

Print only selected positions - only prints drill books for performers that you currently have
selected on the drill page.

Include Drill Book Cover - includes a cover for the drill book pages to be inserted into.

Print all drills of this production - includes all drills, that are part of the current production that is
currently open.

Print all performers black - prints all performers black instead of the color set in the label editor.
Print each performer’s label - prints each performer’s label that is set in the label editor tool.
Print Text - prints all the text boxes that have been entered on each page.

Print facing - prints the facing direction for each performer.

Overlay set: (Previous) (Next) - prints the secondary positions as dots from either the previous or
the next drill set.

Sort Performers allows you to sort the drill books in order of Original Entry, Name, Symbol & Label, or
Label & Symbol.

Save as Default - saves the preferences that you select as the default settings for Drill Book printouts.
Print/Preview - opens the Print Preview screen that is seen on the next page.

Close - closes the Print Drill Book Dialog.
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PRINT PREVIEW | The print preview screen is accessed by clicking the Print/Preview button in the Print Drill Book Dialog.

All drill charts printed on the drill book are in the student perspective.

| 90 Print Preview

=
ey
St [FPragsSetup M 4 page 16 of13 B ML 125% (34 [ Closs
From: Batman Begins "Batmobile Chase" Set 4 From: Batman Begins "Batmobile Chase™ Set #5
Performer: Count: 68 Performer: Count: 100

BENEELRETRE BT 1o BE R M - SV

W0 3 Fi 5 33 i € Eil For E
o
& | 107
106 X ®
X 108 4
s X 100 G
X X
104 o
20 : 25 : 30 3 35: 40 | 4 : 1ol
G G () @ G G U x G & !
X iz 2 2
X G 2
27 2B 25 24 28 i 2
7 2 2 2 X s
X X X X X o 114
28 20 a0 31 32 38 34 a5 X X i |
x x X x X X X X b X ‘)'(“ nroage 1)@
! X
? e, Y, e, WHE E. A, S, e, A, i, S, 0, X —
L i = = = ag
5100 407 | 408 f0e 110 111112 113 14l 115 118 197 198 118 T P i 5 iy
Set Hove Count  Left-Right Visitor-Home Set Hove Court  Left-Rigt Visitor-Home
3 16 32 4.0 stps autside Right 35 v In an Home side line 4 36 68 40 stps outside Right 35 yd In an Hame side line
4 36 B8 4.0 stps eutside Right 35 vl In an Home side line 5 32 100 2.5 stps autside Right 23 vd In 13.5 stps in fmt of Home hash (High Sehl)
5 32100 28 stps outside Right 25 vl In 13.5 stps in fint o Home hash (High Schi} § 2 132 0.6 stps outside Right 35 yd In 5.75 stps hehind Home side fine

Print will send the job to the printer.

Previous Page will move to the previous preview page of the print job.
Next Page will move to the next preview page of the print job.

Page Setup button opens the printer’s page setup dialog.

Done button closes the print preview and returns to the print charts dialog.

170




CHAPTER 14 - Personal Drill Book Printer Plug-In

PRINT PREVIEW | The print preview screen is accessed by clicking the Print/Preview button in the Print Drill Book Dialog.

All drill charts printed on the drill book are in the student perspective.

| 90 Print Preview
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4 36 B8 4.0 stps eutside Right 35 vl In an Home side line 5 32 100 2.5 stps autside Right 23 vd In 13.5 stps in fmt of Home hash (High Sehl)
5 32100 28 stps outside Right 25 vl In 13.5 stps in fint o Home hash (High Schi} § 2 132 0.6 stps outside Right 35 yd In 5.75 stps hehind Home side fine

Print will send the job to the printer.

Previous Page will move to the previous preview page of the print job.
Next Page will move to the next preview page of the print job.

Page Setup button opens the printer’s page setup dialog.

Done button closes the print preview and returns to the print charts dialog.
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CHAPTER 15 - Spiral Drawing Tool Plug-in

In Pyware 3D, the Spiral Drawing Tool is a plug-in that allows a Designer to easily create a fluid spiral
shape.

The Spiral Drawing Tool plug-in is an optional purchase. To see if the Spiral Drawing Tool plug-in
is installed on your program, select Application Options from the File menu and click on the Plug-Ins
tab.

X

. 3'] Application Options

| Display | Installation

Flug-Ins Installed in this installation of 30
Standard 20 Java Plug-In Tool Set
Lentine Spiral Drawing Tool

Traditional Tool Set

Floor Covers

3D Plug-ln Instant Purchazing Information | | Reactivate Plug-lns |

| [8].4 | | Cancel |




CHAPTER 15 - Spiral Drawing Tool Plug-In

INSTALLATION Installing the Spiral Drawing Tool Plug-In: This Plug-in will not operate on any version of 3D that is less
than version 1.1.1. 3D can be updated from our site at www.pyware.com.

* Open the 3D software.

* Go to the File Menu

e Open Application Options.

* Click on the Plug-ins Tab:

 Click the Re-activate Plug-ins button

» Enter the Plug-In Key Code in the text box at the bottom of the screen. The Plug-In Key Code is
sent to you by email from Pygraphics. You can also call Pygraphics 800-222-7536 for the key code.
Please have your 3D program Serial Number ready when you call.

[ 30 Upgrade & Plug-In Catalog E‘.
This window is used to reactivate plug-ins that have been purchased.
It may be necessary to reactivate your plug-ins should you need to reinstall your software.

3D Plug-ins Activation Codes (if purchased)

Floor Cover 00013 - ||

Traditional Tools 0oo13 -

Spiral Tool oool3 -

Personalized Drill Books poo13 -

Other

| Exit | RE-ACTIVATE |]

* Click the Re-activate button to activate the plug-in. Restart 3D and you will see the Spiral Drawing
Tool option on the tool palette.

SPIRAL DRAWING
TooL See Chapter 4 Drawing Tools Page 87.
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